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% Welcome

Welcome

This documentation covers the installation, configuration and
service/maintenance of the mc256 MKII.

For more on operation, please see the "mc256 Operators
Manual".

You can access all manuals and other information by registering at www.lawo.com (click on Login).
By registering you will receive the latest news for your product, and can download software and
documentation.

We also recommend that you carefully observe the release notes delivered with your system.

Getting Started

¢ Read the Technical Overview for an introduction to the system.

¢ Installation deals with installing the hardware.
e AdminHD covers the Lawo configuration software.

e Service/Maintenance includes hardware servicing and software diagnostics.

e The Trouble-shooting section includes a series of example problems and fault-finding tips.

e Part numbers for system components are included in the Appendices.

¢ You will find Technical data, and a Glossary of terms at the end of the manual.

@ The “mc2_Nova73_documentation” guide contains mechanical drawings, data sheets and
further information on all control surface, Nova73 and DALLIS components. The guide is
included with the "CD_mc2_56_X-XX-X-x" software release, available from the Download-
Center after logging in at www.lawo.com.

Marginal Notes

The following symbols are used to draw your attention to:

/O Points of clarification.

@ Useful tips and short cuts.

Warning

Warnings — alert you when an action should always be observed.
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Changes to This Manual %

Changes to This Manual
e \ersion 5.0/1 (Edition: February 3rd 2014) - valid from build V5.0.x.x:

o System Lodfiles - logfiles now use standard formatting, making it easier to locate important
information within a messages file.

0 The Nova73 Module Options and DALLIS Interface Options have been updated to support
some new hardware revisions.

Features from V5.0.x.x onwards are supported only by Router Module MKII systems

As a result of the DSP required to support the Automix feature, some Recording Channel
DSP Configurations are no longer supported (as all channel types must escalate in blocks
of 8). Existing productions will load using the closest available match.

e \ersion 4.24/3 (Edition: November 8th 2013) - updated Lawo logo & claim.
e Version 4.24/2 (not published).
e \ersion 4.24/1 (Edition: July 19th 2013) - valid from build V4.24.x.x. New features added:

0 Nova73 Compact Core.

o0 New DALLIS Line Level IO Cards.

o System logfile time stamping & DSP configuration change information.
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Important Safety Instructions

Important Safety Instructions

Warning

Exposure to excessive sound pressure levels can lead to impaired hearing and cause
damage to the ear.

Please read and observe ALL of the following notes:

Check all of the hardware devices for transport damage.

Any devices showing signs of mechanical damage or damage from the spillage of
liquids MUST NOT be connected to the mains supply or disconnected from the
mains immediately by pulling out the power lead.

All devices MUST be grounded. Grounding connectors are provided on all devices.
In addition, all low-voltage devices external to the system must also be grounded
before operation.

For Scandinavian countries, ALWAYS use a grounded mains connection, to
prevent the device from being grounded through Ethernet or other signal
connections.

All devices MUST be connected to the mains using the three-cord power leads
supplied with the system. Only supply electrical interfaces with the voltages and
signals described in these instructions.

Do NOT use the system at extreme temperatures. Proper operation can only be
guaranteed between temperatures of 10° C and 35° C and a maximum relative
humidity of 85%.

Neutrik PowerCon and Harting connectors must NOT be disconnected under load.
Only Lawo service staff may replace batteries.

Servicing of components inside a device MUST only be carried out by qualified
service personnel according to the following guidelines:

o We recommend switching off the loudspeakers before servicing.

o0 Before removing parts of the casing, shields, etc. the device MUST be switched
off and disconnected from all mains.

0 Before opening a device, the power supply capacitor MUST be discharged with
a suitable resistor.

o Components that carry heavy electrical loads, such as power transistors and
resistors, should NOT be touched until cool to avoid burns.

Servicing unprotected powered devices may only be carried out by qualified service
personnel at their own risk. The following instructions MUST be observed:

0 NEVER touch bare wires or circuitry.
0 Use insulated tools ONLY.

o0 DO NOT touch metal semi-conductor casings as they can bear high voltages.
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Important Safety Instructions M‘

Defective Parts/Modules

Warning

e The system components contain no user-serviceable parts. Therefore DO NOT
open the devices other than to perform the procedures described in this manual.

¢ In the event of a hardware defect, please send the system component to your local
service representative together with a detailed description of the fault. We would like
to remind you to please check carefully whether the failure is caused by erroneous
configuration, operation or connection before sending parts for repair. We
recommend contacting our service department before sending parts for repair.

First Aid (in the case of electric shock)

Warning

e DO NOT touch the person or his/her clothing before power is turned off, otherwise
you risk sustaining an electric shock yourself.

e Separate the person as quickly as possible from the electric power source as
follows:

o Switch off the equipment.
0 Unplug or disconnect the mains cable.

o Move the person away from the power source by using dry insulating material
(such as wood or plastic).

e [f the person is unconscious:
0 Check their pulse and reanimate if their respiration is poor.

o Lay the body down and turn it to one side. Call for a doctor immediately.

e Having sustained an electric shock, ALWAYS consult a doctor.

mc256 MKIl Technical Manual V5.0/1 7



% Chapter 1: Technical Overview

Chapter 1: Technical Overview

Introduction
This chapter introduces the technical components of the mc256 MKII system:

e Hardware Components

e Redundancy

e Sample Rate & System Clock

¢ Networking I/O Resources

¢ Nova73 DSHS (Dual Self-Healing Star)

e Configuration

e System Options

8 V5.0/1 mc256 MKIl Technical Manual



Chapter 1: Technical Overview %

Hardware Components

Hardware Components
The mc256 MKII consists of three principal components:
e Console control surface - with integrated power supplies and local /O connections.

e Nova73 — with Router Modules, DSP boards and AES, MADI, ATM or RAVENNA I/O. Available
in two sizes: Nova73 HD (10RU) or Nova73 Compact (7RU).

e DALLIS I/O — offering further /O breakout options; connected to the Nova73 via MADI, ATM or
RAVENNA 1/O.

Dallis IO : . Dallis 10
Stagebox Novar3 Stagebox

The exact hardware specification defines how many analogue and digital connections are available
for external equipment, and how much DSP processing is available for input channels, monitor return

channels, groups, sums and auxiliary sends. For a summary of the system capabilities, please see
Technical Data.

mc256 MKIl Technical Manual V5.0/1 9



% Chapter 1: Technical Overview

Hardware Components

Console Control Surface

The mc256 MKII control surface is constructed in 16-fader sections, with frame sizes scaling from 16
faders up to 80 faders. You may add 16-fader extenders to expand the number of fader strips.
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A range of console options offer wide (studio) or narrow (OB) side panels, table-top or stand
mounting, overbridge metering, etc.

Control surface power is provided by internal power supplies, with n+1 redundancy and two mains
connections for phase redundancy. PSU status may be monitored from the console GUL

All application software and user data is handled by the control system, located on the Router Module
(MKII) within the Nova73. The surface connects to the Nova73 via TCP/IP Ethernet; if a redundant
Router Module is fitted, then main and backup connections can be installed.

The control surface also houses a local_l/O board, for monitoring, metering, talkback and
headphones. This is available in two versions, connecting to the Nova73 via either MADI or
RAVENNA.

/O As the control system is integrated within the Nova73, the control surface may be powered
off without loss of user data or audio!
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Chapter 1: Technical Overview %

Hardware Components

Nova73

The Nova73 forms the "heart" of the system, and is available in two sizes - Nova73 HD (10RU) or
Nova73 Compact (7RU):

Nova73 HD (10RU) Nova73 Compact (7RU)
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In each case, the front of the frame houses the:

¢ Router Modules MKII - two central slots are available for a main and redundant Router
Module. The Router_ Module MKII (980/33) contains the summing matrix AND control system.
The summing matrix offers a 8k? capacity* router at 48kHz (or 4k? capacity at 96kHz). The
control system runs on an embedded Linux operating system, and stores both the application
software and user data. Connections are made via the two TCP/IP Ethernet ports:

o ETHERNET A - connects to the control surface.

o ETHERNET B — connects to the Lawo system network (to other Lawo devices; third-party
controllers; computers running configuration, maintenance or remote control software).

e DSP and I/O Modules - 16* slots are available for plug-in DSP or /O modules. Up to 8* DSP
boards may be fitted supporting a range of DSP_configurations; /O options include AES/EBU,
MADI, ATM and RAVENNA, see Nova73 Module Options. Al modules are hot-pluggable
enabling them to be be replaced without affecting other aspects of the system. Further
breakout formats are realised by connecting to DALLIS I/O.

e Power Supply Units - two slots are available for main and redundant power supplies.

The rear of the frame houses the:
e Sync ports - accepting Wordclock, AES/EBU (AES3-id) or Video Black Burst (PAL or NTSC).

e Alarm_and control contacts - including a global alarm; prepare cold start; force redundant
Router Module takeover.

e AES connector panels - for front-mounted AES3 I/O modules.

e 5* Cooling Fans - hot-pluggable and easily accessible.

* The figures above are for the Nova73 HD. For more details on the Compact core, see the Nova73
Compact Appendix.
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Hardware Components

DALLIS I/O
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The /O capabilities of the system are expanded by adding DALLIS unit(s). Each may be either 3RU
(shown above) or 6RU in height, and may be remote from the rest of the system.

The front of the frame houses the:

e DALLIS Master Boards - two central slots are provided for a main and redundant master

board. A choice of board types provide connection to/from the Nova73 via MADI, ATM or
RAVENNA, see DALLIS Interface Options.

/O The type of DALLIS master board, and hence the connection, determines the maximum

number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128
(RAVENNA).

e DALLIS I/O cards - 18 slots are available for a range of /O breakout options (Mic/Line, Line,
AES, SDI, GPIO, etc.), see DALLIS Interface Options.

All cards are hot plug-able, with the exception of Phantom Power.

The rear of the frame provides access to:

¢ Main and redundant power supplies

e Alarm and control contacts - including a local DALLIS alarm.
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Hardware Components

Local I/O

The MKII mc256 control surface includes an integrated local /O board. This provides dedicated
connections for local devices such as monitoring, metering, talkback and headphones.

(Note that on the classic mc?56, similar functionality may be provided via an external DALLIS.)
All local /O connections are accessed from the control surface rear panel:

Local I/O
Line IN 9-16 Line OUT

Line IN 1-8 S J S N S 3 2 '
MAINS 1 Line OUT 9-16

pEaiNge AES3 OUT
uuuuuuu s .
MAINS 2 CAUTION!

o]
AES3 OUT5-8 A
o o
FUSE 6,34 . i ROUTER 1 ROUTER 2 ETH Extension CASE MADI RAVENNA
’ Remove both mains/line Plugs ETHA ETHA ®
"4 %) | | before opening the case. ton 128

(o
System Connections

The local I/O provides:
e 16 Line In - wired to 2 x DSub (female).

Note that Line In 16 may be fed from the integrated talkback mic preamp, according to the jumper
switch positions set for the Local I/O.

e 16 Line Out:

0 Line Out 1-8 - wired to 8 x XLR (male). By default, these outputs are routed from the CRM 1
monitor output.

0 Line Out 9-16 - wired to 1 x DSub (male).
e 8 AES3In - wired to 2 x DSub (female).
e 8 AES3 Out:
0 AES3 Out 1-4 - wired to 4 x XLR (male).
0 AES3 Out 5-8 - wired to 1 x DSub (male).

Note that AES IN 5-8 and AES OUT 5-8 connect to the RTW meter, if either of the TM 7 or TM 9
Overbridge options are fitted.

¢ 8 GPIO - wired to 2 x DSub.

e 2 Stereo Headphones - wired to the headphone 1 & 2 connectors on the console's front
buffer.

e 1 MADI or 1 RAVENNA - the local /O board is available in two versions, connecting to the
Nova73 via either MADI or RAVENNA (see Local /O Connection). You will need to reserve one
MADI, or one RAVENNA, port within the Nova73 for this connection.

Please see Local /O Wiring for more details on wiring, pin-outs and jumper switch options.

mc256 MKIl Technical Manual V5.0/1 13
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Chapter 1: Technical Overview
Redundancy

Redundancy

One of the strengths of the mc256 MKII is its ability to withstand component failures, and every
component is designed with fault tolerance in mind:

Star2 Technology

Link & Port Redundancy

Nova73 & DALLIS Power

Redundant DSP

Control System

Redundant Router Module and Control System

Control Surface Power

Control Surface Internal Wiring

14
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Chapter 1: Technical Overview %

Redundancy

Star2 Technology

All components within the system utilise Lawo’s Star? technology:

Capable of
96kHz sample rate

/O boards with MADI,
ATM, AES3 and DSP

Integration of I/O-
satellites
DALLIS)

Central router/controller
board with optional
redundancy incl. control
system

Control via Ethernet
TCP/IP

Hot-pluggable modules
in compact frame

Optional: Redundant
power supply

e Point-to-point connections — with point-to-point connections, a fault only affects that part of
the system, unlike a TDM bus architecture where a fault may disrupt everything connected to
the bus!

e Dual star topology — with redundant Router Modules fitted to the Nova73, and redundant
Master Boards in every DALLIS, then components connect in a dual ‘star’ mode. This protects
signal paths from any single point-of-failure. See Link & Port Redundancy.

e Hot-swappable Modules/Cards — every plug-in module or card can be hot-swapped without
affecting the rest of the system enabling online maintenance of the system.

e Redundant Power Supply Units — both Nova73 and DALLIS units can be fitted with dual
redundant power supplies, which can be isolated and exchanged from the front or rear. See
Nova73 & DALLIS power.

e Passive backplanes — the frame backplanes are entirely passive. With no active
components, this increases reliability.

mc256 MKIl Technical Manual V5.0/1 15



Chapter 1: Technical Overview
Redundancy

Link & Port Redundancy

Simple connection
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For crucial interconnections between DALLIS and Nova73 units, you can specify either link, or link and
port, redundancy:

¢ Link Redundancy —two physical connections (MADI, ATM or RAVENNA) are made from the
DALLIS master board to the Nova73. If the active link fails, then the redundant link ensures an
automatic recovery.

e Link & Port Redundancy - two master boards are fitted to each DALLIS, and connect to
different Nova73 ports (preferably on a different module). Port redundancy provides automatic
recovery from a:

o Failure of the active physical link (MADI, ATM or RAVENNA).
o Malfunction of the active DALLIS master board.
o Malfunction of the Nova73 module.

To specify link redundancy:

e MADI - order a double-port Nova73 module and DALLIS master board for each connection.

e ATM - order a double-port Nova73 module and two DALLIS master boards for each
connection.

e RAVENNA - install both the copper and fibre optic connections from the RAVENNA module /
master board.

To specify link & port redundancy:

e MADI, ATM or RAVENNA - order two master_boards per DALLIS plus enough single-port
Nova73_modules to support the connections. AdminHD configures which ports provide
redundancy.
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Redundancy

Nova73 & DALLIS Power

Nova73 HD front view

Nova73 Compact front view

)

-

1 2

PSU 1 PSU 2

DALLIS internal view of PSUs

The Nova73 HD, Nova73 Compact and DALLIS provide two slots for dual redundant power supplies,
see Nova73 power and DALLIS power. Their status may be monitored from the console GUI using
the Signal Settings display.

mc256 MKIl Technical Manual
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Redundancy

Redundant DSP

Within the Nova73 a DSP board may be reserved to provide redundant processing (indicated by the
STANDBY LED).

In the unlikely event of a failure, the system automatically switches all DSP resources and settings
from the faulty board to the spare; the faulty board may then be safely removed and replaced.

This option is enabled from the console GUI using the DSP Configurations display, and is saved
within the production.
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Redundancy

Control System

The control system resides on the Router Module MKII (980/33)
within the Nova73.

It runs on an embedded Linux operating system for speed and
increased reliability, and stores both the application software and
user data.

/(_') The Router Module MKII (980/33) contains a backup
power unit which provides up to 3 seconds of backup
power to deal with short interruptions to mains (AC)
power.

Warm Start & Cold Start

Following switch-off, power is provided to the control system for a further 18 seconds. During this
time, all current settings are saved to flash memory; this is known as the system's warm start data.

By default, the warm start data is loaded at the end of boot-up. This means that the console comes
back exactly as it was when you last shut down, ensuring fast recovery of all previous settings
following a loss of power.

Alternatively, you can perform a cold start if you suspect a problem with the warm start data.

Data Recovery

Two flash cards are used to store the application software (System Flashcard) and user data (Data
Flashcard) separately. You may create a backup copy of the flashcards so that they may be replaced
if necessary.

g System Flashcard Data Flashcard

- Ipackages N x
L BT sl j Production j
EyEtem conlel
Hi \ \
: ‘Iwm-mwe?uam\s " '
Canfig Snapshats Automation Presets Warm stert data
- ffitphoot
- Image by sarve
A A
N x M x

» -;Io:g::ﬁ Folder Mix
A Y

Snapshots - Saquence

9 During operation, any errors generated by the control system are stored in the message
logfile. This can be copied to USB via the File display, or monitored remotely via the Web
Browser Interface.
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Redundancy

Redundant Router Module and Control System

By fiting a second Router Module to the Nova73, the system can provide @
redundancy for the routing matrix and control system.

In order to provide redundancy, your Nova73 must be fitted with two Router Modules
MKII; Ethernet A and Ethernet B connections from both the main and redundant
modules are required:

Ethernet B

Network Switch

sssss

to other mc2 i
LAN (Ethernet) Systems ®
Lawo Software Applications: or 3rd party
mxGUI controllers

AdminHD/ControlHD
Web Browser Interface
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Redundancy

Automatic Takeover

If the main Router Module fails, then the redundant module automatically takes over. This ensures a
seamless recovery without any interruption to operation.

/g_j Note that a brief interruption to audio will occur while routes are reconfigured.

The redundant control system is automatically activated if, internally, a loss of connection is noticed
by the redundant system. This could be due to a software failure, hardware error or reboot of the main

control system.

If the Ethernet connection between the control surface and Router Module fails, then an automatic
takeover does not occur, as the failure may be deliberate (for example, if you disconnect the cable).

Instead the operator is presented with an error message:

—INPUT MIXER — ——METERING

GAIN

1. Click on the message and a confirmation pop-up appears:

ease Note

ase Note X
erruption of a ystem's audio.

2. Select Yes to switch to the redundant control system or No to cancel.

Selecting Yes causes an interruption to the audio.

If you select No, then you MUST fix the problem with the connection before you can regain control of
the audio.

mc256 MKIl Technical Manual V5.0/1 21
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Redundancy

Manual Takeover

You can force a manual takeover at any time, using the Redundancy takeover
option in the System Settings display:

1. Select the Global topic followed by the Redundancy takeover option.

A confirmation dialogue box appears:

£ @uerre
el b et - |_Q L
» Global o

3 Emmz coLD START
s i

Loudness Metering

3
3
AFL
3
3

@ LamP TEST

@ MODULE TAKEOVER

All AFV cg i a

fae ==
Channel Display

Word clock

Fader/Joystick
Surround Mix Minus

Remote

00:00:00

00000000

Redundancy takeover

2. Select Yes to confirm or No to cancel the operation.

Selecting Yes switches to the redundant control system.

Alternatively, press the Module Takeover button on the front of the redundant Router Module.

/(_) A manual takeover may also be forced using the ROUTER TAKEOVER contact,
connected to GPI 1 on the Nova73 rear panel, see Nova73 Alarm & Control Contacts.
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Redundancy

Control Surface Power

Control surface power is provided by internal power supplies. Depending on the frame size, either
one or two PSU blocks are fitted to each frame. Each block is equipped with two power supplies
running in parallel. Both share the current load; if one fails, then the second is powerful enough to
handle the required load alone.

Power Supply Desk Alarm

From Version 4.8 software onwards, the Central GUI offers status monitoring for all PSU blocks fitted
to the control surface.

The status of each PSU block is represented by a symbol which appears at the bottom right of every
console display:

SEMSE(EXPANDER) ~ |SEL
ATTACK
RELEASE
THRES
LAHD

RATIO

-
-
Y
-
Y
v
-

s
-
>
Y
-

FLOOR

The number of symbols relates to the number of PSU blocks within the control surface and whether
any extender bays with their own PSU are fitted. PSU blocks are represented from left to right, and
each block consists of two supplies running in parallel.

The symbols indicate:
e Green Circle —the PSU block is working fine.

e Yellow triangle with an exclamation mark — the PSU block is working fine, but there was a
fault in the past which has now been cleared. Click on the icon to reset it.

e Red circle with an exclamation mark — there is a fault.

Hover over the symbol to reveal more information:

Our example shows the status for Bay 1 - the first bay on the left of the console.

/Lj Note that within the text on the GUI, bays are counted from BAY 1 upwards. However,
internally bays are addressed from 0. This means that BAY 1 on the GUI relates to an
internal Bay Server address of 0, BAY 2 to an internal address of 1, and so on.
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Redundancy

Control Surface Internal Wiring

‘ = Ethernet —— LSB ‘

Connection Panel {rear)

Ethernet Switch

et iy

(=] o= @c Bo @0 Bo 8 o =L
@E e ee e eEee0600000

Decentral Bay(s)

Central Bay

Within each channel and central bay, individual panels and displays connect to an Ethernet Bay
Server. (Control surface panels via USB; displays via LVDS for high resolution graphics and USB for
touch control).

Each Bay Server then connects to an Ethernet switch, mounted inside the control surface frame. The
network connection from the switch appears on the rear panel as ETHERNET A.

By fitting a redundant Router Module to the Nova73, a second Ethernet A connection can be installed
for automatic redundancy.

Internally, point-to-point connections provide fault tolerance, and allow any bay or panel to be isolated
from the rest of the console.

Control surface panels and displays are hot-pluggable making them easy to service.
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Sample Rate & System Clock

Sample Rate & System Clock

Internal Sample Rate

The system may operate at a choice of internal sampling rates including 96kHz, 88.2kHz, 48kHz and
44.1kHz.

The maximum sample rate (96kHz or 48kHz) is set by the AdminHD configuration and cannot be
modified from the console GUI. (AdminHD: the maximum sample rate is defined when you select the
type of Nova73 Core).

Having configured the maximum rate, you may use the Sample rate option, in the System Settings
display, to change from 48kHz to 44.1kHz, or from 96kHz to 88.2kHz, 48kHz or 44.1kHz.

System Clock (Sync Reference)

The Nova73 offers a fully redundant clock source structure with two independent clock inputs, an
internal sync generator and the ability to lock to sync from an incoming multi-channel signal. This
allows the console to be clocked from a variety of sync sources and recover from loss of external
sync.

External sync connections are located on the Nova73 rear panel.

The sync signal priorities are defined using the Wordclock options in the System Settings display.

mc256 MKIl Technical Manual V5.0/1 25
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Networking I/O Resources

Networking I/O Resources

The mc256 MKII is just one member of the mc? family of products, which utilise the same Nova73
and DALLIS architecture, and run on the same operating system and application software.

The Nova73 and DALLIS system is available in its own right as a stand alone routing matrix. Multiple
systems may be networked to provide sharing of sources and destinations:

Q;;}/f

Mic3 & 4 Mic1 & 2

DALLIS 1/0. Nova 73 Nettirk 1 Nova 73 DALLIS /0

Mic5 & 6

Metlink 2

Netlink 3

DALLIS /0| Nova 73

DALLIS IO

£ =
Q%m_}/f

In the example above, mics are physically connected, via a DALLIS, to each system. Signals are
transferred between systems via ‘Netlinks’, providing the ability to share any mic input.

Each ‘Netlink’ is an audio connection which may be MADI, RAVENNA, ATM, AES or analogue audio,
and signals are dynamically allocated as each operator makes routes from the Signal List display.

Any number of sources may be distributed depending on the physical limitations of your network.
Please consult your system specification for details.

On any system within the network, you can view which sources are distributed from the % column on
the Signal List display:

e % indicates that a source is connected locally to this console, and is ‘Shared’ (made
available) to other consoles within the network.

o W indicates that a source is ‘Imported’. In other words, it is not connected locally to this
console.

/(_') From version 4.0.2.2 onwards, all Lawo products have adopted a consistent software
release numbering system to indicate compatibility. In each case, the first three digits of
the software version must match.

So, for example, a mc?66 console running version 4.20.2.0 can be networked to a mc?56,
mc290 or Nova73 running 4.20.2.x. You can check the software version of your mc?
system from the Global Options in the System Settings display.
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Nova73 HD Dual Self-Healing Star

Nova73 HD Dual Self-Healing Star

The Nova73 HD can be implemented in a dual star topology to form a self-healing architecture where
one Nova73 is active and the other passive. In the case of a component failure, the system switches
to the redundant signal path. This type of system is known as the Dual Self-Healing Star:

Dual Self-Heallng Star Structure

'_.. HEE I "2«'22'2 bl

e Y

Please see the "Nova73 MKIl Technical Manual" for more details.
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Configuration

The mc256 MKII can be customised by operators, technicians or Lawo personnel as follows:

Custom Functions

Functions such as user buttons can be re-assigned from the console GUI using the Custom
Functions display:

Assignments

Name = Name s WEL

Central User Button, Machine ntrol _ Userbutton Type ;User Panel

Stop

Central User Button, System Settings Page Functions Userbutton Index (0=off) 2

Custom functions are stored at a lower level to productions. This means that any changes will affect
all users.

AdminHD

At a lower level (not accessible from the GUI) are a number of files which configure the system’s
hardware and define settings such as the sampling frequency, and the organisation of signals within
the Directories and Subdirectories of the Signal List display. The AdminHD configuration is an
essential part of the system. If a hardware component is not defined within the configuration, then it
will not be visible to you even if it is powered and connected. In other words, the configuration is
always the ‘master’ of the system, regardless of what physical components are added or removed.

The configuration is not designed to be changed by an operator, but can be edited by your systems
engineer using a software application called AdminHD. For example, if a DALLIS stagebox is hired in
for a production, then the unit must be added to the configuration and uploaded to the system before
the signals and parameters become available to the operator.

TCL Functions

At a lower level than AdminHD, a number of other options may be factory-configured using TCL (Tool
Command Language). TCL functions can only be programmed by Lawo personnel, and are designed
to provide some flexibility at the specification stage. TCL allows the logical interlinking of GPIs, soft
keys and events. For example, tally states, automated input allocation and fader starts can all be
programmed using this protocol. Console monitoring is also handled by the TCL protocol.
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System Options

The principle system components offer a number of options which define the layout of the control
surface, the modules fitted to the Nova73 and the cards fitted to each DALLIS. For details see Control
Surface Options, Nova73 Module Options and DALLIS Interface Options.

In addition, the following features may be installed, or configured, to provide further integration with the
production environment:

mxGUI - a Lawo software programme which runs on an external computer to provide offline
setup or remote operation of any mc? system. mxGUI is covered in the "mc256 Operators
Manual".

AdminHD (& ControlHD) - a Lawo software programme which runs on an external computer
to provide system configuration or remote operation of matrix crosspoints, signal labels and 10
parameters. See AdminHD.

Audio Follow Video (AFV) - the console supports up to 128 external events to open and close
any channel or main fader. AFV events are factory-configured, and received via TCP/IP
Ethernet (using Lawo's Remote MNOPL protocol) or GPIO. Please contact your local Lawo
representative or email service@lawo.com for more detalils.

General Purpose Channels (GPCs) - the console supports up to 256 GPCs which may be
used to remotely control parameters within an external device via MIDIl. The assignment of
GPC objects to MIDI program changes and controller values is factory-configured. Please
contact your local Lawo representative or email service@lawo.com for more details.

Plugin Server - the optional LAWO Plugin Server allows plugins to be controlled from the
mc? console, and all settings to be stored and recalled by a production or snapshot. See the
"Lawo Plugin Collection Operators Manual", and the “Plugin Server Technical Documentation”
for details.

Remote MNOPL - Lawo’'s Remote MNOPL protocol is a freely available Ethernet (TCP/IP)
protocol providing control of virtually any system parameter from an external device. A typical
application is to provide third-party matrix control from external systems such as VSM, Evertz,
Quartz, BFE, Pharos and others. See AdminHD: mapping tables.

Remote Desktop - any of the console’s TFT displays (Channel or Central GUI) may be
switched to a remote server in order to view and control other applications. The server running
the desktop must be connected to the Lawo system _network. The remote desktop function is
programmed from the console GUI, using the Custom Functions display, see the "mc256
Operators Manual".

Lawo Remote App - is a free App which allows you to operate any fader of a mc? console,
recall snapshots and control user-defined functions remotely from an iPhone, iPod or iPad.
The Lawo Remote App is covered in the "mc256 Operators Manual”. For details on configuring
the wireless network access point, see the “TD_AccessPoint.iApp” guide.

Machine Control - the optional Recording Com Kit provides Sony 9pin, LTC and MIDI
connections to an external playback device. The operation of machine control is covered in the
"mc256 Operators Manual”.

Networked Resources - for more information on configuring 'Netlinks' to share audio
resources between systems, please contact your local Lawo representative or email
service@lawo.com
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System Options

e Web Browser Interface - the control system includes an integrated web server, allowing
status information to be monitored from an external computer, see the Web Browser
Interface.

e Dial-up Router - this option may be installed to provide remote 'dial-up’ maintenance from the
Lawo service department. Please contact your local Lawo representative or email
service@lawo.com for more details.
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Chapter 2: Installation

Introduction

This chapter deals with installing the hardware components, connecting up the system and powering
on:

¢ Installing the Nova73

¢ Installing the DALLIS Unit(s)

¢ |nstalling the Control Surface

e System Connections

¢ Powering On & Checking the System

e System Settings

9 The “mc2_Nova73_documentation” guide contains mechanical drawings, data sheets and
further information on all control surface, Nova73 and DALLIS components. The guide is
included with the "CD_mc2_56_X-XX-X-x" software release, available from the Download-
Center after logging in at www.lawo.com.
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Installing the Nova73

Both the Nova73 HD and Nova73 Compact core are designed to be mounted in a 19” rack.

All plug-in connectors are located at the front or rear of the unit. Therefore, when using 19” racks with
front doors please leave enough room for the cables.

Cables plugged into the front of the unit can be ducted backwards underneath the unit for distribution
within the rack.

Warning

Use the rack-rails supplied to mount the Nova73. The 19” frame MUST NOT carry the
complete weight of the unit.

Dimensions and Weight

Frame: Nova73 HD Nova73 Compact

Width 19"
483mm (front plate)
440mm (chassis)

Height 10RU 7RU
Cable Duct 1RU below the frame is required for cable ducting and ventilation.
Depth (including rear 510mm 489mm

connectors and system
locking devices)

Weight 16.25 Kg (one PSU fitted) 14.5 Kg (two PSUs fitted)
Each PSU weighs 4.25 Kg Each PSU weighs 2.86 Kg

Ambient Conditions/Air Conditioning

Proper operation of the Nova73 can only be guaranteed at an ambient temperature between 10° C
and 35° C and a relative humidity between 15% and 85% (not condensing).

When the Nova73 is out of action, it can be stored at a temperature between 0° C and 40° C and a
relative humidity between 10% and 85% (not condensing).

The Nova73 is cooled actively by built-in fans. The housing of the Nova73 is perforated at the top and
at the bottom to guide air flow in and out of the unit; the air stream is guided from bottom front to top
rear. Ensure that the cooling air stream is guided to cool the unit efficiently.

The air-flow rate depends on the mounted components. To calculate the air conditioning required,
assume a maximal air-flow rate of approximately 200 m3/h.

The life cycle of a fan is typically 70.000 operating hours (at a maximum ambient temperature of
40° C). For details on how to change a fan, see Nova73 fan replacement.

Warning

Take care that no devices or cables obstruct the flow of air thereby hindering cooling.
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Nova73 HD Frame (980/02)

Frame 980/02, front view
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Nova73 Compact Frame (980/06)

Frame 980/06, front view
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Installing the Nova73

Grounding

Although operator protection is guaranteed (the Nova73 is connected via the IEC Power Connectors
to the ground of the power supply system) it is best to establish an additional ground for EMC
reasons.

1. Fasten the grounding cable to the CASE grounding bolt (M4 x 8) on the Nova73 rear panel
using a Torx driver:

/O
For Ground Terminal /
~~ Contact Washer /

Ring Terminal

Screw M4

N\

Ground Wire

Warning

The Nova73 must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the
device from being grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.
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Nova73 Compact front view

PSU PSU
|- 1 2

PSU 1 PSU 2

The front of the Nova73 frame offers two slots for the installation of power supply units. On the
Nova73 HD, the second PSU is optional. The Nova73 Compact is always installed with two supplies.

To operate the Nova73, one PSU is sufficient. When a second PSU is fitted for redundancy, the load
is shared between the two supplies.

The PSUs are hot pluggable. For details on how to change a PSU, see Nova73 PSU replacement.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied
with the system.

When running with two mains supplies (PSU 1 and PSU 2), make sure that both circuits lie
on the same ground potential. Otherwise, an internal bridge of two ground wires will lead to
a ground loop!

For air conditioning reasons, both PSU slots MUST be occupied when the Nova73 is
operational:

e Nova73 HD: if only one PSU is installed, then please fill the empty slot with a
dummy plate (Type 980/21).

¢ Nova73 Compact: leave both PSUs in the frame until a replacement can be fitted.
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Installing the Nova73

Power Consumption

The power consumption of the Nova73 varies from a minimum of 60W to a maximum of 1000W,
depending on the voltage and the amount of modules and PSUs fitted.

Electrical Voltage

Nova73 HD Frame PSU Specification

980-25 (1000W Power Supply) Input: 100-240 VAC (PFC)/ 47-63 Hz/ max. 13,5 A
Output: 48 VDC / 23 A

980-22 (600W Power Supply) Input: 100-240 VAC (PFC)/ 47-63 Hz/ max. 8,2 A
Output: 48 VDC / 13 A

980-21 (Dummy Plate) n/a

Nova73 Compact Frame

980-27 (500W Power Supply) Input: 100-240 VAC (PFC)/ 47-63 Hz/ max. 5,5 A
Output: 48 VDC / 10,5 A
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Plug-in Modules and Connector Panels

Normally the Nova73 is delivered with the plug-in modules and rear connector panels fitted within the
chassis. However, if you need to fit additional cards or re-arrange the layout, follow these instructions.
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Installing the Nova73

AES3 Rear Connector Panels

» Nova73 HD

Optionally, the Nova73 HD may be fitted with D-Sub and/or BNC AES3 rear connector panels. These

provide connections for any front-mounted AES3 modules (of type 981/02). The two panel types may
be mixed allowing up to 8 rear connector panels:

e D-Sub, 8HP (980/14) - AES3, balanced 110 ?
e BNC, 16HP (980/15) - AES3-id, unbalanced 75 ?

See Nova73 Rear Connector Panels for pin-out information.

/O The position of the rear connector panels determines the slot numbers which MUST be
used for front-mounted AES3 modules. Therefore, it is important to fit the rear panels
BEFORE mounting any plug-in modules.

1. Establish the first free slot (seen from the right) at the rear of the frame.
2. Remove the existing dummy plate if fitted.

Note that dummy plates are 8HP wide. If you want to mount a connector panel with a width of 16HP
you will need to remove two dummy plates.

3. Position the connector panel so that the inscription is legible!
4. Fasten the connector panel with its 4 screws.

5. Repeat for every connector panel/dummy plate.

Warning

Where no connector panels are required please cover the rear of the frame with dummy
plates of the type 980/13.
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» Nova73 Compact

The Nova73 Compact comes with rear-mounted AES3 connectors as standard. These provide
balanced 110 ? D-Sub connections for up to two front-mounted AES3 modules (of type 981/02). Note
that the AES3 modules MUST be fitted to slots 2 and 6 at the front of the core.

See Nova73 Rear Connector Panels for pin-out information.
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Front Module Slots

Nova73 HD / Slot No.

1 3 5 7 A 9 11 13| |15

Nova73 Compact / Slot No.

The diagrams above show the front module slots available within the Nova73:
e Slot A —fit the main Router Module here.
e Slot B —reserved for a redundant Router Module.

e Slots 1-16* — available for DSP or /O modules. (*10 slots are available for DSP or /O
modules in the Nova73 Compact core).

See Nova73 Module Options for details on all plug-in modules.

Note that the Nova73 will only work once slot A is fitted with a Router Module. When fitting a redundant
Router Module, it must be of the same type fitted to slot A.

Note that the system logfile counts slots from O upwards (e.g. physical slot 1 = slot O in the logfile).

To ensure efficient cooling, you should spread the modules evenly within the Nova73.

/(_') Not every /O or DSP module can be used in every slot so it is best to check your
configuration within AdminHD before fitting the physical modules.

/(_') One MADI, or ATM, port is required to provide the Port DSP resources used for the
console's monitoring (Listen surround and Listen stereo). Therefore, you must fit at
least one MADI, or one ATM, module to the Nova73.
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AES3 Modules

In the Nova73 HD, modules of type 981/02 AES3 should be mounted so that they are right-aligned to
the rear connector panel position (looking from the front of the frame). For example, if the 1st and 2nd
rear connector panels (working from right to left) are D-Sub and the 3rd is BNC, then the AES
modules must be front-mounted in slot 2 (D-Sub1), slot 4 (D-Sub2) and slot 8 (BNC).

In the Nova73 Compact core, AES3 modules MUST be mounted in slots 2 and 6.

If a module has been fitted incorrectly, then you may see its AES3 LOCK 1 LED blink.

DSP Modules

DSP modules of type 983/02 or 983/03 should be mounted from right to left filling up the odd slots -
15, 13,11,9,7,5, 3, Linthe Nova73HD or 9, 7, 5, 3, 1 in the Nova73 Compact core.

The logical numbering of the DSP boards follows the mounting order described above (DSP board 1
in slot 15, DSP board 2 in slot 13, etc.):

Logical Numbering of DSP Boards
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>> Mounting the Front Modules

Warning

The Nova73 plug-in modules carry highly sensitive electronic components, and therefore
should only be handled by authorized personnel, and with the utmost care.

ALWAYS observe the following procedures:
1. Discharge yourself before touching a plug-in module.

2. Wear conductive safety-shoes and grounding wristbands to reduce the risk of electrostatic
charging.

3. DO NOT bend the modules.

4. Make sure that all rear_connector panels are mounted before inserting the respective plug-in
module.

5. Toremove an existing module, unfasten the front panel screws, release the locking catches
(as shown below) and pull out the module.

Some modules include DIP switches to set certain features. Therefore, check the DIP switch settings
before inserting a replacement! Further information can be found in the data sheet, available in the
"mc2 Nova73 documentation™ guide.

6. When fitting a module, make sure that it glides smoothly into the top and bottom guide-rails:

When fitted correctly, it will lock into place.

7. ALWAYS fasten the front panel screws in order to fix the module in place. This protects the
operator from contact with live parts; protects the module from being pulled out unintentionally; and
reduces the emission of electro-magnetic radiation.

Tighten the screws carefully to a maximum torque of 0.25 Nm; we recommend using a
dynamometric screwdriver.

8. When you have fitted all the plug-in modules for your system, close any empty slots with
dummy plates.
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Installing the DALLIS Unit(s)

Each DALLIS is designed to be mounted in a 19” rack and comes in a choice of frame heights: 3RU
or 6RU.

All plug-in connectors, with the exception of power and alarm, are located at the front of the unit.
Therefore, when using 19” racks with front doors please leave enough room for the cables.

Cables plugged into the front of the unit can be ducted backwards underneath the unit for distribution
within the rack.

Warning

Use the rack-rails supplied to mount the DALLIS. The 19” frame MUST NOT carry the
complete weight of the unit.

Dimensions and Weight

DALLIS: 3RU Frame 6RU Frame
Width 19" 19”
483mm (front plate) 483mm (front plate)
440mm (body) 440mm (body)
Height 132.5mm 265mm
Cable Duct 1RU below the frame is required |1RU below the frame is required
for cable ducting and ventilation. |for cable ducting and ventilation.
Depth (of unit) 433mm 433mm
Weight (without cards) 7.15Kg 11 Kg

Ambient Conditions/Air Conditioning

The DALLIS requires a constant air stream with a maximum exhaust air temperature of 32° C. Thus
installation in a 19” rack is recommended.

The housing of the DALLIS is perforated at the top and at the bottom to guide air flow in and out of the
unit. Ensure that the cooling air stream is guided to cool the unit efficiently.

To calculate the air conditioning required, assume a power consumption of 200 Watts.

Warning
ALWAYS leave 1 RU below the DALLIS frame for ventilation and cable ducting. Take care
that no devices or cables obstruct the flow of air thereby hindering cooling.

ALWAYS observe the minimum distances at the front and rear of the unit to allow for
ventilation and cable ducting.

44 V5.0/1 mc256 MKIl Technical Manual



Chapter 2: Installation
Installing the DALLIS Unit(s)

Minimum Distances for DALLIS Installation
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3RU Frame (940/30)
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6RU Frame (940/60)

Frame 940/60, front view
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Grounding

Although operator protection is guaranteed (the DALLIS is connected via the IEC Power Connectors
to the ground of the power supply system) it is best to establish an additional ground for EMC
reasons.

1. Fasten the grounding cable to the M4 CASE grounding bolt on the rear panel:

:I B® () Ml‘gﬁ)
pSE 5"
Powersupplies G
i i /O

Contact Washer

For Ground Terminal /
e Ring Terminal Screw M4

N

Ground Wire

Warning

The DALLIS must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the
device from being grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces
For compliance with AES3, digital interfaces should be connected to a field ground.

For connecting microphones, guide the ground connection from the DALLIS to the microphone
directly via the cable shielding, otherwise phantom power cannot be transferred. Take care that the
shielding does not lie on the field ground. This way you will prevent interference and loss of signal

quality.
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Power

DALLIS rear view DALLIS internal view
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Depending on your system specification, each DALLIS may be delivered with single or dual redundant
power supply units (PSUSs).

When a redundant PSU is fitted (type 940/16), the load is shared between the two supplies.
The PSUs are hot pluggable. For details on how to change a PSU, see DALLIS PSU replacement.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied
with the system.

When running with two mains supplies (PSU 1 and PSU 2), make sure that both circuits lie
on the same ground potential. Otherwise, an internal bridge of two ground wires will lead to
a ground loop!

Power Consumption

The power consumption of the DALLIS varies from a minimum of 70W to a maximum of 180W,
depending on the amount and type of /O cards fitted, and whether there are dual power supplies.

Electrical Voltage

3RU frame, PSU specification:
¢ Input: 100-240 VAC (PFC)/ 48-62 Hz/ 1.6-2 A
e Qutput: 12VDC/8.3-11 A

6RU frame, PSU specification:
¢ Input: 100-240 VAC (PFC)/ 48-62 Hz/ max. 2A
e Output: 12VDC /11 A
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Plug-in Cards

Normally the DALLIS is delivered with the plug-in /O cards and master boards fitted within the
chassis. However, if you need to fit additional plug-in cards or re-arrange the layout, follow these
instructions.
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Equipping the 3RU Frame
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18 single width DALLIS /O card slots are available within the 3RU frame. Double width /O cards
(8GU) occupy two slots; single width /O cards (4GU) occupy one slot.
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e Slot M1 — fit the main master board here.
e Slot M2 —reserved for a redundant master board.
e S|ots 1-18 — available for /O cards.

See DALLIS Interface Options for details.

Note that the DALLIS will only work once slot M1 is fitted with a master board. When fitting a
redundant master board, it must be of the same type fitted to slot M1.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot O in the logfile).

/O Not every interface card can be used in every slot. As a general rule, if an interface card is
permitted within AdminHD, then it can be fitted to your system.

/O The type of DALLIS master board, and hence the connection, determines the maximum
number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128

(RAVENNA).
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Equipping the 6RU Frame
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18 double width DALLIS /O card slots, plus a single width slot reserved for Phantom Power, are
available within the 6RU frame. Double width /O cards (8GU) occupy the whole slot; single width /O
cards (4GU) must be fitted on the left of the slot and a dummy plate fitted to the right to close the gap.

¢ Slot M1 —fit the main master board here.

¢ Slot M2 —reserved for a redundant master board.

¢ Slots 1-18 — available for /O cards.

e Slot 19 —reserved for Phantom Power. If specified, fit the Phantom Power card (947/10) here.

See DALLIS Interface Options for details.

Note that the DALLIS will only work once slot M1 is fitted with a master board. When fitting a
redundant master board, it must be of the same type fitted to slot M1.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logdfile).

/Q Not every interface card can be used in every slot. As a general rule, if an interface card is
permitted within AdminHD, then it can be fitted to your system.

/Q The type of DALLIS master board, and hence the connection, determines the maximum
number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128
(RAVENNA).
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Mounting the Cards

Warning
To avoid any unpleasant clicks or pops, the system resets when a Phantom Power card is
replaced. Therefore, you should only replace a Phantom Power card when off air!

The DALLIS plug-in cards carry highly sensitive electronic components, and therefore
should only be handled by authorized personnel, and with the utmost care.

ALWAYS observe the following procedures:
1. Discharge yourself before touching a plug-in card.

2. Wear conductive safety-shoes and grounding wristbands to reduce the risk of electrostatic
charging.

3. DO NOT bend the cards.
4. Toremove an existing card, unfasten the front panel screws and pull out the card.

Note that some DALLIS /O cards include DIP switches to set certain features of the cards.
Therefore, when replacing cards, check the DIP switch settings before inserting the new card!
Further information can be found in the data sheet, available in the "mc2 Nova73 documentation”
guide.

Note also that the DALLIS master board provides a switch to set whether the board performs a cold
or warm start when powered on. You may need to set this switch to cold start to initialise the system.
For details please consult the relevant data sheet.

5.  When fitting a new card, make sure that it glides smoothly into the top and bottom guide-rails.

When fitted correctly, it will lock into place.

6. ALWAYS fasten the front panel screws in order to fix the card in place. This protects the
operator from contact with live parts; protects the card from being pulled out unintentionally; and
reduces the emission of electro-magnetic radiation.

7.  When you have fitted all the plug-in cards for your system, close any empty slots with dummy
plates (For single width slots use part number 940/31, and for double width slots use 940/33. Use
part number 940/32 to blank the second master board slot).
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Installing the Control Surface

The console control surface consists of the:

¢ Frame (available in a range of pre-determined sizes).
e Stand (optional).

e Console Keyboard (English or German) - a floating keyboard which may be connected to
any USB port.

e Removable Script tray (optional).

The frame is designed for table-top mounting onto a cross bar (not supplied). Note that no separate
OB mounting kit is required, as mounting threads are integrated into the frame. Alternatively, the
control surface may be delivered with the optional stand.

All plug-in_connectors are located on the rear panel. Therefore, when installing, please leave enough
room for the cables.

Extenders require their own power and grounding connection, and connect to the main control
surface frame via Ethernet.

Please see control surface options for details on customisation options.

@ The “mc2_Nova73_documentation” guide contains mechanical drawings, data sheets and
further information on all control surface, Nova73 and DALLIS components. The guide is
included with the "CD_mc2_56 X-XX-X-x" software release, available from the Download-
Center after logging in at www.lawo.com.
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Ambient Conditions/Air Conditioning

Proper operation of the control surface can only be guaranteed at an ambient temperature between
10° C and 35° C and a relative humidity between 15% and 85% (not condensing).

To keep the control surface cool in extreme environments, the front panel is fitted with low noise fans.
A sensor within the console activates the cooling fans if the temperature rises above 30° C.

At temperatures below 30° C the cooling fans are switched off permitting installation within noise
critical environments. When relying on convection cooling, ensure that the unit’s ventilation holes are
not blocked to allow air circulation.

Warning

ALWAYS observe the minimum distances around the console frame to allow for ventilation
and cable ducting.

Take care that no devices or cables obstruct the flow of air thereby hindering cooling.
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Dimensions and Weight

16+16C Studio Profile 16+16C Studio Overhead
860.5mm 1319.5mm
598.5mm ~
£
- @5 v, 5
32 el "; oooooooooooooooo Bﬂcgénongu;;mg of :;munnunn
l l {‘Q %Z: ::::EDE' EUEB!EEDDDBD
el - [ oo cccuugul:l%flnuuu-}m
%25‘, é%’:é Sgﬂamg 0 ;DEID??
0OBOBOODDCBOOOOG | GO0COO000E000 Eg%é%ﬁgé
EERERE =g g 00g
Frame Size Part Number Studio Version OB Version
16C 959-09 Width: 809mm 731mm
Weight: 32.4kg 32.4kg
16+16C 959-10 Width: 1319mm 1241mm
Weight: 47.3kg 47.3kg
16+16C +16 959-11 Width: 1829mm 1751mm
Weight: 62.6kg 62.6kg
32+16C+16 959-12 Width: 2339mm 2261mm
Weight: 80.6kg 80.6kg
32+16C+32 959-13 Width: 2849mm 2771mm
Weight: 96.3kg 96.3kg
Extender (16-fader)|959-22 Width: 601mm 523mm
Weight: 23.1kg 23.1kg
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Minimum Distances & OB Van Mounting

Mechanical data for the Studio and OB version of the 16+16C frame are included here. You can find
similar data for other frame variations in the “mc2_Nova73_documentation” guide.

16+16C Studio Frame Installation

2
= P15 e Do net sbstruct_convection alr ouflef RAL 9005
. —- [o7 onsluL copermen
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E o ==
5 o - .
!j o T — R Y
{i - R o mnnn
i L2 :I L0 Il |1 ]
i ' |
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.
air_inlet ; 8195+ 1
min.50 80,5

=
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e ] n
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16+16C OB Van Frame Installation
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Grounding

Although operator protection is guaranteed (the control surface is connected via the Power

Connectors to the ground of the power supply system) it is best to establish an additional ground for
EMC reasons.

1. Fasten the grounding cable to the CASE grounding bolt (M5 x 12) on the rear panel using a

Screw M5 x 12mm

Torx T25 driver:
L©) ©)

E no_
GA5 | Y

TORXT25 -

K / M5x12 ,‘
é == For Ground Terminal '

ﬂﬂ ﬂﬂ El lﬂﬂ /
L 0" Contact Washer /

Ring Terminal

N

Ground Wire

Warning

The control surface must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the
device from being grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AESS3, digital interfaces (connected to the Local_I/O) should be connected to a
field ground.
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Power

Control surface power is provided by internal power supplies, and the power consumption is
dependent on the number of panels fitted to the surface.

Depending on the frame size, either one or two PSU blocks are fitted to each frame. Each block is
equipped with two power supplies running in parallel. Both share the current load; if one fails, then the
second is powerful enough to handle the required load alone.

Each of the supplies connects to the mains via its own terminal. Therefore, it is possible to realise
phase redundancy if each terminal is connected to a different phase (see below).

Larger frames require two PSU blocks, and any frame extenders also require their own supply.
The status of all PSU blocks may be monitored from the console GUI.

For details on how to change a PSU, see Control Surface PSU replacement.

Mains Connections

For each PSU block, two mains connectors (MAINS 1 & MAINS 2) are located on the rear of the
frame. Only one mains connection is essential for operation; the second provides redundancy.

Local I/O
Line IN 9-16 Lme out
Line IN 1-8 . . . . . . . .
MAINS 1 Line OUT 9-16

AES3 IN 5 8

FUSE 6,34 AEssOUT
U AES3 OUT 5-8 AES3'"‘4
oo Ol
MAINS 2 GCAUTION!

FUSE 6,34 ; ) ROUTER 1 ROUTER 2 ETH Extension CASE MADI RAVENNA
’ Remove both mains/line Plugs ETHA ETHA
U before opening the case. T'l;IRS))(”'I'ZZS

System Connections

IOI 101

It is recommended that MAINS 1 and MAINS 2 be run from separate phases of the mains supply,
and that the same two phases are used for all parts of the desk. It is also recommended that all
power connections are controlled from a common mains switch.

Warning
All devices MUST be connected to the mains using the three-cord power leads supplied
with the system.

Make sure that ALL circuits lie on the same ground potential. Otherwise, an internal bridge
of two ground wires will lead to a ground loop!
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To unplug the MAINS cables, press the red button to unlock the IEC connector:

Power Consumption

The maximum power consumption, per mains connection, for a fully loaded frame is:
e Current (max): 1.4 Ato 3.4 A (depending on the voltage)
e Power (max): 340 Watts

A control surface with fewer panels requires less current and power.

Due to the power supply inrush current, no more than three PSU blocks should be used per 16 A
circuit breaker.

Frame Spec & (Part Number) No. of PSU blocks per phase
16C (959-09)

16 + 16C (959-10)

16 + 16C + 16 (959-11)

32 + 16C + 16 (959-12)

32 + 16C + 32 (959-13)

16 Fader Extender (959-22)

R[NP |[R R

Electrical Voltage
The specification for each PSU block is:
¢ Input: 100-240 VAC (PFC)/ 47-63 Hz
e Output: 13 VDC / 18 A (max)/ 234 Watts (max)
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Console Keyboard Driver

The console keyboard is available in either English or German; if you change the keyboard, then you
will need to modify the driver as follows. For the mc256 MKII, the parameter for the keyboard
language is saved on the GUI_0 Bay Server (inside the control surface).

1. Using a computer connected to the Lawo system network, open a telnet session to the mc256
MKII control system, and remotely login to the GUI_0 control system.

Once logged in, you should see the GUI_0 control system prompt.
2. TyperemountRW /dev/hdcl and press Enter.

This step changes the write protection for the keyboard configuration file directory, so that the file
may be altered.

3. Typecd /media’/hdcl and press Enter.
This navigates to the correct directory.

4. Type joe keyboard and press Enter:

helcome to

Lawo moZ 90 Bayserwver Shell

thaddaeus_ GUI_0:~ § remountPW /dew/hdcl
thaddaeus_GUI_0:~ # cd /mediashdel
thaddaeus_GUI_0:/media/hdcl § joe keyboard =

This step starts a text editor, called joe, and opens the keyboard configuration file.

5. To change the language version, type:
e KEYBOARD=GERMAN (all capital letters), or
e KEYBOARD=ENGLISH (all capital letters):

& Ctorl-KE H for helpjiey

IJETEQATD=ENCLISH

6. Close the editor and save the file by pressing CTRL + K + X.
The newdriver is configured and will become active after the next reboot.

Note that the write protection of the keyboard configuration file is reset after the reboot.

9 You can reboot the control system from the telnet client by typing reboot and Enter.
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System Connections

Ethernet MADI! / RAVENNA

m ﬁ’/:j}fg !:\y f

Dallis 10 5 E Dallis IO
Stagebox Novar3 Stagebox

RAVENNA

The control system resides on the Router Module MKII (980/33) within the Nova73. Therefore, the
following essential connections are required to boot and test the system:

e FEthernet A - connects the control surface to the Nova73 Router Module.

e Control Surface Power - mains connections to the control surface frame.

o Nova73 Power - mains connections to the Nova73.

All other connections, including those to/from DALLIS IO units, may be made as and when required.

@ You may connect your external /O to the:

e Nova73 - see Nova73 Module Options.

e DALLIS - see DALLIS Interface Options.

e Local I/O (in the control surface) - see Local I/O.

mc256 MKIl Technical Manual V5.0/1 63



% Chapter 2: Installation

System Connections

Ethernet A

This port connects the console control surface to the control system on the Nova73 Router Module
MKII (980/33).

Connections are made via TCP/IP Ethernet. Only one connection (to the active Router Module) is
essential for operation; the second is required if a redundant Router Module is fitted:

Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors):

1. Connect either of the control surface ETH A ports (on the rear_connector panel) to the first
Nova73 Router Module.

e On the control surface, you may use either port (ROUTER 1 or ROUTER 2).
e On the Nova73, make sure you connect to ETHERNET A (and not ETHERNET B).

Control Surface Rear Nova73 Router Module MKII Front

ROUTER 1 ROUTER 2 ETH Extension

g0 00

ETHERNET A

0
: :ACTIVITV

100 1000

| evvenner

2. If a redundant Router Module is fitted to the Nova73, then run a second network cable from the
spare control surface port (ROUTER 1 or ROUTER 2) to the redundant Router Module
(ETHERNET A).

This second connection is essential to support control system redundancy.

3. You may now power on to boot and check the system, or continue with the rest of the system
wiring.
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Ethernet B (System Network)

The ETHERNET B port, on the Nova73 Router Module MKII (980/33), connects the control system to
the rest of the Lawo system network. This connection supports various applications including:

session, etc.

Remote control from Lawo's mxGUI software.
Remote configuration from Lawo's AdminHD software.

Remote control from a third-party device via Lawo's Remote MNOPL.

Diagnostics and maintenance from the Web_Browser Interface, Telnet

Control connections to other Lawo systems to support audio networking.

Remote maintenance, from Lawo's service department, via the dial-up
router.

Connections are made via TCP/IP Ethernet.

A single device can connect directly. However, more commonly, a network switch is installed to
support a wider system network.
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Network Connection

For a Direct Connection
Use a crossed network cable (STP-CAT 5 with RJ45 connectors):
1. Connect the device to the ETHERNET B port on the active Router Module MKII:

LAN (Ethernet)

FIFrsriss,
:::::::::

e

/O If a redundant Router Module is fitted, and a control system takeover is actioned, you will
lose your network connection. Therefore, a network switch is recommended.
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For a Connection via a Network Switch
Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors):
1. Connect the device to the network switch.
And, if not already installed:
2. Connect the network switch to the ETHERNET B port on the Router Module MKIL.

3. If a redundant Router Module is fitted, then run a second network connection. This ensures
continued operation should a control system takeover occur:

® Ethernet B

Network Switch

to other mc2
LAN (Ethernet) systems

or 3rd party
controllers

Lawo Software Applications:
mxGUI
AdminHD{ControlHD
Web Browser Interface

Warning

You must use a network switch and NOT a hub.
Keep the Lawo network separate from other network traffic within the installation.

For more information on installing a suitable network switch, please contact your local Lawo
representative or email service@lawo.com.

Depending on the number of network connections, one mc256 MKII system is able to support up to 16
clients simultaneously
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TCP/IP Configuration

To establish communication with the control system, you will need to configure the TCP/IP settings
for your device’s network interface card.

The following screenshots demonstrate how to do so on a computer running Windows 7 and Mac OS
X
Windows 7:

* » Control Panel » Networkand Internet » *Network and Sharing Center v | 43l Search ControtPanet - )

Control Panel Home

View your basic network inf ion and set up connections
- | v
Manage wireless networks h&-‘ _Local Area Connectigp Status L 2 J] Seefullmap Intemet Pratocol Version 4 (TCP/IPv4) Properties |2 |
1

Change adapter settings

TOSHIBALAPT| | | General @ : [ = ] General
Change advanced shating (This comput BF o s o Popetie: SR
settings Connection You can get IP settings assigned automatically if your network supports
View your active netwi Pvd Comectity: Networking | Sharing this capability. Otherwise, you need to ask your network administrator
: for the appropriate IP settings.
Netwol IPv6 Connectivity: Connect using
Public Media State: ¥ Reattek PCle GBE Family Controller 1 (7 Obtain an IP address automaticall
Duration: || #® Use the following TP address:
Speed: | 1P address: 192 . 168 . 123 . 100
This Gannection uses the following ftems | sadresst e
% p:bhc 8 Client for Microsoft Networks 3 Subnet mask: 255255 .
/3 \itualBox Bridged Networking Driver Default gatenay: L
121005 Packet Scheduler L |
Activity 7
Change your networki % "’:"‘le and Prnter Sharing for ;":v;a“"*s Obtain DNS server address automatically
emet Protocal Version &
G Setupaned o e TCPAPed) @ Use the following DNS server addresses:
Set up a wir = TRR-Tayer TopOIny DIECevey Mapper /0 Diver Preferred DNS server: .. f
Bytes: & Link-Layer Topalagy Discovery Respander A
o Connesti] — — o Alternate DNS server:
See also 3 o~ Instal [ Urinstal . Popeties ]
Connect or g rrapertes N
el opeilies) Deseription 7] alidate settings upon exit
Choose h ion Control Protocal. The defauit |
HomeGroup o‘& anse hoj wide area network protocol that provides commurication |
L Access files across diverse interconnected networks: L | EE
Windows Firewall [ Troubleshoof problems

| R i

Mac OS X:

Edit View Go Window Help

[“Y Finder File
About This Mac
Software Update...
App Store...

System Preferences

————
System Preferences..
T ——

Personal
Locaion 5 M &
Appearance  Desktop & Dock Exposé &
Recent Items Screen Saver Spaces - -
Location: | Home ]
Force Quit Finder i T
Sleep N £3 t
N Status: Connected
Restart... im T 5 Eth I d has the IP
CDs & DVDs. Displays Energy B . ‘thernet is currently active and has the
Shut Down... Saver @ AirPort = address 192.168.123.100.
Connected 2
Internet & Wireless .
FireWire . rﬁ
@ frewire g Configure IPv4: | Manually
@ IP Address: 192.168.123.100
MobileMe Bluetooth Sharing ] g';:*g;’:’y’:'(':?" 9

Subnet Mask: 255.255.255.0

System Router:

n ® G
Accounts Date & Time Parental Software S h D PR
Controls Update earc! lomains:

Other

B = © &

Flash Player  Growl Microsoft  Microsoft
Keyboard

— @
n S
Click the lock to prevent further changes. Revert ) (_ Apply

You can find further information from www.microsoft.com or www.apple.com.
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IP Address

The IP address of your device’s network interface card must be unique, and set within the same
range as that of the mc256 MKII control system.

You can check the IP address of your control system from the console GUI (using the Signal Settings
display). See TCP/IP Addresses for a list of the default IP addresses for different Lawo products.

For example, to connect to a mc266 with a default IP address = 192.168.102.65, set your device's IP
address to 192.168.102.101.

In a networked installation, it is likely that you will be connecting via an Ethernet switch, so please
consult your network administrator for further details.

/(_') Take care when setting the IP address of your device. If there is an IP conflict within the
network, then the console may not operate correctly.

Subnet Mask

The Subnet Mask of your device’s network interface card should be identical to that of the system. For
all products, the default Subnet Mask is 255.255.255.0.

Checking Network Communication

You can use AdminHD, mxGUI or the Web Browser Interface to check the network communication.
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Wiring from the Control Surface

Main Frame (Rear Connector Panel)

The principle connections come from the main control surface frame:

MAINS 1 Line OUT 9-16

FUSE 6,3A

Local I/O
Line IN 9-16 Lme out

...‘..‘.

AES33IN°5 -8 AES3 UUT

MAINS 2 CAUTION!

FUSE 6,34 ; ) ROUTER 1 ROUTER 2 ETH Extension CASE MADI RAVENNA
’ Remove both mains/line Plugs ETHA ETHA
U before opening the case. T'l;IRS))(”'I'ZZS

AES3 OUT 5-8 AES3'"‘4
oo Ol

IOI 101

System Connections

MAINS 1 & MAINS 2 - see control surface power. Only one mains connection is essential for
operation; the second provides redundancy.

CASE - see control surface grounding.

ROUTER 1 & ROUTER 2 (ETH A) - see Ethernet_A. Only one connection (to the active
Router Module) is essential for operation; the second connection is required if a redundant
Router Module is fitted.

ETH Extension x 2 (ETH A) - connect to extender frames.

MADI & RAVENNA - one of these ports connects the local_I/O board to the Nova73. The
connection type is pre-determined by the version of the Local /O board, so check your system

specification for details.

TBK, LINE, AES & GPIO - audio and GPIO breakouts for the local I/O, see Local /O and
Local /O Wiring.
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Extender Frames

Extenders require their own power and grounding connection, and connect to the main control
surface frame via Ethernet:

Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors) to connect the extender to one
of the ETH Extension ports on the main frame. If more than two extenders are fitted, then a Fast

Ethernet switch is supplied.

To Mains supply To control
) surface frame
Grounding Bolt - (ETH Extension)

If you are adding a new extender, then you may need to adjust the Bay Server address settings.

Main Frame (Front)

Note that a number of "user" connections are also available at the front of the console:
e USB x 2 - on the Overbridge, to connect the console keyboard or a data memory stick.
e XLR x 1 - on the Overbridge. This is the talkback mic connector.

e Stereo Headphones x 2 - in the arm rest. The default monitoring configuration sets HP 1 to
follow the CRM 1 monitor source selector, and HP 2 to follow CRM 2. Note that on larger
frames, two additional phones connectors (HP 3 & 4) operate in parallel with HP 1 & 2.

e Ethernet x 1 - in the arm rest. Another network_port for connecting an mxGUI or AdminHD/
service computer.
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Wiring from the Nova73

The Nova73 HD (shown below) and Nova73 Compact core provide identical connections:

Nova73HD Front View Nova73HD Rear View

L RN L L
8- LEEL:

Front Connections:

e PSU 1 & PSU 2 - see Nova73 power. Only one PSU is essential for operation; the second
provides redundancy.

e Router Module(s) MKII:
o ETHERNET A - connect to the control surface.
o ETHERNET B — connect to the Lawo system network.

If two Router Modules are fitted, then run Ethernet A and Ethernet B connections from both the
main and redundant Router Modules.

e MADI, ATM & RAVENNA - connect to DALLIS units or external /O devices. See Nova73
Module Options. One MADI or RAVENNA port must be reserved for the local l/O.

Rear Connections:

e SYNCHRONISATION Ports - see External Sync. If a sync reference is not connected, or
invalid, then the system automatically switches to internal sync.

e GPI1& 2, Global ALARM - see Nova73 Alarm & Control Contacts.

e AES Breakout Connectors - see Nova73 rear connector panels.
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Wiring from DALLIS Unit(s)

Front View (3U frame)

ZZZZ 22 e e w2 2 2
A= =l [l [ |
& | A A AS =0V
e i gé
. & "
g oele ey o g
Rear View (3U frame)
] @ @
::.w"mrmh‘
Powersupplies ~:»;_-
T @@ E

Front Connections:
e DALLIS Master Board(s):

o MADI, ATM or RAVENNA - connect to the Nova73, see DALLIS Interface Options. If two
master boards are fitted, then you may configure Link & Port Redundancy.

0 CTRL, WCLK, SYNC - on some master boards, you will find additional connections for a
control computer and local sync. Please refer to the relevant data sheet, available in the
"mc2_Nova73_documentation” guide. Note that external sync for the mc256 MKII should be
made to/from the Nova73.

e DALLIS I/O Cards - audio and GPIO breakouts, see DALLIS Interface Options.

Rear Connections:

e PSU 1 & PSU 2 - see DALLIS power. Only one PSU is essential for operation; the second
provides redundancy.

e ALARM & FORCE M2 - see DALLIS Alarm & Control Contacts.
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Nova73/DALLIS Interconnects

The type of master board determines how each DALLIS unit connects to the Nova73. There are three
possible options: MADI, ATM or RAVENNA:

MADI
e AESI10, multi-channel digital audio interface.

e Connections are either multi-mode or single-mode fibre, depending on the master board type;
duplex-SC connectors:

0 Multi-mode fibre: 62.5/ 125 1 m, 1300nm
0 Single-mode fibre: 9/ 125 jm, 1300nm
e Up to 64-channels at 48kHz, or 32-channels at 96kHz, per port.

/Lj A minimum of 4-channels are used to transport Port DSP resources to/from the DALLIS.
This leaves up to 60-channels at 48kHz, or 28-channels at 96kHz, for plug-in I/O.

ATM
e ATM, over STM-1, multi-channel digital audio interface.

e Connections are either multi-mode or single-mode fibre, depending on the master board type;
duplex-SC connectors:

0 Multi-mode fibre: 62.5/ 125 1 m, 1300nm
0 Single-mode fibre: 9/125 ym, 1300nm
e Up to 80-channels at 48kHz, or 40-channels at 96kHz, per port.

RAVENNA
e Ravenna Link 1.0, multi-channel digital audio over IP interface.
¢ Two physical connections, per port, for standard CAT 5 Ethernet and optical fibre:
o CAT 5/6/7 Gigabit Ethernet, RJ45 connectors, crossed or straight (1:1) cable, up to 200m.

o Optical transceivers (SFPs) can be installed for multi-mode or single-mode fibre. These
must be Lawo-certified, see SFP Modules.

e Up to 128-channels at 48kHz, and 96kHz*, per port, for DALLIS interconnects. (RAVENNA
supports 128/256-channels per port for non-DALLIS applications.)

/L) * 96kHz RAVENNA is a future option.
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Connecting the RAVENNA Ports

RAVENNA links should be directly wired to the corresponding RAVENNA port. The interface is
completely self-configuring. Thus, once you have connected the ports (from your Nova73 to DALLIS),
no further network configuration is necessary.

Warning

To guarantee low latency, reliability and easy setup, do NOT connect any network
equipment between the two RAVENNA ports.

When both copper and fibre are installed at start-up, fibre is the preferred medium. In either case, the
second medium can be hot-plugged without disturbing the current operating link. If a link breaks, then
the card automatically switches to the second medium (if installed) - note that there will be an audible
audio interruption until the automatic link/stream setup re-establishes the connection.

@ Close any unused optical connectors, with a protection plug, to avoid performance
degradation by dust or dirt.

For more details, see Service/Maintenance: RAVENNA Interfaces.
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External Sync

All external sync connections should be made to and from the Nova73 rear connector panel:

!vl FRAME
980/ 01

Il Sync inputs (Input 1/ 2) accept

i WORDCLOCK, VIDEO or AES/ EBU (AES3).
i & 4

i Ensure the proper termination of the inputs
It with 75 Ohm on the looped-through outputs

|
|
|
|
|
|
|
|
|
|
|
|
l
1 INPUT 1 INPUT 2 |
- |
|
|
|
|
|
|
|
|
|
|
|
|
|

m (Thru 1/ 2).

Il

Il )
il e .

:: ]7 SYNCHRONISATION 4(

I
§

Il J— — —
k N (7 |

m ) | | |

N THRU 1 WCLK OUT THRU 2

e INPUT 1 & INPUT 2 - accept Wordclock, Video Black Burst (PAL or NTSC) or AES 3-id.

/(_') When running the system referenced to Wordclock, the frequency of the sync source
MUST match the internal operating sample rate of the system.

The Nova73 supports only one video format at a time. Thus, if both inputs are supplied with
Video Black Burst, only signals of the same type can be used (either PAL or NTSC).

e THRU 1 & THRU 2 - provide an output of the sync signals connected to INPUT 1 & INPUT 2.
Note that the THRU ports provide a "looped-through" signal, and do NOT follow the system
clock selection.

Warning

If no further components are connected to the THRU ports, then it is essential to terminate
each port using a 75 ? resistor. Terminating resistors, designed as BNC connectors are
included in the delivery.

e WCLK OUT - provides an output of the current system clock. This output follows the system
clock selection.

The sync signal priorities are defined using the Wordclock options in the System Settings display.

9 A star-like clock distribution, via a distribution amplifier, offers better signal quality and
should be preferred to that of passive daisy chaining.

76 V5.0/1 mc256 MKIl Technical Manual



Chapter 2: Installation
System Connections

Nova73 Alarm & Control Contacts

O O
GLOBAL
ALARM
open if o.k.
GPI 1 GPI 2

Three alarm connectors appear on the Nova73 rear panel:

e GPI1& GPI 2 -two 25-pin D-Sub connectors carrying various input and output signals.

e GLOBAL ALARM - one BNC carrying the global alarm.

GPI1
25—
° =3
Q ol
- +5V/max. 150mA Inputs:
R GND optocouplers
°——1—}+ GENERAL PURPOSE IN 2 3..30V/

o—_1—} + GENERAL PURPOSE IN 1

>——1—} + ROUTER TAKEOVER (IN) typ. 8mA
“— 1} + PREPARE COLD START (IN) outputs:
TS } 2nd ROUTER ACTIVE relays
= } GENERAL PURPOSE OUT 2 max. 30V/
= } GENERAL PURPOSE OUT 1 500mA

—

GPI 2

25— )

+5Y¥/max. 150mA
GND

[ }+ ALARM A4 IN
—}+ALARM 3 IN

[ }+ALARM 2 IN
—}+ALARM 1IN
1_} CTRL LIFE-WATCH
o1 }2. ROUTER ACTIVE
1} PSU ALARM
o1} GLOBAL ALARM

TTGO

N

9 On both D-Sub connectors, you can pick up a short-circuit proof voltage feed (+5V, max

150mA).
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GPl Inputs

The GPl inputs are opto-couplers; accept voltages of 3V..20V; draw a typical current of 8 mA; and are
floating and galvanically isolated.

» GPI1

e GENERAL PURPOSE IN 1 & 2 — used for project-specific applications, please check your
system specification for details.

e ROUTER TAKEOVER (IN) — use this input to force a takeover to the redundant Router
Module. The takeover is triggered by a positive edge at the input.

¢ PREPARE COLDSTART (IN) —when turning on the Nova73, supply a voltage at this input to
force a cold start.

> GPI2

e ALARM IN 1to 4 - may be used to monitor peripheral equipment such as devices from other
manufacturers. The inputs MUST be factory-configured. Each alarm is triggered by an applied
voltage. When the input is open or grounded, the alarm is cancelled. Within the AdminHD
configuration, you can assign a text error message for each input, and define whether the
input activates the global alarm. Predefined standards are:

o0 ALARM 1IN = failure of the external clock supply (activates the global alarm).
0 ALARM 2 IN = failure of the external power supply (activates the global alarm).
o0 ALARM 3 IN = failure of the external /O system (activates the global alarm).

0 ALARM 4 IN = the external device exceeds its operating temperature (activates the global
alarm).
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System Connections

GPI Outputs

The GPI outputs are relays; output a maximum of 30V / 500 mA; and are floating and galvanically
isolated.

> GPI 1:

e 2nd ROUTER ACTIVE - this contact reports the activation of the redundant Router Module
(closed status).

e GENERAL PURPOSE OUT 1 & 2 — used for project-specific applications, please check your
system specification for detalls.
> GPI 2:

e CTRL LIFE-WATCH - this is a project-specific contact which can be used to report the loss
of a connection to another control system. Please contact your local Lawo representative or
email service@lawo.com for more details.

e PSU ALARM - this contact reports the failure of either of the Nova73 PSUs (closed status).
e GLOBAL ALARM - this contact signals that the global alarm is active (closed status).
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Global Alarm
The global alarm can be output by both the GLOBAL ALARM BNC and GPI 2 D-Sub connectors.

9 The global alarm status can also be monitored from the Web Browser Interface.
Global alarm errors are stored on the control system in the alarm.log system lodfile.

The global alarm may be disabled by the AdminHD configuration (see Parameters: Core -> System
Settings).

When enabled, the global alarm is triggered when any of the following conditions are satisfied:
Within the Nova73:

e Malfunction of a Router module.

¢ High temperature on a Router module — triggered if the temperature exceeds 45° C.

e Too high or too low a voltage to a Router module.

¢ Malfunction of an /O module in the Nova73.

e Malfunction of a PSU.

e Malfunction of a fan.

e Active external control input — the global alarm can be triggered by a control input from an
external device (e.g. via GPI).

¢ Internal sync (optional) - the the AdminHD configuration can set the global alarm to be triggerd
if the system switches to internal sync (see Parameters: Core -> Data).

From an I/O Port (e.g. DALLIS or external device):
¢ [f the port is not supplied with a valid signal.
e Malfunction of a DALLIS master board.
e Malfunction of a DALLIS I/O card.
e Malfunction of a DALLIS PSU.
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DALLIS Alarm & Control Contacts
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Three alarm connectors appear on the DALLIS rear panel:
e ALARM FORCE M2 -15-pin D-Sub carrying the DALLIS local alarm and other signals.

e FORCE M2 - BNC for the FORCE M2 control signal.
e ALARM - BNC carrying the DALLIS local alarm.

ALARM FORCE M2 D-Sub ALARM FORCE M2 Block Diagram
Al SN
arm § B gl = = = = = = = — — — — —
tact 40 ok | o 15 } Force second masterboard (M2) .
con(g:mﬁgeqs B\NCOU 7 14FI (depending on redundant board), FORCE M2 :ZZ: Optocoupler ratings
Alarm E;L'J. parallel connection to BNC 2 BNC 2 + 3=30V/3=-8mA  r===—— al
= 0 e
contact closed if ok ., 2% L = Master 2 select \L ,UC J|
Alarm in case of . ] t PSUT: contact closed if o.k. i T
— Mains failure . 10%7] ¢ PSUT: contact closed if o.k. H e _L q
— PSU failure o 9"t PSU2: contact closed if ok, o | C |
- E‘O mosLtEeDrboord ! (depending on redundant PSU) 15 M |
— Alarm on — L 3
— Wordclock T 14 Contact ratings
— Temperature
— Sec. PWR—-ERROR = 8 30V/100mA
— Wrong configuration 5 f————— 1
— Error on | 1 t
multi channel link —Ej 7 ok pC |
e e
( L >~ J
f— 1
I S f
5 2? & MG |
- T
7 L > J
1
10
-
2 Lor—== al
} ok PSUT! swi closed
9 [ ifonly PSUI
4]
A E—
| I
ALARM ‘LOK Pz
BNC 1T N T T T

contact position: coil without power
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ALARM FORCE M2
The following contacts are accessible via the ALARM FORCE M2 (15-pin D-Sub) connector:

Force second masterboard M2 (Pins 14&15) — use this input to force a redundant Master
Board takeover (if two master boards are fitted to the DALLIS). The takeover is triggered by a
positive edge at the input.

Alarm (Pins 7&8) — this contact signals that the DALLIS local alarm is active (closed status).

Alarm Inverted (Pins 5&13) — as above, but the status is inverted.
PSU 1 (Pins 3&11; Pins 2&10) — these contacts report the failure of PSU 1 (closed status).
PSU 2 (Pins 1&9) — this contact reports the failure of PSU 2, if fitted (closed status).

The two BNC connectors provide:

FORCE M2 —use this input to force a redundant Master Board takeover (as above).

ALARM - outputs the DALLIS local alarm.
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DALLIS Local Alarm

A local alarm for the DALLIS unit can be output by both the ALARM BNC and ALARM FORCE M2 D-

Sub connectors.

»

Note that some of the alarm conditions vary for DALLIS fitted with the RAVENNA master
board (947/21); the differences are highlighted in the second table below.

Local Alarm Output States for DALLIS fitted with 947/03, 947/13, 947/05, 947/07 and 947/15

Condition ALARM (BNC /D-Sub Pin |ALARM Inverted (D-Sub
7&8) Pin 5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present open closed

1 card in left slot, error present closed open

2 cards, booting closed open

2 cards, left no error, right no error open closed

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right error closed open

Local Alarm Output States for DALLIS fitted with 947/21

Condition ALARM (BNC /D-Sub Pin |ALARM Inverted (D-Sub
7&8) Pin 5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present closed open

1 card in left slot, error present open closed

2 cards, booting closed open

2 cards, left no error, right no error closed open

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right error open closed
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Powering On & Checking the System

For details on how to power on, see System Shutdown and Restart.

Once the system has booted, you can check that the status of all Nova73 and DALLIS components
by looking at the console’s Signal Settings display. If all modules and DALLIS units are installed and
operating correctly, then they appear in grey:

— Settings

3

- Destination

o Core 1 [mec256 Net 2009-04-02]

! Module 1 [DSP 983/03-007]

3

i Module 6 [ATM 981/56]
o Module 15 [DSP 983/03]

4

f== PSSl 1

If any components are not installed or connected, then a red/white cross in the System tree, and a
red highlighted card, shows the location of the problem. See Diagnosing System Errors.

You can also check the status LEDs on each unit’s front panel:

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE
LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the system. If
an LED is out of sync, then check that the card is fitted correctly, and if the symptom persists,
replace the card.

See also trouble-shooting for a list of example problems and fault-finding tips.
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Powering On & Checking the System

Diagnosing System Errors

In the event of a component failure, a hazard warning flag appears in the title bar of the console GUI.
Note that this flag will appear at the top of any display, so you don’t need to be viewing the Signal
Settings display to monitor your system hardware:

9:11:15

Snapshots

Snapshots

Type

1_Production Test Act 1 Scene 1 full 06/ 09:09:52

Act 1 Scene 3 full” " 06/08/10 09:09:55,
snapshot0004 Rl 06/08/10 09:09:56

Music

1. Press the SIGNAL button, located on the SCREEN CONTROL panel, to view the Signal
Settings display.

A red/white cross in the System tree, and a red highlighted card, show the location the problem.

2. [Ifthe fault is hidden within the System tree, follow the red warning flags and open each branch
of the tree to find the problem — in our example, a DALLIS card.

3. Open the DALLIS card further, and you will see grey/white crosses beside Signal In 1, Signal
In 2, etc. These show that the AES signals are no longer available:

T
2
3
3
b
[ o
3
3
b
e
3

- 0 -
PO

Port 1 MADI [REDUNDANT]
@ Dallis 3RU
b Card 1 [AES3]
& card 3 [AES3]
¢ Signal In 1
¢3 Signal In 2
%3 Signal In 3
¢3 signal In 4 Mic 01
v signal In 5
¥ signal In 6
¢ Signal In 7
#A Siagnal In 8

046A01m1

3. Check and replace the card if necessary.

Once all components are connected and working correctly, the red/white crosses disappear from
the System Settings display and the hazard warning flag in the title bar is cleared.
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System Settings
At this stage, you may also want to adjust the following System Settings from the console GUI:

e Wordclock Options - sample rate and system clock priorities.

¢ Level Options - reference level and headroom.

/(_') All System Settings are stored and recalled with productions. Therefore, any changes
should be saved for recall at a later date.
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System Settings

Wordclock Options

The Wordclock topic covers a range of options for selecting the internal sample_rate of the system,
and defining source priorities for system sync.

Settings

Max. Sample Rate
Level
Loudness Metering
SrcPriol
F E e X
Alarm when internal
Input 1 Signal wordClck
OK
WordClck

Channel Display

» word clock e 0K
None

Fader/joystick

Surround Mix Minus
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Max Sample Rate & Sample Rate

The option to run at higher (96kHz or 88.2kHz) or lower (48kHz or 44.1kHz) sample rates is made
within the AdminHD configuration and cannot be modified from the console.

/(_') Higher sample rates use twice as much DSP resource as lower sample rates; this is
reflected in the DSP Configurations display.

Higher sample rates also affect the crosspoint capacity of the routing matrix (8k2 at 48kHz,
or 4k? at 96kHz).

Max Sample Rate

The maximum rate is displayed in the Max Sample Rate field. This field is for display purposes only,
and determines the available Sample Rate options below.

Sample Rate
This option selects the internal sample rate of the system.

If the system is configured to run at lower sample rates (by AdminHD), then you may select either
48kHz or 44.1kHz operation.

If the system is configured to run at higher sample rates, then you may select 96kHz, 88.2kHz,
48kHz or 44.1kHz operation.

/(_') It is recommended that you mute your loudspeakers when changing the system sample
rate.

When running the system referenced to Wordclock, the frequency of the sync source
MUST match the internal operating sample rate of the system.
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System Clock Options
The remaining Wordclock options define the system's sync reference.

The Nova73 offers a fully redundant clock source structure with two independent clock inputs, an
internal sync generator and the ability to lock to sync from an incoming multi-channel signal. This
allows the console to be clocked from a variety of sync sources and recover from loss of external
sync.

Source Priority 1 & 2
These two options define the main and redundant clock source.

If sync is lost or a signal of an incorrect frequency appears on Source Priority 1, the system
automatically switches to Source Priority 2. Similarly, if sync is lost on Source Priority 2, the
system automatically switches to internal sync.

You can set each of the options to:

¢ Input 1 — connected to the Nova73 rear panel (Wordclock, Video Black Burst or AES3-id).

¢ Input 2 — connected to the Nova73 rear panel (Wordclock, Video Black Burst or AES3-id).

e MultiCh - Multichannel Sync (MADI or ATM, as defined by AdminHD).

Active Synchronization Source

This option displays and sets the active sync source for the system:
e Src Prio 1 —the input selected as Source Priority 1.
e Src Prio 2 —the input selected as Source Priority 2.

e |Internal.

Return Mode

This option activates a return mode so that the system will switch back to Source Priority 1 (or 2)
when it returns. The system even checks whether the return sync is valid and will not switch until the
sync source matches the chosen operating frequency of the console.

e Return Mode (On) - activates the return mode.
e Return Mode (Off) - deactivates the return mode.

To force the system to run on internal sync, deactivate the return mode and set the Active Source to
Internal.

Alarm when Internal

This option activates an alarm when the system is running on internal sync:
e Alarm when internal (On) - activates the alarm.
e Alarm when internal (Off) - deactivates the alarm.

The alarm triggers on-screen Warning flag and illuminates the red LED on the front panel of the
Nova73 Router Card.
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External Sync Input Status

The next five options are for display purposes only and show the status of the external and multi-
channel sync signals.

Settings

Level

Loudness Metering

Alarm when internal

Input 1 Signal WordClck

Channel Display Input 1 State oK

Input Ell WordClck

» Word clock Ol
MultiChannel State None

Fader/joystick

The example above shows that a valid Wordclock signal is connected to external inputs 1 and 2, and
the Active Synchronisation Source is Src Prio 1 = Input 1.
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System Settings

Level Options

Select the Level topic to make changes to the system's reference level, headroom or overload
threshold:

Settings
15.0dBu
0.00dB
} Level 0 d Threshold -1.0dB

Loudness Metering

FL

Channel Display

Fader/joystick

These levels affect the maximum analogue level from your system according to the following
equation:

e Maximum Analogue Level = Reference Level + Headroom

The system supports a maximum analogue level = +24dB, and a minimum analogue level = +12dBu.

Warning

Changing the Reference Level or Headroom options move the internal 0dB operating
point for the system and therefore will change the behaviour of any level dependent settings
such as dynamics processing and metering. Therefore, it is not advisable to alter these
levels once dynamics processing has been set.

/O For systems fitted with fixed level analogue /O cards:

e The Headroom and Reference Level cannot be altered independently. For
example, with a +15dBu fixed analogue /O card and +9dB Headroom, the
Reference Level must be +6dBu.

e The Maximum_Analogue Level of the whole system is defined by the DALLIS card
with the lowest GDA (General Device Address) - this is the card with the lowest
address fitted to the DALLIS frame connected to the lowest port number of the first
Nova73. (If a different fixed level analogue card is fitted elsewhere within the
system, then a warning appears in the log file; however, the card with the lowest
GDA still wins.)
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Reference Level
Sets the reference level of your analogue interfaces in dBu.

Reference level may be set from 0dBu to +24dBu, depending on the Headroom.
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System Settings

Headroom

Sets the operating headroom to the external world; this is the difference between the analogue
reference level and digital full scale (0dBFS).

Headroom may be set from 0dB to +20dB depending on the Reference level.

Note that the internal Headroom is more then 380dB which means, if you route from input to group to
group to sum, you can overdrive the level more then 380dB before clipping!
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Chapter 3: AdminHD

Introduction

This chapter covers AdminHD, the Lawo software programme which runs on an external computer

to provide remote configuration of any mc? system.

Topics covered are:

Overview
AdminHD and mxGUI
Compatibility

Computer System Requirements

Software Installation

Connecting to the Lawo Control System

Configuration Files

Operating Principles

Core Configuration: First Steps

Core Configuration: Defining the System

Core Configuration: Editing Parameters

Signal List Configuration

Online Operation

System Diagnostics

The ‘Connect Manager’

Documenting the Configuration

Core Configuration: Parameters

mxDSP Configuration

The 'Console Panel'
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Overview

Overview
AdminHD is the Lawo software application used to configure all Nova73 systems.

It is responsible for generating the config.tcl and gui_config.tcl configuration files, which are read by
the control system at boot-up following a cold_start. These files define the Nova73 and DALLIS
system components, and the console GUI's Signal List display:

System Configuration Signal List Editor

e B

i= signal list editor - C:\Documents and Settings',Sue McdonaldMy Documents't AdminHD_Configs\Studio 2\signallist.sl...

B Bemote s Window 7

=Moo & x M

Source ' Destination |

Directories & signals Hardware Tree Selected signals
DaMHEeL BOO0Fansd™ |- + =
Bus Out | M1
Direct Out Mz
Insert Send M3
= b M+

S8t agebox ms
M1 Me
Mz Card 4 [MIC] e
M3 [-Card 5 [MIC] Me

M4 Card 6 [MIC]

. Stagebox 2 Card 11 [LINE]

Machines ALSZ

'DSP4
5P8
1_64
164

It can also run online to provide control of matrix crosspoints, signal labels and /O settings, or
perform system diagnostics:

Online Connect Manager System Diagnostics

<4 Connect manager
e s e

e + == & B

List | Makrix | Snapshok |

Sourss sigrals Destination signals Destination directories
al[e O01ADIm] ANADL.D1 5] 001401m1 ANADLDI | [E-O MOIPOIDALSD

Card L [LINE] [} 001ADmZ ANAOD.02 [*] 01ADIm2 ANADL 02 0

O Card 3[LINE] [} 001ADImS ANAOD.03 6] 01ADIm3 ANADL.03 O Card 3[LINE]

O Card S[LINE] (] O01ADImS ANAOD.04 &) 01ADImS ANADL.04 O Card S[LINE]

O Card 7 [LINE] [ QOLADIMS ANAQLOS %] UOLADLMS ANADLOS O Card 7 [LINE]
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Comiie | |9 gwew s |0 e mow ||| O Ciin
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O MD1PO3DALED MOLIPOIDALSD
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O MO1POIDSPS 3 HO1PO3DSPE 3

Comnected destinations | Source paramsters |

Comnected source | Destination parameters |

ame [abel | superdevice

|pevice

ame |abel [superde:

vie  |Device

 Core rowser

=M 00 ﬁ~ [ = [ 7] =

0l

B
B

)

Lelio]|

In addition, a number of useful tools are included for documenting the configuration.
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The configuration_files created by AdminHD are an essential part of the system. If a hardware
component is not defined within these files, then it will not be visible to the user even if it is powered
and connected. In other words, the configuration is always the ‘master’ of the system, regardless of
what physical components are added or removed.

This brings a number of advantages:
e The configuration is always controlled by AdminHD.

¢ You can configure components which may not be permanently connected (e.g. Stageboxes)
so that routes can be made to/from these devices without relying on a physical hardware
connection.

¢ You can easily test changes to the configuration offline. If a component or parameter is not
available within the AdminHD software, then it is ‘illegal’. This allows you to prepare
configuration updates offline, and upload them to the system with confidence.

e AdminHD can connect to the control system of mxGUI. This allows you to open mxGUI using a
pre-prepared configuration in order to create user settings ahead of an event.
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AdminHD and mxGUI

AdminHD and mxGUI

From Version 4.8 software onwards, a separate programme — mxGUI — is available to complement
AdminHD.
Both programmes can run online to remotely control a real system. AdminHD offers control of matrix

cross points, signal labels and I/O parameters only (via the '‘Connect_Manager'). mxGUI emulates the
GUI displays of the mc? consoles, providing control of virtually any user parameter.

Both programmes can also run offline on your computer. This allows you to prepare a complete
system ahead of an event as follows:

1. Use AdminHD to define the Core configuration (config.tcl) and Signal List (gui_config.tcl).

2. Upload the configuration files from AdminHD to the mxGUI local control system on your
computer.

3. Use mxGUI to prepare and save user settings (by saving a production).

4. Once connected to the final system, you can use mxGUI to transfer both the configuration
and production(s) from your computer to the Lawo control system.

For more details on mxGUI, please refer to the "mc256 Operators Manual”.
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Compatibility

AdminHD may configure, or connect to, any Nova73 system. To ensure that you can only access the
options supported by your product, the software can be opened in one of two modes:

e AdminHD for Mixing Consoles — supports mc?56, 66 and 90 consoles (MKI and MKII).

e AdminHD for Nova73 & DSHS — supports the Nova73 stand-alone routing matrix, or Nova73
HD Dual Self-Healing Star.

When new hardware options or software features are released for any of these systems, then a new
version of AdminHD is also issued.

/;\_j From version 4.0.2.2 onwards, all Lawo products have adopted a consistent software
release numbering system to indicate compatibility. In each case, the first three digits of
the software version must match.

So, to prepare a configuration or connect to a mc? console running 4.20.2.0, you need to
run AdminHD 4.20.2.x.

You can check the software version of your mc? system from the Global Options in the
System Settings display, and the version of AdminHD from the ? main menu.

Note that:

e Configurations saved by an earlier version of AdminHD can be opened in a later release.
However, configurations saved by a newer release are not backwards compatible.

¢ Configurations created for one type of system are NOT compatible with another; you cannot
open a mixing console configuration from AdminHD for Nova73 & DSHS, or vice versa.
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Computer System Requirements

To install and run the AdminHD software, your computer MUST meet or exceed the following system
requirements:

Windows PC:

Hardware: 500MHz.

Operating System: Windows XP, Windows Vista (32-bit), Windows 7 (32-bit and 64-bit)
RAM: 1.5GB RAM (Windows XP), 2GB RAM (Windows Vista/7).

Hard Disc: minimum 200 MB free space.

Operation: Keyboard and mouse.

Interface: Ethernet 10/100Mbit.

Hardware: 500MHz.

Operating System: MAC OS X 10.6 (Snow Leopard), 10.7 (Lion), 10.8 (Mountain Lion)
RAM: 2GB RAM

Hard Disc: minimum 200 MB free space.

Operation: Keyboard and mouse.

Interface: Ethernet 10/100Mbit.
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Software Installation
During installation, you may choose to install AdminHD and/or ControlHD:

e AdminHD is the administration programme providing configuration, remote control, system
diagnostics and documentation.

e ControlHD is a subset of the AdminHD software. It looks and operates in an identical manner,
but can only be used for remote control and system diagnostics (i.e. not configuration).

@ By installing only ControlHD on some computers and AdminHD on others, you can set up
computers for different users within the facility. Remember that you may also use mxGUI
for online operation of the system.

In each case, both modes are installed (... for Mixing Consoles and ... for Nova73 & DSHS),
resulting in up to four programme entries on your computer:

m

. Lawe

. AdminHD 414

. AdminHD 4.16

. AdminHD 418
AdrminHD 4.20
%] AdminHD for Mixing Consoles
& AdminHD for Nova73 & DSHS
%] ControlHD for Mixing Consoles
%] ControlHD for Noval3 & DSHS

. Editor

. Jade -

1 Back

| Search programs and files 02 |

2w

/(_') You can install multiple AdminHD versions (4.18, 4.20, etc.) as shown above; there is no
need to uninstall older versions. This is particularly useful when working with systems
running different releases of software..

Licensing

Lawo’s AdminHD/ControlHD application is free of charge and does not require a software licence.
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Installation Procedure
1. Copythe AdminHD_Release_X-X-X-X.zip onto your computer and unpack the file.
2. Double-click on the relevant installer.

AdminHD is delivered in a compressed format, so it may take a few seconds before you see the
‘Setup Wizard”.

“m AdminHD 4.20.2 for me® consoles & Nova73 series =] |

Installanyehere will guide you through the installation of AdminHD

Itis strongly recommended that vou guit all programs before
continuing with this installation

Click the 'Mext' button to praceed to the next screen. Ifyou want to
change something on a previous screen, click the Previous' buttan.

rou may cancel this installation at any time by clicking the 'Cancel
buttan.

Cancel Previous Mext

/O If you are running Windows 7, then you may be prompted to allow changes to your User
Account; select Yes to continue.

If you are running MAC OS X 10.8 (Mountain Lion), and have problems opening the
installer, see additional notes for MAC OS X.

3. Follow the Wizard's instructions accepting the default options provided.

As part of the installation process, you can choose the AdminHD, ControlHD or AdminHD +
ControlHD install set.

4. When you reach the 'Summary' window, check the options and click Install.
The software is installed onto your computer; this may take a few minutes.

By default, files are installed in the location: ‘C:\Program Files\Lawo/AdminHD X.XX'. where X.XX is
the release version.

5. When the installation is complete, a confirmation window will appear.
6. Click on Finish to exit the ‘Setup Wizard'.

If you have any problems with the software installation, please contact your local Lawo representative
or email service@lawo.com.
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Additional Notes for MAC OS X Installation

If you are running MAC OS X 10.8.x.x (Mountain Lion), then you may see the following error message
after double-clicking on the "install.exe" file:

N “New App” is damaged and can’t be
K@# opened. You should move it to the Trash.
1

Safari downloaded this file today at 12:38 PM from
example.com

'r | Cancel | | Moverto Trash |

This error can appear if your "Gatekeeper.app" does not allow installation from downloads which are
not from the MAC App Store. To change this setting:

1. Select "System Preferences -> Security & Privacy" and set the "Allow applications
downloaded from:" as follows:

800 Security & Privacy
[« » ][ showan | Q

FileVault = Firewall Privacy

A login password has been set for this user | Change Password... |

| Require password | immediately :  after sleep or screen saver begins

_| Show a message when the screen is locked | Set Lock Message

E Disable automatic login

Allow applications downloaded from:

_IMac App Store
(*)Mac App Store and identified developers
I Anywhere

il :
J£ Click the lock to prevent further changes. Advanced... (7

2. Then retry opening the AdminHD "install.exe" file.
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Uninstall & Update

Uninstalling AdminHD
On Windows 7, use the “Uninstall a program” option within the Control Panel to uninstall AdminHD.

On MAC OS X, remove the programme from your "Applications" folder.
Updating AdminHD

To update to a newer version of AdminHD or ControlHD, simply run the installer; there is no need to
uninstall older versions. Following installation, each version appears within its own folder:

. Lawe

. AdminHD 414

. AdminHD 4.16

. AdminHD 418
AdrminHD 4.20
%] AdminHD for Mixing Consoles
& AdminHD for Nova73 & DSHS
%] ControlHD for Mixing Consoles
¥ ControlHD for Nova73 & DSHS

. Editor

. Jade -

1 Back

| Search programs and files 02 |

2w
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Connecting to the Lawo Control System

In order to transfer configuration data, or run AdminHD online, you will need a valid network
connection between your computer and the mc256 MKII control system.

On the mc256 MKII, the ETHERNET B port on the Nova73 Router Module MKII (980/33) should be
used:

1. Connect your computer to the Lawo system network.

2. Configure the TCP/IP settings on your computer's network interface card.

/g_) The control system location may vary for other Lawo products, see Control System
Locations.

You may open an existing AdminHD file, or create a new configuration, without this
connection. However, it is a good idea to configure the network now, so that you are ready
to transfer data later.
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Checking the Network Communication

If this is the first time you have connected to the mc256 MKII control system, then start AdminHD,
create a new session and then download the online configuration from the remote system:

e [|f the connection is successful, then the 'Core_Browser' updates to display the hardware
components for your system.

e [f the connection fails, then nothing appears in the 'Core Browser', and the ‘Remote_Log’
reports that the connection has timed out:

0 Check the network_connection and TCP/IP_settings of your computer's network interface
card.

0 Check that AdminHD is compatible with the mc256 MKII system (the first three digits of the
software versions must match.)

0 See also the trouble-shooting tips to resolve the problem.

Alternatively, if you have an existing AdminHD file, with the correct system IP_address, then you can
switch online to test the network communication.
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Configuration Files

Before you start working with AdminHD, it is useful to understand how configuration data is stored on
the mc256 MKII control system, and which files can be edited and saved on your AdminHD computer.
The diagram below illustrates the processes involved; keep reading for further explanation.

Admin HD Computer
System Configuration

i) The System & Signal Parameters ‘O DOWNLOAD all data from Remote HD

Control System

€ UPLOAD all data to Remote HD

Online
Configuration

<+

- APy e |
E -EHH-‘ £ i
File > SAVE
| v
File » EXPORT

config.csv

. config.tcl

ii) Console Control Panel
(mec266 MKl only)

et

File > EXPORT console_config.tcl

(66 MKI only)

iii} Signal List Editor

£ DOWNLOAD GUI Signal List from control system

<

(saved as Warm Start Cold
H data at shutdown) Start

Cold Start Files

Remote -= UPLOAD file
config.tcl

Remote -= UPLOAD file

console_config.tcl
(factory-configured
except for 66 MKI)

Other Files include:
custom.icl
userconfig.tcl
chstom_template_instancgs

téi EXPORT to cold start config

SAVE Signal List Config

i signallist.slx

Online Control - Connect Manager

= OPEN Signal List config

ONLINE CONTROL

~ qgui_config.tcl Remote > UPLOAD file ﬂ gui_config.tcl

Online Settings
(saved as Warm Start
data at shutdown)

Other Files include:

connectionlist.csv
config.bfe
remote.log
snapX.lsn
system_log_message.log
systemlist.csv
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Control System Cold Start Files

The following configuration files are stored on the mc256 MKII control system, and are read after a
cold start:

e config.tcl — this file, known as the Core configuration, defines the:
0 Nova73 and DALLIS components.
0 System-wide parameters such as sample rate, reference levels and sync options.

o Signal parameters such as the HLSD address, name, default label, /O settings, silence
detects and mapping tables.

e gui_config.tcl — this file, known as the Signal List configuration, defines the Directories,
Subdirectories and signal organisation within the GUI's Signal List display.

e console_config.tcl — this file, known as the Console configuration, defines the control surface
layout for mc? consoles.

e custom.tcl — this file defines customer-specific functions.
e userconfig.tcl — this file defines the user monitoring functions in the mc? console series.

e Custom_template_instances — this folder stores the custom functions programmed from the
GUI's Custom Functions display. Each function is stored as a separate .tcl file.

The table below summarises which files can be edited by AdminHD and which must be factory-
configured. Also, whether files can be accessed by mxGUI and how they are named within mxGUI's
File Transfer display:

Edit in File Transfer to
Control System Filename AdminHD mxGUI Appears in mxGUI as:
config.tcl v v Core Configuration
gui_config.tcl v v Signal List Configuration
console_config.tcl Vv * v Console Configuration
custom.tcl x x n/a
userconfig.tcl x x n/a
Custom_template_instanc x v Custom_template_instance
es S
/;\_) * The console_config.tcl file can be edited using AdminHD for MKI mc266 systems only;
for all other mc? consoles, this file is factory-configured; the file is unused by a stand-alone
Nova73.
Files such as the custom.tcl and userconfig.tcl must be edited by Lawo personnel.
Please contact your local Lawo representative or email service@lawo.com if you require
further assistance to modify these aspects of the configuration.
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AdminHD Files (on your computer)

AdminHD cannot edit the config.tcl and gui_config.tcl files directly. Instead, it downloads the online
configuration (running in memory) from the mc256 MKII, and saves it locally onto your computer as a
.csv or .slx file. These file types can then be opened, edited and saved by any AdminHD computer.

Once editing is complete, you can choose to either update the online configuration (in temporary
memory) or export and upload new versions of the cold start .tcl files (recommended for permanent
changes).

Organising Your Files

These processes mean that AdminHD creates several files all relating to a single system's
configuration.

In the example below, we have created a folder named Studio 2 to store all the AdminHD files for a
mc? mixing console:

File Edit View Favorites Tools Help

eBack M =Y l’; /-:Search |~ Folders v

MName Size | Type

s

File and Folder Tasks 2 1 | snaplen 2KB LSNFile

3 Make a new folder
g Publish this folder to the

= snap2.lsn 2KB LSNFile
@_e]cunﬁg.csv 424KE Microsoft Office Excel Comma Separated Values File
Web @_e]cnnnechnnhst.csv 1KB Microsoft Office Excel Comma Separated Values File
EJ Share this folder sysbemlist 102KE  Microsoft Office Excel Comma Separated Values File
signallist. shx 8KB S5LXFile
=) config.tol 493KB TCLFile
cnnsnle_cnnﬁg.h:l 1KB TCL File
&) qui_config.td 9KB TCLFile
E] remote 1KB Text Document

Details [Z] system_log_message 1KB Text Document

@ Create a backup folder to store copies of the current configuration files before you begin
editing.

When using both AdminHD and mxGUI, you could create a master folder for the system,
with separate sub folders for AdminHD and mxGUI.
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The following files are created by AdminHD and stored locally on your computer:

e config.csv - created when you save the AdminHD configuration. This is a .csv file which can
be opened by AdminHD, ControlHD or imported into a 3rd party editor such as MS Excel.

You can give this file any name as long as it keeps the .csv suffix. It is a good idea to keep "config"
in the name to distinguish it from other .csv files.

¢ signallist.sIx - created when you save a Signal List from the ‘Signal List Editor’. This is a .slx
file which can only be opened by AdminHD or ControlHD. You will need to copy this file to
other AdminHD/ControlHD computers if you wish to open the Signal List within the ‘Connect

Manager'.
You can give this file any name as long as it keeps the .slx suffix. If you are creating multiple signal

lists for different ControlHD/AdminHD users, then choose something descriptive like
AudioControl.slx, VideoGallery.slx.

e config.tcl and gui_config.tcl - are the cold start configuration files exported from AdminHD.
They are stored locally on your computer, in preparation for an upload to the mc256 MKI
control system.

DO NOT rename these files, or edit them using an application other than AdminHD. Otherwise,
they cannot be read by the control system! If you wish to keep copies of ‘older’ versions, store
them in a sub folder or change the filename.

e systemlist.csv - can be exported to produce a parts_list for the hardware defined within your
configuration. It is a .csv file which can be opened by a 3rd party editor, such as MS Excel, in
order to print or view the data.

e connectionlist.csv - can be exported from the ‘Connect Manager'. It is a .csv files which can
be opened by a 3rd party editor, such as MS Excel, in order to print or view all matrix
crosspoints set within the system.

e config.bfe - exported for use with a BFE controller system. Please contact your local Lawo
representative or email service@lawo.com for more details.

e remote.log - created when you save the contents of the ‘Remote Log’ window as a text file.
You may be asked for this file if you request assistance from the Lawo service department.

e system_log_message.log - can be downloaded from the mc256 MKII control system. You
may be asked for this file if you request assistance from the Lawo service department.

e snapX.lsn - are snapshot files which you can save or load from the ‘Connect_ Manager'. If you
are creating snapshots for multiple systems, then store them in separate folders on your
computer.
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Operating Principles

This section covers the basic operating principles of AdminHD:

Starting AdminHD

The Main Operating Window

Online/Offline Status

The Main Toolbar

The Sub Windows

‘Core Browser’

‘Graphic View’

‘Parameter Box’

'Remote Log'

The Main Menus

AdminHD Preferences

If you'd like some data to work with, then create a new session and download the online
configuration from the mc256 MKII to your computer (recommended). Or, open an existing

config.csv file.

If neither of these options are possible, create a new session and build a simple Core

configuration from scratch.
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Starting AdminHD

1. Start the programme, by selecting AdminHD for Mixing Consoles from the START menu
(Windows) or Applications folder (MAC):

Ju Lawo E
| AdminHD 4.14
L. AdminHD 4.16

| AdminHD 4.18

. AdminHD 4.20 |
¥ AdminHD for Mixing Consoles
-ﬁ AdminHD for Noval3 & D5HS
-ﬁ ControlHD for Mixing Consoles
%] ControlHD for Noval3 & DSHS

| Editor

L Jade -

1 Back

| Search programs and files 0 |

Warning

It is very important that you choose the correct mode (... for Mixing Consoles and not ...
for Nova73) , AND the correct software version (the first three digits must match the
software running on your remote system).

If not, AdminHD will not be able to connect to the mc256 MKII. Or, the system may not read
your configuration data. See Compatibility for details.

AdminHD starts up and opens the last configuration file (config.csv) you were working on:

) AdminHD - C: ion & Training)\Lawo - All i in HDVAdminHD_Configs\V4.16 - Config Used for Manuals updated to V4 1B\configasy [E=SRed )
File Remote Exras Window 2

= @ KO kW EL+ =

or
Module 2 [AES3]
Port 1 AES3
E}-Port 2 MADI
E1-Dallis 3RU (52 channels)
Card 1 [LINE]
Card 4 [AES3]
Card 6 [MIC]
Card 11 [SDI]
Card 13 [SDI}
Masterboard
PSU
Redundant PSU
{DSP Resources (4 channels)
DSP Resources (8 channels)
odule 4 [MADI]
fi-Port 1 MADI

zzz @z
cCRiids

FR-F
FREE

ek [ T T o [

/O If the file was saved in an older version of AdminHD, then you will be asked to convert it.

The ‘Core Browser’ and ‘Remote Log’ sub windows may open automatically (according to
the Extras -> Preferences -> Startup menu).
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If this is the first time you have started AdminHD, or a file could not be loaded, then AdminHD opens
with a completely empty operating window:
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File Conversion
The following dialogue pop-up appears if there is a mismatch between the AdminHD software version
and the configuration file you are trying to open:

x

Confirm | |

Do You want to convert to the curent version (4.20) #7

| Yes | | Mo |

@ The existing config file has an old version number (4.16)

e Select Yes to convert the configuration file to the newer AdminHD release.

e Select No to leave the file unchanged, and open AdminHD without any configuration data.
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The Main Operating Window

5 Admi -cqpf AD ion & Training\Lawo - All ion\Admin HD\AdminHD_Configs\V4.16 - Config Used for Manuals updated to V416\configesv ™ ||

=1 Madule 2 [AES3]
-Port1 AES3
EH-Part 2 MADT
(- Dallis 3RU (52 channels)
| E-Card1 [LINE]
B Card 4 [AES3]
Card 6 [MIC]
~Card 11 [SDI]
Card 13 [SDI]
~Masterboard
~PSU
.~ Redundant PSU
-+~DSP Resources (4 channels)
DSP Resources (8 channels)
Meodule 4 [MADI]
B-Part1 MADI
*--Port 2 MADI
~Module 11 [DSP]
~~Module 13 [DSP]
Module 15 [DSP]
-~ Router medule
PSU
-~ Redundant PSU

m

[ II | mc® console I E | || ottline ]
A

The main operating window is divided as follows:

1 Headline Displays AdminHD, or Control HD, followed by the file path of the open file
(config.csv). If no filename appears, then this is a new AdminHD session.
If the filename is followed by an asterisk (*), then changes have been made
since the last save.
On the right you can close the programme or minimise/maximise AdminHD
in the usual manner.

2 Main Menus Access to the File, Remote, Extras, Window and ? main menus.
3 Main Toolbar Fast access to common functions.
4 Sub Windows This is the main operating area in which you can open a mixture of sub

windows. In our example, only the ‘Core Browser' is open.

5 Status Bar Displays the AdminHD mode (mc2 console or Nova73 HD) and online/
offline status.
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Online/Offline Status

AdminHD starts up in offline mode; the online/offline status is shown in the status bar at the bottom of
the display:

¥ AdmintiD - CAUsers\Sue\Dacuments\Documentation & Training\Lawo - All Documentatiom\Admin HD\AdminHD_Configs\V4.16 - Config Used for Manuals updated to VA16\onfigesv® = )
File Remote Edras Window ?

MO0 & K [H @M+

Core browser

=L re A

Jl«

ter

m“:?

m
Corel
E}-Medule 2 [AES3]

N ™ S

‘I—H—Hmﬂ—\l—l

Offline
When running offline, you can:
¢ Download configuration data (from the online system to your computer).

e Edit the configuration data, locally on your computer in AdminHD.

e Export and upload cold start configuration files (from your computer to the mc256 MKII control
system).

Note that to download and upload data, you will need a valid network connection between your
AdminHD computer and the mc256 MKII control system.

Online
You should switch to online mode if you wish to:

¢ Monitor the system status.

e Use the 'Connect Manager' to control matrix crosspoints, signal labels and /O settings.

¢ Update the online configuration (in memory).
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The Main Toolbar

1 2 3 4 5 6
= Q0 & K

i

7 8 910 11 1213
o BT 4 -

The first six buttons provides fast access to common functions:

1 Open Opens an existing AdminHD file (config.csv).

2 Save Saves the current AdminHD configuration as a config.csv file.

3 Download Downloads configuration data from the online control system into AdminHD.

4 Upload Uploads the AdminHD configuration to the online system (available in online
mode only).

5 Online Enables (or disables) the online connection to the remote control system.

6 Preferences Opens the AdminHD Preferences window.

The remaining buttons show or hide the sub windows.
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The Sub Windows

AdminHD supports seven sub windows. They can be opened from the main toolbar, the Window
menu, or by using a keyboard shortcut:

Toolbar Window menu & Keyboard Shortcuts

1 2 3 4 5 6

AM Q0 @ 5

Window ¥

7 8 910 11 1213
|__] Core browser Cid+5Shift-B

7 Core Browser

8 Parameter Box

9 Graphic View
(Frame editor)

10 Console Panel

11  Signal List Editor

12  Connect Manager

13 Remote Log

(=

I "H ] 4 e [ parameter box  Ctl+Shif-p
-

'8, Frame editar Ctl+Shift-F
W Conscle Frame Ctl+Shift-C
1= gignal list editar  Crd+Shif-s

< Connect manager Gl +5hift-c
& Remote |og CtH+Shift-L

Displays the Core configuration hardware as a system tree. You can
navigate around the system, and add or remove components. When
running online, components are colour-coded to provide diagnostics.

Used to adjust parameters for the selected component or signal.

Provides a graphical representation of the system. Works in
conjunction with the 'Core Browser' to add or remove system
components. When running online, components are colour-coded to
provide diagnostics.

Defines the Console configuration (MKI mc266 systems only).

Creates the Signal List configuration used in the GUI's Signal List
display or AdminHD's 'Connect Manager'.

Available in online mode only. Here you can remotely control matrix
crosspoints, signal labels and /O settings.

Logs all the messages generated by AdminHD and, when online, the
mc256 MKII control system.

/(_') Some selections may be unavailable (greyed out). For example, the 'Connect Manager'
can only be selected once you are running online.
The ‘Core Browser’ and ‘Remote Log’ may open automatically (according to the Extras ->
Preferences -> Startup menu).
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Arranging the Sub Windows
The sub windows are rarely used in isolation, and should be combined according to the application.

For example, while editing a configuration, you may open the 'Core Browser', 'Graphic View',
'Parameter Box' and 'Remote Log'":

| AdminHD - CAUsers\Sue\Documents\Documentation & Training\Lawo - All DocumentationAdmin HD\AdminHD_ConfigsiV4.20 - Config Used for Manuals\Studiol._config.csv =) S

Eile Remote Extras Window 7
T G z [
MO0 & K

[T Core browser

{4l Core 1 - mc* Studio 1

B ez B

@ i
...... S = st D)
- * n -
| Module alias [map1s1/31
E, : % Slot number |2
Bl | | Module model number [981/31 |
|
i |
} ?ﬁ | Module type [981/21 MADIZ MMF ]
- o Les | | -
B E B |
- Card 16 [LINE]
Card 18 [NA]
i Masterboard
. Redundant masterboard

+-PSU
- Redundant PSU
1-DSP Resources (4 channels)
P Resources (8 channels)
1-Port 2 MADI
- Module 4 [MADI]
- Module 11 [DSP]
Module 13 [DSP]
~Module 15 [DSP]
- Router module

PSU
- Redundant PSU

-
‘ || mc® console ” ” Offline ” ” ‘

Sub windows can be closed, minimised, resized or moved as follows:
1. Clickon E to close a window.
2. Click on # to minimise a window.

Minimised windows are reduced to a button, for example:

File Remote Extras Window 7

M 00 @ X
[ J Core browser

e @ A
[ERCor=1

E-Maodule 2 [MADI]
i EPort1 MADI [REDUNDANT]

Corel - mc® Studi.

Click on the button - e.g. Core 1 - to restore the window to its original size and position.

3. To change the size of a window, point to the relevant margin or corner, and drag left/right or
up/down accordingly.

4. To move a window, place the mouse pointer over the title bar of the window. Then drag and
drop the window to its new position.

/(_') The ‘Core Browser’ cannot be minimized or moved.
The ‘Graphic View’ cannot be resized.
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‘Core Browser’

The ‘Core Browser’ displays the Core configuration using a hierarchical system tree. It can be used to

navigate around the system, add or remove components, and monitor their status (when online).

1. Clickon _— from the main toolbar to show the ‘Core Browser'.

Or select Window -> Core browser (from the main_menus) or press CTRL + SHIFT + B (on

your computer keyboard).

The System tree appears as you last left it. When running online, components are colour-coded to

provide diagnostics:

:] Core browser

= = @ A
System

E}---C_orel

EH-Module 2 [MADI]

E-Port 1 MADI [REDUNDANT]
[=1-Dallis 3RU (52 channels)
Et-Card 1 [MIC]

~Signal In 2

~Signal In 3
“-Signal In 4

t-Card 3 [MIC]

t-Card 7 [AES3]

t--Card 14 [LINE]

t--Card 16 [LINE]

----- Card 18 [MNA]

----- Masterboard

----- Redundant masterboard

-

----- Redundant P5U
[+-NSP Recnuirres (4 rhannelcd

(T4 core browser

=hnre

System

EH-Care 1
E}-Module 1 [MADT]
Eb-Part 1 MADI
E}-Dallis 3RU (60 channels)
EH-Card 1 [MIC]
----- Signal In 1
----- Signal In 2
----- Signal In 3
----- Signal In 4
----- Signal In 5
----- Signal In &
----- Signal In 7
----- Signal In &
ard 2 [LIME]
ard 5 [LIME]

----- Signal In 3
----- Sianal In 4

2. Click on the + or — signs to open or close a branch of the system tree. Or, use the arrow keys

on your computer keyboard:
e Up/Down - navigate up/down.

e Left/Right - open/close the selected branch.

3. Hover over an individual signal (e.g. Signal In 1) to display its parameters.

4. Right-click on a component to reveal its configuration options.

Signal Parameters Summary

__:] Core browser

FF
j Core browser

Right-click Options

= = - A iy @ A
System —
& Corel System
[=-Module 2 [MADT] E‘"C_DIEI
[=Port 1 MADI [REDUNDANT] F-Module 2 [MADI]
=3 [gl\ics3zul ([Eljﬂccl]anne\s) "'MDdLI|E4 [MADI]
Lar
d ‘Module 6 [MADI]
- Signal In 2 gPort 1 MADE
~Signal In 3| HLSD BOR:008:000:000 : - Port 1 MADL
~Signal In 4| Signal name MICO1.01 -~ Module11 [DS Define Dallis 3RU (60 channels + 4 DSP resources)
£ Card 3IMIC] | giomal label MICO1.01 Module13 [DS| ;
[+ Card 7 [AES3] ‘Module 15 [DS| Define Dallis 3RU (52 channels + 4 8 8 D5P resources)
B Card 14 [LINE] Group MIc odule15 [
[ Card 16 [LINE]| I/O-DSP false ‘Router module Define Dallis 6RU (60 channels + 4 DSP resources)
Card 18 [NA] | Offset [dE] 00 ~PSU :
~Masterboard. | Digital gain [dB] o \Redundant PSU Define Dallis 6RU (52 channels + 4 & & DSP resources)
?;a”"da"t "™ Stereo link for silence detect false Define Tie-Line (64 channels)
- Redundant ps| Silence detect = Define Tie-Line (56 channels + & DSP resources)
E-DSP Resources (4 ¢ Threshold [dBFS] -60.0
B DSP Resources (8 ¢ Attack time [sec] 15 Define Plugin Server
E-Port 2 MADI Release ti 15
B2 Module 4 [MADT] Mo '::I:S‘:LMI& Define Local /O
Module 11 [DSP] PPIng
- Module 13 [DSP] Mapping table 02 address ]
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The System

The System structure is hierarchical and arranged as follows:

System Each configuration consists of a single System 1] Core browser
containing all the hardware components for your = = A
H H System
installation. E};___tc.ml
oy . . F-Module 2 [MADI]
Core Within the System, you define the Core. E---Pr_grtl MADI [REDUNDANT]
i i i -t-Dallis 3RU (52 channels)
Virtually all Systems consist of a single Core. (In certain B Card 1 [MIC]
specialised Nova73 DSHS systems, two Cores may be
configured.) Signal In 3
SignalIn 4
Modules Next, you fit the Core with Modules. o Cord s A
In our example, Core 1 is fitted with two MADI Modules, o Cord 16 ]
and three DSP Modules. ::::E:rdt 1sb[NAd]
Standard components, such as the Router module, ~Redundant masterboard
main PSU and Redundant PSU are added automatically e dant PSU
when you define the Core. [+-DSP Resources (4 channels)
[#-D5P Resources (8 channels)
Ports  Each Module can then be opened to view its /O Ports: e Line (64 channels)
In the case of a MADI, RAVENNA or ATM module, the et 11 10sP]
ports offer a range options (for example, to connect to a vecue {ggﬁ}
DALLIS or Operate as Tie'LineS). ----- Router madule
..... pSU
Cards  Each DALLIS may then be fitted with Cards. Inour Redundant PSU
example, you can see the MIC, AES3 and LINE cards
fitted to the DALLIS connected to Module 2, Port 1.
Signals At the lowest level of the system tree are the signals
themselves — in our example, Card 1 has been opened to
reveal the four mic/line input signals (Signal In 1 to 4).
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The Core Browser Toolbar
| Core browser
= @ A
1

2 3 4 5 6 T

At the top of the 'Core Browser' are a number of useful functions.

The first two buttons help with system navigation:

1 Collapse all ~ Hides all sub nodes within the selected branch.

2 Expand all Shows all sub nodes within the selected branch.

The next four buttons can be used when editing the Core configuration:

3 Copy Copies the selected component and its sub entries.

4 Cut Cuts the selected component and its sub entries

5 Paste Pastes the copied component, with sub entries, to the selected branch of the
system.

6 Delete Deletes the selected component and its sub entries

The last button can help identify system components:

7 Alias Displays your device alias names rather than the Lawo system names.
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‘Graphic View’

The ‘Graphic View’ provides a graphical representation of the system. It works in conjunction with the
'Core Browser' to define the Core configuration and monitor system status (when online).

1. Openthe 'Core Browser' and select a component other than the System - e.g. Core 1.

2. Clickon A from the main toolbar to show the ‘Graphic View'.

Or select Window -> Frame editor (from the main menus) or press CTRL + SHIFT + F (on your
computer keyboard).

A pictorial representation of the selected component appears. (When running online, components
are colour-coded to provide diagnostics.)

File Remote Extras Window 7

MO0 @ < OCEMW + &
'3 Core browser

T = @ A

il Corel-Studiol

System
= -

[=Module 2 [MADI]

Eh-Port 1 MADI [REDUNDANT] | 4 7| = 5 5 -0;
[=+-Dallis 3RU (52 channels) | I I

Eh-Card 1 [MIC]

+5ignal In 1

o o
- Card 3 [MIC] E E -

#-Card 7 [AES3]
t-Card 14 [LINE]
--Card 16 [LINE] B
- Card 18 [NA]
- Masterboard
--Redundant masterbeard
-Redundant PSU
- [5P Resources (4 channels)
- [5P Resources (8 channels)
~Part 2 MADI
EH-Module 4 [MADI]

E-Part1 MADI

[#-Port 2 MADI [LINK]
~~Module11 [D5P]
~~Module13 [D5P]

Module 15 [DSP]

Router module
-Redundant P5U

-

The ‘Graphic View’ cannot be opened if System is selected (as there is no valid hardware
component to display!) In addition, the ‘Graphic View’ will close automatically if you select
System in the 'Core Browser'.

3. Click on a module in the 'Graphic View', and the system tree selection (in the ‘Core Browser’)
follows.

4. Similarly, select a different component in the ‘Core Browser', and the 'Graphic View' updates.
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5. Right-click on a Module slot (within the Core), or a Card slot (within a DALLIS), to reveal its
configuration options:

Core Module Options DALLIS Card Options

J#, Corel1-Studiol

E Dallis 3RU (52 channels) - Dallis 3RU (Channels left IN: 28 f OUT: 36 o [

[ E
- -
f é 981/02 AES3 SRC + MADI Port
v 981/31 MADI 2 MMF
981/32 MADI 22 MMF i3 . Analog 941/02 Line In trafo 15dBu D-5ub
o 981/36 MADI 6:2 MMF - 941/04 Line In trafo 24dBu D-Sub
981/38 MADI 8 MMF AES3 941/06 Line In trafo 18dBu D-5ub
981/41 MADL 2 SMF GPI 941/12 Line In trafo 15dBu XLR
081/53 ATM 3 MMF SDI 941/14 Line In trafo 24dBu XLR
081/56 ATM 6:x2 MMF Dsp 941/16 Line In trafo 18dBu XLR
983/02 DSP 24 Data 941/51 Mic/Line In D-5ub
983/03 DSP 48/24 || Copy941/62 e Mfﬂf“e lalistal b
983/06 DSP I0SONO | cutoa1/62 e Mfﬂf“e Ll
983/03-007 mxDSP 941/62 Mic/Line In trafo XLR
- - 941/83 Line In/Out D-5ub
983/03-060 DSP WFS (mix)
) 941/84 Line In D-5ub
983/03-061 DSP WFS (filter) 5
942/02 Line Qut trafo 15dBu D-Sub
983/03-062 DSP spatial mixer 5
942/04 Line Qut trafo 24dBu D-Sub
981/61 Ravenna Link 4x128ch 2
. 942/06 Line Qut trafo 18dBu D-Sub
9 S61/61 Ravenna Link 2:256/2426ch = 942/12 Line Out trafo 15dBu XLR
981/61 Ravenna Link 28ch + 1x256¢ch 942/14 Line Out trafo 24dBu XLR
: = 942/16 Line Out trafo 18dBu XLR

942/84 Line Qut D-Sub
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‘Parameter Box’

The ‘Parameter Box' is used to adjust settings for the selected component or signal. It works in
conjunction with the 'Core Browser' and 'Graphic View' to define the Core configuration.

1.
1.

Alternatively, select the component or signal, and click on
‘Parameter Box'.

Open the 'Core Browser' and double-click on a component or signal - for example, Signal In

' from the main toolbar to show the

Or select Window -> Parameter box (from the main_menus) or press CTRL + SHIFT + P (on
your computer keyboard).

%

2.

'__:] Core browser

. [ signal In 1

o B

- A

4

System

=-Corel
[=-Medule 2 [MADI]

=
T

EI"-P_or‘t 1 MADI [REDUNDAMNT]
EI---D_aHis 3RU (52 channe
A

!

H-Card 3 [MIC]
#-Card 7 [AES3]
#-Card 14 [LINE]
- Card 16 [LINE]
- Card 18 [MA]
- Masterboard

- -

PSU
-~ Redundant P5U

[#--Port 2 MADI

~Maodule 4 [MADI]
~Module 11 [DSP]
-Module 13 [DSP]
-Maodule 15 [DSP]
--Router module
- PSU
~~Redundant P5L

Redundant masterboard

[#-DSP Resources (4 channels)
[#-DSP Resources (8 channels)

Signal | DSP | Map |,

HLSD [BoR

~|d008 2000 {000 |

Signal name | MICOL.01

Signal label |MIC01.01

Group | MIC

Once the 'Parameter Box' is open, if you make a different selection (in the ‘Core Browser'
or 'Graphic View'), then the 'Parameter Box' follows.

Use the tabs to select a page - e.g. Signal, DSP, Map.

e White parameter fields (e.g. Signal name, Signal label, Group) can be edited.

e Grey parameter fields are usually for information purposes and cannot be modified.

e Check boxes may selected or deselected.
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'Remote Log'

The 'Remote Log' lists all the messages generated by AdminHD and by the mc256 MKII control
system (when online). It is a good idea to open this window when transferring data to or from a
system, or running online.

1. Clickon |!‘ from the main toolbar to show the ‘Remote Log'.

Or select Window -> Remote log (from the main_menus) or press CTRL + SHIFT + L (on your
computer keyboard).

The log displays all errors and queries since AdminHD was started:

2. Scroll up the list to view the log history.

The ‘Remote Log’ stores all messages while AdminHD is running. If you exit AdminHD and re-open it,
then the previous log is lost.

To save the log contents:

3. Right-click anywhere within the window, and select Export content.. (or select File ->
Export File -> Remote Log):

@ Remote log

Export content ...

Clear content

A File -> Save dialogue box appears.
4. Choose a folder, enter a flename and click Save.

The log is stored as a plain text file and can be opened by any common text editor.

Q You can specify a default directory for your logfiles from the Extras -> Preferences ->
Common Directories menu.

To clear the log contents:
5. Right-click anywhere within the window, and select Clear content..

The existing contents of the ‘Remote Log’ are cleared.
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The Main Menus

AdminHD supports five main menus:
* File
* Remote

e Extras

e Window

o ?
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File

Elle | Remate Extras

| Mew 4

B Open [al}; o]
Open recent ]

Q Close

D File infi

H Save ol B

LY save as

H Export file »

[E] Exit Al-Fa

¢ New — creates a new AdminHD session.
e Open —opens an existing AdminHD file (config.csv).
e Open recent —opens arecent config.csv file.

¢ Close — closes the current AdminHD session. You will be prompted to save your configuration
as a config.csv file before closing.

e Save - saves the current AdminHD configuration as a config.csv file.
e Save As - saves the current configuration under a new filename.
e Export file - exports the following file types:

o Core cold start config (config.tcl) — the cold start Core configuration.

o Component List —a component parts list.

o BFE controller — a BFE controller file. Please contact your local Lawo representative or
email service@lawo.com for more details.

o0 Remote log - the contents of the ‘Remote Log'.

e Exit — click to close the AdminHD programme. You will be prompted to save your current
configuration before closing.
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Remote

File

Extras  Window 7

<+ Online to remote system

|7 Reconnect mode

[El e

1

[

[

System| :
E-Co Upload file »

(_} Download all data from remote HD  Ctr-D

Download file »

¢ Online to remote system — enables (or disables) the online connection to the remote control
system.

e Reconnect mode — when enabled, AdminHD attempts to reconnect to the remote control
system if network communication is interrupted.

e DSHS —access to dual self-healing star options (Nova73 DSHS configurations only).

e Upload all data to remote HD — uploads the AdminHD configuration to the online system
(available in online mode only).

e Upload file - uploads the following configuration files from your computer to the remote
control system:

o Core cold start config (config.tcl) —the cold start Core configuration.

o Console cold start config (console_config.tcl) — the cold start Console_configuration
(MKI mc266 only).

o0 GUI cold start config (gui_config.tcl) —the cold start Signal List configuration.

e Download all data from remote HD — downloads configuration data from the online control
system into AdminHD.

¢ Download file — downloads the following file types from the remote control system to your
computer:

o Core cold start config (config.tcl) — the cold start Core configuration.

o0 Systemlog messages - the control system log file.

0 Console cold start config (console_config.tcl) — the cold start Console configuration.

0 GUI cold start config (gui_config.tcl) — the cold start Signal List configuration.

¢ Reset system (cold send) — cold starts the remote control system (available in online mode
only).
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Extras

Eile Eemote - Window ?
L;‘j H @ Datasheet »

Show mapping table 4
%~ Check configuration  Cri-K

L'_j Core browse

—_
et -

S % Preferences Carl-P
WETEIM

e Datasheet -> Comfort Text Edit Mode - enable this mode to use the naming short cut in the
Signal 'Parameter Box'.

e Show mapping table — opens an overview of the mapping tables 1 to 16.

e Check configuration — checks the AdminHD configuration for programming errors.

¢ Preferences — opens the AdminHD Preferences.
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Window

Ex
@ Core browser Ctrl +Shift-B

=] parameter box Cirl +Shift-p

64 Frame editor i +5hift-F
Tl console frame Ctd+Shif-o
i= sSignal list editor  Ctd+shifs
4 Connect manager  Ctd+5hift-C
| Remote log Ctd+Shif-L

Shows or hides the seven sub windows.
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? -> About

About ...

Info"\‘ Li cense\\‘ System "\‘

AdminHD 4.20.2

Suitable for release 4.20.2
Release date: 01.02.2012
Copyright (c) 2013 - Lawo AG

Warning:

This computer program is protected by copyright law and
international treaties. Unauthorized reproduction or distribution
of this program, or any parts of it, may portion result in severe
civil and criminal penalties, and will be prosecuted under the
maximum extent possible under law.

& 0K

Information about the AdminHD software version, license and operating system.
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AdminHD Preferences

When using AdminHD for the first time, it is a good idea to spend a few minutes adjusting the
programme's Preferences.

1. Select Extras -> Preferences from the main_menus, or press CTRL + P, to open the
'Preferences’ pop-up window:

el I

Signal list editor\
Commeon \ 4 » Startup \l [}/ Directeries \ + Connect manager "\‘

C |Disable graphic frame popup after creating new hardwarel

[] Display large graphics (for extended screens)

["] Disable auto reconnect

|(‘/'DI(| IRCanceLI I

Use the tabs to select a page.
Select or unselect a preference.

Click OK to save your changes.

a > w0

Restart AdminHD or re-open the relevant window for the changes to take affect.

/O Your preferences are stored in the setup files for the software. Therefore, they will remain
as you last left them each time you start the programme.
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Preferences -> Common

e W=

Signal list editor\
Common \'\ 4> Startup \ DJ' Directories \ 4+ Connect manager "\‘

| |Disable graphic frame popup after creating new hardwarel

[| Display large graphics (for extended screens)

["] Disable auto reconnect

This page deals with common programme options:

e Disable graphic frame pop-up after creating new hardware — tick this box if you wish to
stop AdminHD automatically displaying the ‘Graphic View’ when new hardware is added to the
configuration.

¢ Display large graphics (for extended screens) — select this option if you are working with a
larger screen (e.g. 21”). The graphics are doubled in size.

e Disable auto reconnect — tick this box to prevent AdminHD automatically reconnecting to
the online system if network communication is interrupted.
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Preferences -> Start up

Signal list editor\
Common = 4 Startup \ [}/ Directories "\‘ < Connect manager \

[ |Hide core browser

[ ["] Show remote log

This page deals with start-up options which occur when you open or create a new configuration.

e Hide Core Browser — tick this box if you do NOT want the ‘Core_Browser’ to appear
automatically.

e Show remote log — tick this box if you DO want the ‘Remote log’ to appear automatically.
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Preferences -> Directories

Preferences - 4 mw G Select config file directory |
il .24 . .

Signal list edi‘tor"\‘ Laok In: ||“_*| Studio 2 -| @
Common \ 45 Startup Directories \ 4 Connect manager \
Config files
| |
Remote log files
| |
File: Mare: Jocuments and Setting y

Coldstart config files Files of Type: | All Files v|
| |
Core log message files
| |
snapshot files
| |

This page allows you to specify the default directory paths which will be used each time you save,
open, export or download a file:

1

Click on the folder button next to the entry you want to specify — e.g. beside Config files.

A file dialogue box appears.

2.

Select the folder where you usually want to save your files and click on Open.

The file dialogue closes and the path is displayed in the Preferences field.

3.

Repeat for all the AdminHD file types:

Config files — AdminHD configuration files (config.csv).

Remote logfiles — ‘Remote log’ text files.

Coldstart config files — config.tcl, gui_config.tcl and console_config.tcl files.
Core log message files — System log text files.

Snapshot files — ‘Connect Manager’ snapshots.
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Preferences -> Connect Manager

Default Options Recommended Options for ControlHD
reeerce: 10 e (poeers T R i
Signal list editor\ Signal list editor"\‘
Common | 4» Startup ' [ Directories = 4 Connect manager \\‘ Commen ', 4 Startup |, [ Directories ~ + Connect manager \
E] |Auto load connect manager in ControlHD model Auto load connect manager in ControlHD mode
[[] Auto switch to remote online mode Auto switch to remote online mode
['] Disable online ovenwrite lock [] Disable online overwrite lock
["] Enable connect/disconnect easy step mode ["] Enable connect/disconnect easy step mode
[[] Auto load config file after startup Auto load config file after startup
| | |C:\Users\Sue\Documents\Documentation & Training\La... |

These preferences affect what happens when the ‘Connect Manager’ window opens:

Auto load connect manager in ControlHD mode — when ticked, the ‘Connect Manager’ will
automatically open when you open or download a configuration in ControlHD. This option does
not affect AdminHD.

Auto switch to remote online mode —when ticked, AdminHD will automatically select online
mode when you open the ‘Connect Manager’.

Disable online overwrite lock — tick this box if you want overwrite lock to be disabled each
time you open the ‘Connect Manager'.

Enable connect/disconnect easy step mode - tick this box if you want easy step mode to
be enabled each time you open the ‘Connect Manager'.

Auto load config file after startup — when ticked, AdminHD will load a signal list when you
open the ‘Connect Manager’. The signal list is selected by clicking on the file open icon and
making a selection from the pop-up.
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Preferences -> Signal List Editor

. B e

Signal list editor |
Common "\‘@ Startup \ [/ Directories "\‘ + Connect manager "\‘

[ |Enab|e physical Inputs/Monitors in DSP profilel

[[] Disable AB of Inputs/Monitors in DSP profile
[] Show foreign signals if already in matrix list

[] Skip using device alias for directory auto creation

[
These preferences affect how the ‘Signal List Editor’ creates new signal lists.
The first two options affect mc2 mixing console systems only:

e Enable physical Inputs/Monitors in DSP profile — tick this option to add the physical inputs
of the mc? input and monitor channel DSP channel to the default directories of the

Destination page.

e Disable A/B of Inputs/Monitors in DSP profile - untick this option if you do NOT wish to add
the mc? input and monitor channel DSP signals to the default directories of the Destination

page.

Enable physical Inputs/Monitors in DSP profile (ticked) Disable A/B of Inputs/Monitor in DSP profile (ticked)

' i= signal list editor

| = signal list editor

Source * Destination \ Source  Destination \

Directories & signals Directories & signals
3

B EE® LN BN =N 0N NERS

Lol
- Inputiion & + B - Insert Return
= hew dir_000L

---Input,l'Mon
---Insert Return P ew subdir_0001

- Mew dir_ooo1
[ v+ subdir_0001

The second two options affect all Nova73 systems:

e Show foreign signals if already in matrix list — affects networked systems. Please contact
your local Lawo representative or email service@lawo.com for advice.

e Skip using device alias for directory auto creation - tick this option if you do NOT want to
use the Super-device alias names when directories are automatically added to the signal list.
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Core Configuration: First Steps

This section deals with how to edit and update the Core configuration. The best approach is as
follows:

1. Create a new AdminHD session and, if possible, download the online configuration from the
mc256 MKII control system.

Alternatively, if you can't connect to the mc256 MKII, open an existing config.csv file. This may be
a file which you saved earlier or requested from your configuration engineer.

If you have neither a network connection or an existing config.csv file, then you will need to create
a new session and build a configuration from scratch. Note that this method can be time
consuming, and is not recommended for minor changes to an existing system!

2. Save the configuration as a config.csv file - this allows you to open it later, or move it to
another AdminHD computer.

3. Define the new system components and edit their parameters using the 'Core Browser',
'‘Graphic View' and 'Parameter Box'.

4. Check the configuration for programming errors.
5. Backup the system's existing cold start files.

6. Export the configuration as a cold start config.tcl file - this puts the data into a format which
can be read by the control system.

7. Upload the cold start config.tcl from your computer to the mc256 MKII control system.

8. Cold start the mc256 MKII to see your changes take affect.

/;\_j As an alternative to exporting and uploading the config.tcl file, AdminHD can update the
online configuration (in temporary memory). However, this is not recommended for
permanent changes to a configuration.

Workflow Suggestions:

Both the config.csv and config.tcl files can be transferred between computers. This allows you to
download and save the configuration (as a config.csv) on a networked AdminHD computer; open it
on your personal AdminHD computer (for editing); export the config.tcl and transfer this back to the
networked computer (for upload to the control system).

If you are also editing the Signal_List configuration, then download and save both sets of data
(config.csv and signallist.slx) while you are connected to the control system. Once editing is
complete, export both cold start files (config.tcl and gui_config.tcl), and upload them to the control
system. You can then perform a single cold start to action all your changes.
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File -> New

This menu option creates a new empty AdminHD session. It should be used before downloading data
into a new session, or to build a new configuration from scratch.

1. Select File -> New from the main menus, and choose mc2 console. This mode supports the
mc?56, 66 and 90 consoles (MKI and MKII):

The available options depend on the AdminHD mode and software release.

2. If you have not closed your previous AdminHD session, then the following dialogue box
appears:

The config file has been changed. Do You want to save the config file?

Yes Jl No ]

e Select Yes to save the configuration (as a .csv file) before proceeding.

e Select No to continue without saving.

The new session opens - you will see the entry System in the ‘Core Browser’ and confirmation of
the system type in the status bar:

2 it e conig it 0 W

|| offline
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Downloading the Online Configuration

The best way to ensure that you are working with your system's latest configuration data, is to
download the online configuration, from the mc256 MKII control system.

To perform a successful download, you will need a valid network connection between your computer
and the control system.

9 We recommend running AdminHD offline, to avoid accidentally clicking the Upload button.
Open the 'Remote Log' to monitor the progress of the download.

1. When you download the online configuration, you will download the current data (stored in
memory). Therefore, to make sure this data is identical to the cold_start configuration, reset the
system by performing a cold start.

2. Once the system has cold started, open a new AdminHD session (File -> New).

This step ensures that you will be asked for the IP address of the Remote connection below. If
you miss this step, then AdminHD will attempt to connect to the IP_address configured in your
current session.

3. Thenclick on O from the main toolbar (Download all data from remote HD).

Or select Remote -> Download all data from remote HD (from the main menus) or press CTRL
+ D (on your computer keyboard).

The following pop-up appears requesting an IP address for the Remote connection:

¥ AdminHD - new config file * = el

File Remote Extras Window ?

MO0 @ < OO0 M + =

Remaote connection IP adress 192.168.56.101 ‘

|| Remote connection redundant available

Remote log

II |[me’ consale | I | |[ofline LI
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4. Enter the IP address of your control system.

If a single Router Module is fitted to the Nova73, then enter the main IP address only.

If main and redundant Router Modules are fitted, tick both boxes and enter both IPs; the
redundant IP address is always 1 above the main IP address.

Router Module Redundancy

Remote connection

Remote connection available

Remote connection IP adress 192.168.102.56

Remote connection redundant available

Remote connection redundant IP adress |192 .168.102.5?|

IQ} Connectl | sx Cancel |

9 You can connect AdminHD to mxGUI by entering mxGUI's virtual IP address
(192.168.56.101).

5. Then click Connect.
AdminHD downloads the online configuration data from the remote system; the 'Remote_Log'
reports on the progress.
When the download is complete, any open windows such as the ‘Core Browser’ update to show the
new configuration:

o x|

%7 AdminHD - new config file *

File Remote Extras Window ?

>y [ & (%
MO0 & K
[ T3 Core browser

= @ A
=

Module 2 [MADI]

“Module 4 [MADI]
-Maodule 11 [D5SP]

~~Module 13 [DSP]
--Module 15 [DSP]

- Router module

»PSU

~Redundant PSU

w
T2 e

| oftine [H

I [ me* sonsole | I I
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If there is a problem with the download, then:

0 Check the network connection and TCP/IP_settings of your computer's network interface
card.

0 Check that AdminHD is compatible with the mc256 MKII system.

0 See the trouble-shooting tips.
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Opening a Saved Configuration

To open an existing config.csv file:

1. Clickon £ ] from the main toolbar.
Or select File -> Open (from the main menus) or press CTRL + O (on your computer keyboard):

% AdminHD - new config file *

Fle Remote Darss Window ?

9M Q0 @ K

ore browser

| LookIn: |3 V.20 - Config Used for Manuals

File Name: | Studicl_config.csv

| Files of Type: | Config files

9 Use File -> Open recent to select a recent configuration.

2. Select your file and click Open.
If the file was saved in an older version of AdminHD, then you will be asked to convert it.

The file opens, and the path and file name appear at the top of the display:

¥ AdminHD {CaUsers\Sue\Dacuments\Documentation & Training\Lawa - All Documentation\Admin HD\AdminHD_Configs\V4.20 - Config Used for Manuals\Studiol configcsv =)

Eile Remote Exras Window ?

[} e
M e0 @ X W7 4[]
[T Core browser
e R 2
System
E-Corel
EFModule 2 [MADI]
; [-Port1l MADI [REDUNDANT]
£ [=Dallis 3RU (52 channels)
El-Card 1 [MIC]
. Signalinl

--Sianal Tn ?

You can decide whether the 'Core Browser' appears automatically from the Extras ->
Preferences -> Startup menu.

If there is a problem opening the file, then check:
¢ s the file an AdminHD .csv ?

e Was the file saved by a newer release of AdminHD?

Configurations saved by an earlier version of AdminHD can be opened in a later release.
However, configurations saved by a newer release are not backwards compatible.
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Saving the Configuration

Having downloaded or opened an existing configuration, it is a good idea to save the data as an
AdminHD config.csv file. This creates a copy, in AdminHD format, which can be opened later, or
moved to another computer.

1. Select either File -> Save, or File -> Save As from the main menus:
¢ File -> Save overwrites the current file name (if one exists).

e File -> Save As asks for a new file name:

1 AdminHD - new config file *

File Remote BEdras Window 7

MO0 AOCHME +=

ﬁ Core browser ', Dallis 3RU (52 ch Is) - Dallis 3RU [Ch | : z [
LM r oA
System
E-Corel
E-Module 2 [MADI]

Eh-Port 1 MADI [REDUNDANT]
- Dallis 3RU (52 channels)

Card 1 [MIC]
-Card 3 [MIC]
- Card 7 [AES3]
[--Card 14 [LINE]
- Card 16 [LINE]

~Card 18 [NA]

- Config Used for Manuals

Redundant masterboard
PSU

- Redundant PSU

[#-DSP Resources (4 channels)
[#-DSP Resources (8 channels)
[F-Port 2 MADL

Module 4 [MADI]

Module 11 [D5P]

-~Module 13 [D5P]

-~Module 15 [D5P]

- Router module

--Redundant PSU

fr=t
#

File Name: | StudiolJconfig.csv

Files of Type: | Config files

2. Select a path and enter a suitable file name.

@ You can use any name as long as it keeps the .csv suffix, but it is a good idea to keep the
word "config" in the name to distinguish it from other .csv files. See Organising Your Files.

You can also specify a default directory for your config files from the Extras ->
Preferences -> Common Directories menu.

3. Click Save to save the configuration onto your computer’s hard disk.

i
4. From here on, you can quickly update the file by clicking on 1 (from the main toolbar) or
pressing CTRL + S.

@ If you are making a lot of configuration changes, use File -> Save As to save different
versions during the programming. This will allow you to revert to an earlier version, if there
iS an error in your programming.
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Editing the Configuration

You can edit the Core configuration using the '‘Core_Browser', 'Graphic_View' and 'Parameter_Box
windows. The details are covered later in this chapter, please see:

¢ Defining the System - to add or remove components, or modify the System structure.

e Editing Parameters - to adjust system or signal parameters.
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Checking the Configuration

Having completed your AdminHD configuration, it is a good idea to check it for programming errors.
This will avoid any problems later when you upload to the system.

1. Select Extras -> Check Configuration from the main_menus, or press CTRL + K on your
computer keyboard:

File Remote

B H 6 Datasheet 4

':| | Show mapping table 4

Window ?

%7 Check configuration  Cri-K

4 Preferences Ctrl-P

Sustern

AdminHD analyses the configuration to check for the following errors:
¢ Signal HLSD Conflicts — if two signals have the same HLSD (Lawo system address).
e HLSD Syntax —if there is an invalid HLSD in the configuration.
¢ Signal Name Conflicts — if two signals have the same name.

e Mapping Table Address Conflicts — if you have assigned the same mapping table address
to different signals.

The result of the check is displayed within the status bar of the display:

| W Configuration check result: config is Ck! |

If an error is reported, then try retracing your steps by opening an earlier version of the config.csv.
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Backing up the Cold Start Files

Before uploading new data, it is a good idea to backup the system's cold start configuration files.

/O To perform a successful download, you will need a valid network connection between your
computer and the control system.

1. Select Remote -> Download file from the main menus, and click on a file option:

Eile Extras  Window 7

i

@ £ Online to remote system

{7 Reconnect mode

1w DSHS b
A O Upload all data to remote HD Cirl-U
Systern :
B-Co Upload file 4
B

) @ Download all data from remote HD  Cwi-D
Bl Download file

Core cold start config (config.tcl)

e, Systern log messages

Console cold start config (console_config.tcl)

B Card 8 [SDI]
- Card 14 [LINE]

GUI cold start config (gui_config.tcl)

e Core cold start config (config.tcl) — the cold start Core configuration.

e System log messages - the control system log file.

e Console cold start config (console_config.tcl) — the cold start Console configuration.

e GUI cold start config (gui_config.tcl) —the cold start Signal List configuration.

2. You are asked to specify a folder location and name for the file - in our example, we have
chosen the Studio 2 folder created earlier, and have renamed the file as BACKUP_config.tcl,
see Organising Your Files.

r'.!:'] Enter save file name for FTP downlo 1 u1
Saveln: |3 Studio2 - =)
[ config.tcl
@ console_config.tl
= gui_config.tcl
FileName:  |BACKUP_config.tc] |
Files of Type: | Coldstart config files -

3. Click Save.
AdminHD downloads the file from the remote system; the 'Remote Log' reports on the progress.

4. Repeat for each file you wish to backup.
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Upload Options
The Core configuration may be uploaded to the mc256 MKIl in one of two ways:

¢ For permanent changes, you should upload a new version of the cold start config.tcl file. This
file will be stored on the mc256 MKII control system, and read following a cold start. Note that
this method requires three stages:

o Export the configuration as a config.tcl file.
0 Upload the config.tcl file from your computer to the mc256 MKII control system.
o Cold start the mc256 MKII.

e For temporary changes, or for installations where a cold start is not possible, you should
upload your data to the online configuration. This updates the online system without requiring a
restart; AdminHD must be running online to use this method.

The next few sections work through both options.

9 Before uploading new data, it is a good idea to backup the system's cold start configuration
files.

148 V5.0/1 mc256 MKIl Technical Manual



Chapter 3: AdminHD w

Core Configuration: First Steps

Exporting the Cold Start config.tcl

This operation exports the Core configuration from AdminHD, and puts it into a format which can be
read by the mc256 MKII control system - the config.tcl.

1. Select File -> Export file -> Core cold start config (config.tcl) from the main menus:

- Remote Extras Window 7
LI b R O s+

[% Open Ctil-0

Open recent r

Q Close

[) Fileinfo

Ej Save Ciri-5
I saveas

MDANT]
hannels)

l“'r_- Export file 4 Core cold start config (config.tcl)

Component list

BFE controller (config.bfe)

BFE controller new format (config.bfe)

F-Card 14 Remote log

2. You are asked to specify a folder location for the file - in our example, we have chosen the
Studio 2 folder created earlier, see Organising Your Files.

. Save coldstart config file as ... , M
Save In: |D Studio 2 '| @I
[E] BACKUP_config.tel
2 config.tel
@ console_config.tcl
£l gui_config.tcl
File Marne: |
Files of Type: | Coldstart config files -

/O Do NOT rename the file; it must be named config.tcl in order to be read by the control
system.

@ You can specify a default directory for your Coldstart config files from the Extras ->
Preferences -> Common Directories menu.

3. Click Save.

The configuration is exported from AdminHD and saved on your computer.
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Uploading the Cold Start config.tcl

Having exported the config.tcl file, it may now be uploaded to the mc256 MKII control system.

@ You can use this operation to upload any config.tcl file. For example, a backup file, or a file
prepared on another AdminHD computer.

/(_') To perform a successful upload, you will need a valid network connection between your
computer and the control system.

AdminHD can remain offline to upload cold start configuration files.

If you have a redundant Router Module, then you will need to disable the redundant control
system BEFORE uploading the config.tcl file, see Upgrading Configuration and Software
in a Redundant System.

1. Select Remote -> Upload file -> Core cold start config (config.tcl) from the main menus:

Extras  Window 7

+ Online to remote system "" _;__. _%_
|7 Reconnect mode hoa

L
ik .
Systel =
Eﬁ Core cold start config (config.tcl)
' {_) Download all data from remote HD  Cuil-D Console cold start config (console_config.tcl)
- i)
L. Download file 3 GUI cold start config (gui_config.tcl)

2. Then select the config.tcl file you wish to upload:

] Select file for FTP upload

Lookln: |(3 Studio2

] BACKUP_config.tcl
B config.tcl

a console_config.tcl
| [l gui_config.tcl

File Name: |c0nfig.tc| |

Files of Type: | Coldstart config files '|

3. Click Open.

The file is uploaded to the remote system's cold start data; the 'Remote Log' reports on the
progress:

@ Remote log

150 V5.0/1 mc256 MKIl Technical Manual



Chapter 3: AdminHD %

Core Configuration: First Steps

If there is a problem with the upload, then:

e Check the network connection and TCP/IP_settings of your computer's network interface
card.

e See the trouble-shooting tips.

4. Cold start the mc256 MKII to see your changes take affect.
If there is a problem reading the new configuration after the cold start:

e Check that you have uploaded the correct config.tcl file - the file MUST be named config.tcl
and MUST have been created using a compatible version of AdminHD.

9 When uploading a config.tcl to mxGUI, you should treat the mxGUI control system like any
real mc? or Nova73. In other words, upload the file (as above), and then cold start mxGUIL.
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Uploading Data to the Online Configuration

For temporary changes to the Core configuration, or for installations where a cold start is not
possible, you should upload your data to the online configuration. This updates the online system
without requiring a restart and can be useful for testing, or updating systems where a cold start is not
possible (for example, if 24 hour continuous operation is required).

The online configuration is stored in the system's warm_start data (at shutdown), and recalled
following a normal restart (warm start). Providing you do not cold start the system, any changes
made will remain intact.

/O Only the Core configuration can be modified in this manner (you cannot update the
Signal List or Console Configuration).

Warm start data is temporary. Therefore, this method is NOT recommended for
permanent changes to the configuration. If the control system is 'cold started', then it reads
the config.tcl file, and any changes to the online configuration will be reset.

To upload your current AdminHD session to the online configuration:

1. Enable online mode, by clicking on from the main toolbar (Online to remote system).

AdminHD now connects to the remote system and compares the online configuration to the one
open in AdminHD. When the analysis is complete, an 'Upload summary' appears:

(# AdminHD - C:\Dokumente und Einstellungen'zuegerd1Desktop)2007_07_23_save_config_Auslieferung'2007_07_23_0 =1olx|

Fle Remote Extras Mindow 7

MO0 B & G )+ ]

@ Core browser

System
E-Core 1
=}

ork 1 ATM [REDUNDANT]

Port 2 ATM [REDUMDANT] @& Upload summary

Part 3 4TM [REDUNDANT]
DSP Resources Module changes:
= -Module 2 [MADI] Care 1, Nodule 1: type: 981/53 is different froom remote type: 98121, & vill be deleted and recreated.
[-Part: 1 MADL Core 1, Nodule 2: type: 06131 is not existing and will be eated.
Dallis 3RU (EU :hannels) Core 1, hodule 3: type: 981453 is different from remote type: 98141, & will be deleted and Tecreated.

Core 1, Module 4: type; 261002 is riot escisting and will be Ceed.
Core 1, Mudule 5: type: 981131 15 rot exdsting and vrill be created.
Core 1, Module 2 type; 281002 is rot existing and will be Ceed.
Core 1, Module 16: type: 30/31 i ot sxcisting and vrill be eated.

1--DSP Resources (4 channels)
E+-Part 2 MADT

[=-Dallis 3RU (60 channels)

| E-Card1[MIC)

| E-Card3[MIC)

| E-Card5[MIC)

| E-Card7[MIC)

| E-Card 3 [MIC)

. ECard 11 [MIC]

| B Card 16 [LINE]

Port changes:
Core, Module 1, Port 1, Superdevice: iype Dallis SRU (80 channds) is not excieting and will be aeated,
Core 1, Module 1, Peri 2, Superdevice: type Dallis 3RU (80 channels) is not existing and will be ceated.

- Card 18 [NA] Core 1, Module 1, Pert 3, Superdevice; type Dallis SRU (80 chanmes) i not xisting wd will be qeated.
+-Masterbaard Core 1, Module 1, Port 3, Superdevice DSF Resources (4 channds), Device L: type Listen steres is not existing and vwill be ceated.
;opePsU Core 1, Module 1, Port 9, Superdevice DSP Resources (§ channds), Device L: type Listen surround is not exicting and will be
+-Redundant PSU reatad.
“--D5P Resources (4 channels) Core 1, Module 2, Port 1, Superdevice: type Dallis 3RU (60 chanmes) is not existing and will be ceated.
E-Madule 3 [ATH] Core 1, Module 2, Port 2, Superdevice: fype Dallis 3RV (60 channels) is not existing and will be aeted.
Part 1 ATM [LTNK] fiure 1 Module 4 Port ? ice fvme TaTlis TRILOG chamnels) is not exristine nd srill he created
Part 2 ATM [LTK]
part 3 4 1]

DSP Resources
El-Module 4 [AES3]
Pork 1 AES3
Pork 2 MADT
Ei-Module 5 [MADT]
- Port 1 MADT
- Part 2 MADL
Ei-Module 8 [AES3]
Port 1 AES3
- Part 2 MADT
Module 13 [D5P)

\ I [Jmees I

Hﬁonhne(lgz.ms‘mz.ss) H @ || Q |

This list allows you to review the changes which you are about to make BEFORE you continue
with the upload.

2. Read through the list and click on Upload to continue (or Cancel to abort the upload).

The 'Remote_Log' reports on the progress of the upload; after a successful upload, the system
immediately updates.
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Core Configuration: Defining the System

This section looks at adding or removing components to/from the Core configuration - for example to
add a new DALLIS or plug-in card.

%

To change parameters for existing components or signals, skip straight to Editing
Parameters.

The same principles apply whether you are updating an existing configuration or building a new
system from scratch. The system is hierarchical, and therefore components must be added in the
following order:

1.
2,
3.
4,
5,

Define the Nova73 (the Core).

Fit modules to the Core.

Define the I/O ports: for example, to configure a DALLIS or Tie-Lines.
Fit cards to a DALLIS.

Define other options such as Link and Port redundancy, and Port DSP resources.

You should open both the 'Core Browser' and 'Graphic View' to perform these tasks.

Warning

It is vital that the configuration matches your intended physical installation. Otherwise
components may not operate correctly. Therefore, it is useful to have the specification
details (part numbers and options) to hand.
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Defining the Core

The first step when configuring a new System is to add the Core:
1. Select the System entry in the ‘Core Browser’ and right-click.

A list of drop-down options appears - those in black can be selected; those in grey cannot. The
available options depend on the AdminHD mode and software release:

) AdminHD - new config file =

File Remote Extras Window 7

EH OO0 @ kO M= + =

Core browser

= - @A
Svsiac

Y

Define HD Core 3k (48 kHz)
Define HD Core 1.5k (96 kHz)
Define HD Core 8k (48 kHz)
Define HD Core 4k (96 kHz)
Define HD Core MEZ2 (48 kHz)
Define HD Core MK2 (96 kHz)
Define Compact Core (48 kHz)
Define Compact Core (96 kHz)

2. Select an option to define the type of Core. The first four options provide support for MKI
systems. For MKIl systems, select one of the last four options:

e HD Core MK2 (48kHz) or (96kHz) = Nova73 HD; fitted with the Router Module MKII (980/33);
with a maximum sampling rate up to 48kHz or 96kHz.

e Compact Core (48kHz) or (96kHz) = Nova73 Compact; fitted with the Router Module MKII
(980/33); with a maximum sampling rate up to 48kHz or 96kHz.

The selected Core is added to the System tree, along with its standard components: Router
module, PSU and Redundant PSU:

Nova73 HD Nova73 Compact

¥ AdminHD - new config file * Ea B s S TR M AdminHD-newconfigfic i I S s v T

File Re Extras  Window 7

ZA

e
==
—_—
—
—_—
—

3
whzey

You can decide whether the 'Graphic View' appears automatically from the Extras -> Preferences -
> Common menu.
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If you want to change the Core, then you will need to delete it and make a new selection:
3. Select Core 1 inthe 'Core Browser', right-click and select Delete:

==
:] Core browser

= = @ A
System
—.p/Corel
oP remove router module
:"""R

add redundant router module

add multichannel sync port

@ Delete Corel

You are asked to confirm - Yes or No.

4. Select Yes to remove the Core, and all of its sub components, from the configuration. You
can now return to step 1 to make a new selection.

Warning

Once you have defined the Nova73 Core, you CANNOT change the type later. So take
care to select the correct option before continuing!

mc256 MKIl Technical Manual V5.0/1 155



v Chapter 3: AdminHD

Core Configuration: Defining the System

Fitting Modules to the Core

Next, fit your /O and DSP modules to the Core, using the 'Graphic View’ as follows:

1. Right-click on a module slot - e.g. Slot 4 - and select a drop-down option:

Nova73 HD Nova73 Compact

Redundant PSU

581/02 AES3 SRC + MADI Port
961/31 MADI 2 MMF

981/32 MADI 222 MMF
981/36 MADI 6:2 MMF
081/38 MADI 8 MMF
G81/41 MADI 2 SMF
961/53 ATM 3 MMF
961/56 ATM 6:2 MIMF
083/02DSP 24

981/36 MADI 6:2 MMF
981/38 MADI 8 MMF
981/41 MADI 2 SMF
981/53 ATM 3 MMF

981/56 ATM 62 MMF
983/02D5P 24

983/03 DSP 48/24

983/06 DSP I0SONO
983/03-007 mxDSP
983/03-060 DSP WFS (mix)

083/03 DSP 48/24

B 982/06 DSPIOSONO

The fitted modules appear within the ‘Graphic View and ‘Core Browser.

The available options depend on the selected slot; you cannot configure an illegal option (they are
"greyed out"):

E Core browser

sl BB
T el O R

System
E-Corel

B-Module 2 [AES3)
Module 4 [MADI]

981/02 AES3 SRC + MADI Port
981/31 MADI 2 MMF

981/32 MADI 22 MMF
981/36 MADI 6x2 MMF
981/38 MADI & MMF

981/41 MADI 2 SMF

981/53 ATM 3 MMF

981/56 ATM 6x2 MMF

983/02 DSP 24

983/03 DSP 48/24

983/06 DSP I0SONC
983/03-007 mxDSP
983/03-060 DSP WFS (mix)
983/03-061 DSP WFS (filter)
983/03-062 DSP spatial mixer
981/61 Ravenna Link 4:128ch
981/61 Ravenna Link 2:256/2:128ch
981/61 Ravenna Link 2:128ch + 1x256ch

“Redundant PSU

<
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1%

2. Toremove a module right-click on the 'Graphic View' slot and select Empty. Or, go to the
'‘Core Browser', right-click on the module and select Delete:

i-..d Core 1 - Studio

981/02 AES3 SRC + MADI Port
981/31 MADI 2 MMF

981/32 MADI 2:2 MMF
981/36 MADI 6:2 MMF
981/38 MADI& MMF

981/41 MADI 2 SMF

981/53 ATM 3 MMF

981/56 ATM 6x2 MMF

v

983/03-007 mxDSP

981/61 Ravenna Link dx128ch

981/61 Ravenna Link 2x256/2x128ch
981/61 Ravenna Link 2x128ch + 1x256¢ch

You are asked to confirm - Yes or No.

ot [E

'.._—.] Core browser

= = @ A
System

=+Corel

B-Module 2 [AES3]
-Module 4 [MADI]

“Port 2 MAD] &5 Delete Module 6 [MADI]
Module 11 [DSP,

3. Select Yes to remove the Module, and all of its sub components, from the configuration.

4. For the Nova73 HD, you can right-click on the second PSU to add or remove the redundant

power supply:

i Core1-Studiol

DR > £3338584300800001 o
AN Seeresrasonganasl N

D3 <2, 2

[ 2

[ =, <

0 2

e

g;,; o’ o o’

7 17 |7

o=

I

e

-

e

ﬁ

Warning

Take care to fit each module so that it matches the exact slot position, and part number, of
your physical installation. Otherwise, the module may not operate correcily.
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Fitting a Redundant Router Module

To add a redundant Router Module:
1. Right-click on the redundant Router Module slot and select available:

# B

i‘ﬂi Corel

[N -
[
i
g
Y
% a2
a2

W= 35atasasasasasst o

el el | - g

The module is added to the 'Graphic View and 'Core Browser":

LT5| Core browser

e @ A

System
E-Corel
Module 2 [AES3]
Module 4 [MADI]
Module & [MADI]
++Module 11 [DSP]
++Module 13 [DSP]
~Meodule 15 [DSP]
~Router medule
[@Redundant router module
+PSU
-Redundant PSU

m 353535845858 51 2
Ridioivdntets

/O Note that the type of Router Module is automatically configured (to match that of the
existing module).
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You can also add or remove a redundant Router Module from the ‘Core Browser’, or 'Parameter Box':

'Core Browser' 'Parameter Box'
@ Core browser [ =] Core 1
= = @A Plugin ser\rer\l\
%ﬁ:em Connection ' Data \ System settings \Map \l\ External \l\ Network\l\
: Core 1
Core alias |mc25tudi01 |
remove router module
""" add redundant router module Router module medel number |980f32 |
add multichannel sync port Reuter module type |HD Core 8k (48 kHz) |
@ Delete Corel Router module
Redundant router module |

Redundant PSU
Black burst synchronised switching [
Internal sync activates alarm |
Enable sync port O

Multi-channel sync port
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Defining the IO Ports

Each I/O module can now be opened within the ‘Core Browser’ to view its ports.

In the case of an AES3 module, the port is pre-defined and can be opened to access the AES input
and output signals.

In the case of a MADI, RAVENNA or ATM module, the ports require further configuration. For example,
the port may connect to a DALLIS, operate as Tie-Lines to/from an external device, connect to a
Lawo Plugin Server, etc.

1. Select the Port in the ‘Core Browser’ and right-click:

%2 AdminHD - new config file *

File Remote Extras Window 7

=M 00 @ x [AH

’Tj Core browser

= = @ A

13

System

E"'C_Urel
E-Module 2 [AES3]
£ Module 4 [MADI]

Port 2 MAL Port 1 MADI

Madule & [M

Define Dallis 3RU (60 channels + 4 DSP rescurces)
Define Dallis 3RU (52 channels + 4 & & D5P resources)
Define Dallis 6RU (60 channels + 4 DSP resources)
Define Dallis 6RU (52 channels + 4 8 8 DSP resources)
Define Tie-Line (64 channels)

Define Tie-Line (56 channels + 8 DSP resources)
Define Plugin Server

Define Local V'O

The drop-down options vary, depending on the module (MADI, ATM or RAVENNA), and the AdminHD

mode and software release. For a MADI port, the options are:

e DALLIS - configures a DALLIS unit (3RU or 6RU frame), with either 60 or 52 audio channels +
DSP resources.

¢ Tie-Line - the port is configured for a direct connection to an external device, either 64 audio
channels only, or 56 audio channels + DSP resources.

e Plugin Server - configures a connection to the Lawo Plugin Server.

e Local I/O - configures a connection to the Local /O board in the mc256 MKIL.

RAVENNA and ATM ports support similar options:

RAVENNA 128 ch link Port Options

RAVENNA 256 ch link Port Options

ATM Port Options

L[5| Core browser

'__:] Core browser '3 Core browser
= @ A S @ A
System System
El-Corel E-Corel
[=H-Module 1 [RVL] #-Module 2 [RVL]
[ Port 1 RV -Moduled [RVL]
-Port 2 Ry|Port 1 RVL

~Part3 RV
- Port 4 RV
""" Router modu

Define Dallis 3RU (128 channels)
Define Dallis 6RU (128 channels)
Define Tie-Line (128 channels)

Define Local /'O

-Port1 RVL
-Port 2 RVL

= o A

Module11 [D!P"“3R\ﬂ-

Modulel3 [D

Define Tie-Line (256 channels)

Module 15 [D%ey

~Router module
“~Redundant PSU

2. Select an option to define the port.

System
B -Corel

E-Module 1 [ATM]
Port 1 ATM

Define Dallis 3RU (80 channels)
Define Dallis 6RU (80 channels)
Define Tie-Line (80 channels)
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Your selection is added to the 'Core Browser' - for example:

e Selecta DALLIS 3RU (52 channels) - a DALLIS with DSP Resources (4 & 8 channels) is
added to the Port. If you open the DALLIS, you will see its standard components
(Masterboard, PSU, and Redundant PSU). You can now fit cards to the DALLIS.

@ Core browser

sere A
System
E-Corel
[-Module 2 [AES3]

EF-Module 4 [MADI]
=h-Port 1 MADI
gDallis 3RU (52 channels)
~Masterboard
~PSU
~Redundant PSU
‘DSP Resources (4 channels)
‘DSP Resources (8 channels)
Port 2 MADI
E-Module & [MADI]

Module 11 [DSP]

Module 13 [DSP]

Module 15 [DSP]
~-Router module
PSU
-Redundant P5L

Note that the DALLIS master board is configured automatically according to the connection
type from the Nova73 module.

e Selecta Tie-Line - the MADI signals are added to the Port:

E Core browser

s @A

Jystem

E'"C_orel
-Module 2 [AES3]
Module 4 [MADI]

ElModule 6 [MADI]

=-Port1 MADL

[=RTic-Line (64 channels)
#-Inl-8

..

B Qutl -8
BH-Outd - 16
- Qut 17 - 24
E-Out 25 - 32
Qut33-40
Out4l -48
B-Out 49 - 56
- Out 57 - 64

-Port 2 MADI

-Module1l [D5P]

- Module13 [D5P]

- Module15 [D5P]

~-Router module

--Redundant router module

- PSY

-Redundant P5U
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e Select Plugin Server - a special 64 channel connection to the Lawo Plugin Server is added to
the Port:

(T3] Core browser il Core1- mxGUI mc’ Series

g \___:\é.A”. o
System '

E-Corel

- Module 2 [MADI]
EFModule 4 [MADI]

E+-Port1 MADI

[ ILigin Server (64 channels)

B-Port 2 MADI
~Module 11 [DSP]
-Module 13 [DSP]
- Module 15 [DSP]
--Router module
pSY
--Redundant PSU

[ corebrowser
T il BB

System
Bl Corel

+-Module 4 [MADI]
~Module 6 [MADI]
=-Port 1 MADL

=

+-10-Card 4 [GPI]
[-10-Card 5 [AES3]
[#-10-Card 6 [LINE]
“Masterboard
------ Port 2 MADI
----- Medule11 [DSP]
Module13 [DSP]
Module 15 [DSP]
Router medule
PsSU
Redundant PSU

/O The signals appear in a similar manner to DALLIS plug-in cards. However, you cannot
change the Local /O card arrangement, as this is determined by the physical board fitted
to the control surface!

If you want to change the function of a port, then you will need to delete the current assignment:
3. For example, right-click on a DALLIS in the 'Core Browser' and select Delete:

@ Core browser

==L MNeA
System
E}---C_orel

dule 2 [MADI]
Port1 MADI [REDUNDANT]

Dallis 3RU (52 ch 1s)
|| Copy Dallis 3RU (52 channels)
[ Cut Dallis 3RU (52 channels)

~Card 1 [MIQ

@ Delete Dallis 3RU (52 channels)

You are asked to confirm - Yes or No.

4. Select Yes to remove the DALLIS, and all of its sub components, from the configuration. You
can now return to step 1 to make a new selection.
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Fitting Cards to a DALLIS

You can now fit cards to DALLIS units in a similar manner to fitting Nova73 modules:

1. Right-click on a card slot and select a drop-down option:

L5 Core browser

= Z e A

System

llis 3RV (52 channels) (Channels left

E-Corel

=3

Module 2 [AES3]
Module 4 [MADI]
=-Port1 MADI

DSP Resources (4 channels)

941/02 Line In trafo 15dBu D-Sub
941/04 Line In trafo 24dBu D-Sub

'.-DSP Resources (3 channels} 941/06 Line In trafo 18dBu D-Sub
- Port 2 MADI 941/12 Line In trafo 15dBu XLR
B Medule 6 [MADI] 3
. Module 11 [DSP] 941/14 Line In trafo 24dBu XLR
Module 13 [DSP] 941/16 Line In trafo 18dBu XLR

- Module 15 [DSP]

- Router module
PSU

- Redundant PSU

941/62 Mic/LineIn trafo XLR
941/83 Line In/Out D-Sub

941/84 Line In D-5ub

942/02 Line Out trafo 15dBu D-Sub
942/04 Line Out trafo 24dBu D-Sub.
942/06 Line Out trafo 18dBu D-5ub
942/12 Line Out trafo 15dBu XLR
942/14 Line Out trafo 24dBu XLR
942/16 Line Out trafo 18dBu XLR
942/84 Line Out D-5ub

The available options depend on the selected slot and the capacity of the DALLIS; you cannot
configure an illegal option.

2. Right-click on PSU 2 to add or remove a redundant power supply:

| Ji. Dallis 3RU 52 channels) (Channels left IN: 36 / OUT: 36)

Z. 2% ¥ I 2

v available

@ You can check how many audio channels are left by looking in the title bar of the DALLIS
frame - in our example, 52 In and 52 Out.

The DALLIS master board type cannot be altered (as this is configured automatically when
you define the Nova73 /O Port.

Warning

Take care to fit each card so that it matches the exact slot position, and part number, of
your physical installation. Otherwise, the card may not operate correctly.
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Copy, Cut & Paste

If you are fitting several components of the same type, then you can use copy, cut and paste.

For example, you may be fitting several MIC cards to a DALLIS, or connecting several DALLIS (with
the same /O configuration) to the Nova73. Or, you may need to move a DALLIS card from one slot
position to another.

Note that all sub components and parameters are copied. Therefore, you may wish to configure the
DALLIS or card completely (including any parameters), before using copy, cut and paste.

Copy & Paste from the 'Graphic View'
1. Right-click on the source DALLIS card and select Copy:

. i"i Dallis 3RU {60 channels) - Dallis 3RU {Channels left IN: 44 [ OUT: 36)

=
i i LALALEF L N ]

empky

Analog
Special
AES3
GPI

Mulki-channel
DsP
Drata

* ¥ r*F v r v r

~ Copy 941/51
[ Cuk 94151

The card is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom of
the display:

| | Device 1111411111110 |

2. Then right-click on the destination card slot and select Paste:

. Ei Dallis 3RU {60 channels) - Dallis 3RU (Channels left IN: 44 7 OUT: 36

A0l 30 o R 1 d

.
Slot 2 il

v emphy @ o -
[
Analog i ]
Special

AEST

GFL

> Multi-channel
DSk

Daka

* ¥ ¥ ¥ rvr v r

8 Paste 941/51 tothis Slot

The card, and all of its parameters, are pasted into the configuration.
3. Repeat step 2 to quickly assign the same card to a number of slots.

4. Select Cut (in step 1) to move a card to a different slot.

/O Note that Paste is only available if you select a valid destination. For example, if the DALLIS
runs out of audio channels, then you will not be able to select Paste.
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Copy & Paste from the 'Core Browser'
1. Right-click on the source component - for example, a complete DALLIS - and select Copy:

Core browser

S i@ A
System

Et-Corel

EHModule 2 [MADT]

Eh-Port 1 MADI [REDUNDANT]
---Card 1 [MIC Dallis 3RU (52 channels)
B Card 3 [MIC L|_L| Copy Dallis 3RU (52 channels)

Card 7 [AES] 1 :
Card 14 [LIN [ Cut Dallis 3RU (52 channels)
Card 16 [LIN _
Card 18 [N @ Delete Dallis 3RU (52 channels)

----- Masterboard

The device is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom
of the display:

||L|_I_|Su|:erdevice 11110 ”

2. Then right-click on the destination Port and select Paste:

Core browser

=z . @A
System

E}-"C_orel

E-Maodule 2 [MADI]

Eh-Port1 MADI [REDUNDANT]
[=}-Dallis 3RU (52 channels)
B-Card 1 [MIC]
B-Card 3 [MIC]
B--Card 7 [AES3]
B-Card 8 [SDI)
&
[

H--Card 14 [LINE]

t--Card 16 [LINE]

----- Card 18 [MNA]

------ Masterboard

----- Redundant masterboard

----- Redundant P5U

[ DSP Resources (4 channels)
[#}-D5P Resources (8 channels)
EF-Port 2 MADI

“Module 4 [MADI]

“Module 6 [MADI]

-
Lol o)

.-Port 2 MAD| Port 1 MADI

~~Module 11 [DSR [ paste Dallis 3RU (52 channels)
~Module 13 [DSR

~Module 15 [DSH Define Dallis 3RU (60 channels + 4 DSP resources)
- Router module
PS5l Define Dallis 3RU (52 channels + 4 & 8 DSP resources)
~~Redundant PSU Define Dallis 6RU (60 channels + 4 DSP resources)
Define Dallis 6RU (52 channels + 4 & 8 DSP resources)
Define Tie-Line (64 channels)

Define Tie-Line (56 channelz + & DSP rezources)
Define Plugin Server

Define Local V'O

The DALLIS, including all of its cards and parameters, are pasted into the configuration.
3. Repeat step 2 to paste the same DALLIS configuration to multiple ports.

4. Select Cut (in step 1) to move a DALLIS to a different port.

Note that Paste is only available if you select a valid destination. For example, you can only
paste a MADI DALLIS to another MADI port.
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Deleting Components

Depending on the component, it can be deleted either from the ‘Core Browser’ or ‘Graphic View’, see
Defining the Nova73 and Fitting Modules to the Core.

Warning

Deleting a component, removes it and all of its sub components, from the configuration.
Therefore, if you wish to keep parts of an existing configuration, use Copy, Cut & Paste.
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Port Redundancy

For crucial interconnections between DALLIS and Nova73 units, you can specify link & port

redundancy.

To configure port redundancy, two master boards are fitted to each DALLIS. Each connects to a
different Nova73 port (preferably on a different module). AdminHD can select which /O _port is used
for the redundant connection as follows.

/O Note that to support this feature, your system must be fitted with two master boards per
DALLIS, plus enough single-port Nova73 modules to support the connections.

Let’s take an example, where the main connection to the DALLIS is from Module 4 Port 1. We have
a spare port on Module 8 Port 1 which we want to use for the redundant connection:

L7 Care browser

= = X @
Syshern

El-Care 1

Eb-Module 2 [AES3]
¢ [-Port 1 AES3

| E-Port 2MADI Main
[=h-Module 4 [MADT] Connection
1 MADI
Dallis 3RU (60 channels)
[#--DSP Resources (4 channels)
[#-Port 2 MADI
[F-Module & [MADI]
[=-Module § [MADIL]

wPrt | MACT

~-Part 2 MADT
~Module 11 [D5P] 3 Spare Port
- Module 13 [D3P]
~-Module 15 [DSP]
~-Rouker module
--Redundant PSL

1. Select Module 4 Port 1 and double-click to open its ‘Parameter Box'.
2. Tickthe Is redundant option.

The following pop-up appears:

[T core browser ] Port 1 MADI

= = . © Data |,

System

EH-Care 1 Port Number |25
EH-Madule 2 [AE53]

Port 1 AESS Intetface bype

—}-Madule 4 [MADI] Is redundant [
- T system
~Dallis 3RU {60 channels) Corresponding port E-Core 1
| [-DSPResources (4 channels)
Part 2 MADT
G- Module & [MADI]
[=}-Module & [MADI]
LePart 1 MADT
Pt 2 MADI

E}-Port 1 MADL
Dallis 3RU {60 channels)
D3P Resources (4 channels)
[E-FPort 2 MADT
E-Module & [MADI]
El-Module & [MADI]
ork 1 MADI
Port 2 MADT
Maodule 11 [DSP]
Maodule 13 [DSP]
-Madule 15 [DSP]
--Rouker madule
---Redundant PSL

- Module 11 [DSP]
- Module 13 [DSP]
- Module 15 [DSP]
--Router module
Pl
--Redundant PSLI

|
3. Select the redundant port — in our example, Module 8 Port 1 and click OK.
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The ports are now linked as indicated in the ‘Core Browser”.

[T core browser | | Port 1 MADI

= z Lrl_l Bﬁ’ G m‘ Data "\
Syskem

[=h-Core 1 Port: Humber [25 |

EH-Madule 2 [4ES3]
B3-Port 1 AES3
F-Port 2 MADI
E+-Madule 4 [MADI] Is redundant [¥]
ort 1 MADI [REDUMNDANT]
Dallis 3RU (60 channels)

H DSP Resources (4 channels)
ort 2 MADT /
[F#-Module 6 [MADI]
=}-Madule & [MADI] / ¥
L.Port 1 MADT [LINK]

L-Port 2 MADT
----- Module 11 [DSP]
----- Module 13 [DSP]
----- Module 15 [DSF]
----- Rauter module

Intetface bype [mabT |

Corresponding pork | 1:1:8:1:0:0:0

----- Redundant PSU

And the ‘Parameter Box' for Module 4 Port 1 shows the address of the linked port within the
Corresponding port box. This is described as a system address:

System : Core : Module : Port © nu.: nu. . nu.
1 : 1 8 : 1 - 0: 0 : 0

4. If you now select the DALLIS and look at its ‘Graphic View’, you will see that a redundant
master board has been fitted:

[ ﬁ Dallis 3RU {60 channels) {Channels left IN: 60 / OUT: 60)
T [ (6 (& (& & & & & & & |

e

- @a @s -
BoRS

- -
e

Redundant masterboard

v available PsU 2‘

5. Right-click on the redundant master board slot and select (or unselect) available to add (or
remove) the link to the redundant port.

168 V5.0/1 mc256 MKIl Technical Manual



Chapter 3: AdminHD
Core Configuration: Defining the System

1%

Port DSP Resources

Whenever you define a MADI Tie-line or DALLIS which is 60-channels or less, you automatically

configure an amount of DSP resource.

This is DSP which is physically located on the port (within the Nova73 module), and can be used for
additional mix matrices of either 4x4 or 8x8. The applications for this DSP resource are defined by

AdminHD and include:

e Console Monitoring - one 4x4 plus one 8x8 resource are required to support the console's
standard stereo and surround control room monitoring.

e Downmix Matrix - one 8x8 matrix is required to for each surround downmix. Once
configured, matrices can be controlled from the GUI's Downmix display.

The amount of DSP resource is defined when you configure each MADI Port - for example, defining a
52-channel DALLIS leaves 12 free channels to support one 4x4 plus one 8x8 DSP resource:

B AdminHD - new config fils *

File Remote Extras Window 7

M OO0 @ X [O
[ T3] Core browser

= @ A

G-+ -

System

.p
Module 6 [M
‘Module 11 [D
‘Module 13 [D
‘Module 15 [D
‘Router madul

Define Dallis 3RU (60 channels + 4 DSP resources)
Define Dallis 3RU (52 channels + 4 & & DSP resources)
Define Dallis 6RU (60 channels + 4 DSP resources)
Drefine Dallis 6RU (52 channels + 4 & & DSP resources)

: U
“Redundant PS

Define Tie-Line (64 channels)

Define Tie-Line (36 channels + & DSP resources)
Define Plugin Server

Define Local /'O

To configure the application of the DSP resources:

=
___:] Core browser

= @ A

System
E}-"C_ore 1

(- Module 2 [AES3]
=-Medule 4 [MADI]
E-Port1 MADI
E-Peort 2 MADI

- Moduled [MADI]
----- Module 11 [DSP]
----- Router module

1. Right-click on the DSP Resources in the 'Core Browser'.

F#-Dallis 3RU (52 channels)

RSP Resources (4 channels)

- DSP Resources (8 channels)

A drop-down menu appears listing the available options. These vary depending on the number of

channels:

(T4 core browser

= = - @

-’ ',

System
[=h-Care 1
F-Module 2 [AES3]
E-Madule 4 [MADI]
B-Part 1 MADI
EH-Park 2 MADI
i}-Dallis 3RU (52 channels)
P Resources (4 channels)
D3P Resources (3 channels)
[#-Module & [MADI]
----- Module 11 [DSP]
----- Module 13 [DSP]
----- Module 15 [DSP]
----- Router module

DSP Resources {4 channels)
Define Listen stereo

Define Listen surround
Define Matrix (4 * 4)
Define Matrix (3 * &)

----- Redundant PSU

(T3 core browser

= > b @

=

System
E-Core 1
(- Madule 2 [AES3]
[E-Madule 4 [MADI]
F-Port 1 MADI
[=-Port 2 MADI
---DaIIis 3R (52 channels)

Resaur

SP Resources (4 channels)
T s (8 channels,

DSP Resources {8 channels)

[+-Module & [MADI]
----- Module 11 [D5P]
----- Module 13 [DSP]
----- Module 15 [DSP]
----- Router module

Define Lisken stereo
Ceefine Listen surround
Define Matrix (4 * 43
Define Matrix (5 * &)

----- Redundant PSU
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2. Select an option to configure the resources:

e Listen stereo or Listen surround — configures matrices for the console's stereo and
surround monitoring.

e Matrix (4 * 4) or Matrix (8 * 8) — creates summing matrices. You will need a Matrix (8 * 8) to
define a downmix matrix.

3. Todefine a Matrix (8 * 8) as a downmix matrix, double-click to open its 'Parameter Box', and
tick the Downmix matrix option:

I—_j Core browser . [ Matrix(8* 8
e 3
Gy BT @ A Data \
System
E-Corel Device alias |D0wnmix Matrix 1 |
- Module 2 [AES3]
E-Moduled [MAD]] Typename | Matrix (8 * 8) |
&-Port 1 MADI
[=+-Port 2 MADI

[ Dallis 3RU (52 channels) Downmix matrix
----- DSP Resources (4 channels)
=-DSP Resources (& channels)
B-Module 6 [MADI]

----- Meodule11 [DSP]

----- Router module

----- Redundant P5U

Once the configuration is uploaded to the system, you will be able to control the surround downmix
from the GUI's Downmix display.

/O To access the inputs and outputs of a matrix, the signals must be added to the Signal List
configuration (gui_config.tcl) using the 'Signal List Editor'.
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Core Configuration: Editing Parameters

This section looks at editing the system-wide and signal parameters stored within the Core
configuration.

9 To add or remove a hardware component, see Defining the System.

Whether you want to change a system or signal parameter, the operation is essentially the same, see
Operating Principles: 'Parameter Box'.

For details on all options, see the Parameters reference section. Here we will cover some of the most
common editing tasks:

¢ Signal names and labels

e Device names (Alias names)

e Control system IP address

e Multi-channel sync

e Qperating levels

e Maximum sample rate

e Mapping Tables
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Signal Names and Labels

For each individual signal, you can edit the Name and default Label. These appear in the GUI's
Signal List display, and are also used by AdminHD's 'Connect Manager':

mc? Signal List display

Destinations
& () | Name Label ™7
046A01lm1 Mic 01 ! INP 1A Com 01

{046A01m3:Mic 03 | | | : INP 3A iGuest

e The signal Name is stored only by the Core configuration, and cannot be edited from the
console GUL. It should be used to provide a "fixed" signal name relevant to the installation.

e The signal Label is the label which the system resets to after a cold start. Users can change
labels later from the GUI's Signal List display, or from AdminHD's 'Connect Manager'.

/O Both the Name and Label are limited to a maximum of 8 characters.

» To edit an individual name (or label):
1. Open the branches of the ‘Core Browser’ to reveal the signal you wish to edit.
2. Double-click on the signal — for example, Signal In 1.

The 'Parameter Box' opens:

[T5| Core browser . [ signal In 1

= = - A [ Signal | DSP | Map |,

System

=Corel HLSD [BoR ~:008 Hooo |{ooo |

EH-Madule 2 [MADI]
E+-Port 1 MADI [REDUNDANT
[1-Dallis 3RU (52 channe
- Card

B
R oignal In 1

SignalIn3
“-Signal In 4 Qralp Mic |

#-Card 3 [MIC]

#-Card 7 [AES3]
#--Card 14 [LINE]
- Card 16 [LINE]

Signal name | MICOL.01 |

Signal label | MICOL01 |

- -

- Card 18 [NA]

- Masterboard
Redundant masterboard
PsU

-~ Redundant P5U

[#-DSP Resources (4 channels)

[#-DSP Resources (8 channels)

[#--Port 2 MADI

~Maodule 4 [MADI]

~Module 11 [DSP]

-Module 13 [DSP]

--Module 15 [DSP]

--Router module

- PSU

~~Redundant P5L

=
T

3. Clickin the Signal name (or Signal label) field, and type in the new name - you may enter up
to 8 characters.

4. Press Enter to confirm the name.
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> To edit arange of names (or labels):

Once you have selected the text in the Signal name (or Signal label) field, you can use the PAGE
UP or PAGE DOWN keys (on your computer keyboard) to navigate up or down the system tree while
retaining the selected field.

@ This short cut can be applied to any "name" field - for example, the Group name, Super-
device alias name, etc.

You can also press CTRL + C to copy, and CTRL + V to paste text between fields.

Alternatively, if you want to name a range of signals with the same suffix — for example, GUEST_01,
GUEST_02, GUEST _03, then you can use the Comfort Text Edit Mode:

1. Enable this mode from the Extras -> Datasheet -> Comfort Text Edit Mode main menu.

2.  Name the first signal and leave your cursor in the "name" field:

,__j] Core browser 'j SignalIn1 @

e @ A signal | DSP ' Map |
System
El---C_Drel
=Module 2 [MADI]
El-Port1 MADI [REDUMDANT]
= Dallis 3RU (52 channels)
- Card 1 [MIC]

HLSD [BoR |00 {000 <000 |

Signal name |MIC01.01 |

Signal label |

Group | MIC |

3. Now press CTRL + SHIFT + PAGE DOWN.

AdminHD steps down to the next signal in the system tree and automatically increments the
suffix:

'_|_:] Core browser = Signal In 2

i @A Signal |, DSP ', Map |,
System
=-Corel

=-Medule 2 [MADI]
=-Port 1 MADI [REDUNDANT]
[ Dallis 3RU (52 channels)

HLSD [Bor ~|{o0s [foo1 4000 |

Signal name | MIC01.02 |

Signal Iabel |

Group | MIC |

4. Repeat for all the signals in the range.
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Device Names (Alias Names)

For each component you may enter an alias name to help identify components in AdminHD.

The names are used only within AdminHD, and are not transferred to the remote control system.

You can display the alias names in the '‘Core Browser' by enabling the Alias button on the toolbar:

Alias off

[T Core browser

= T @ A
System

EH-Corel

EH-Module 2 [MADI]
=-Port 1 MADI [REDUNDANT]
£} Dallis 3RU (52 channels)

Card 1 [AES3]
Card 3 [AES3]
Card 5 [MIC]
Card 6 [MIC]
Card 9 [LINE]
Card 11 [LINE]
Card 12 [LINE]
Card 14 [LINE]
Card 16 [AES3]
Masterboard

- Redundant masterboard

PSU

- Redundant PSU
DSP Resources (4 channels)
DSP Resources (8 channels)

oo ] G- G G

&
s

ol
b

Alias on

L ‘L] Core browser

T =
B e |,

System
EH-mc66mKI_Demo
H-Slot 2 MADI
EH-Port 1 MADI [REDUNDANT]
E}-Stagebox AL
AES31-4
AES3 5-8
MIC1-8
MIC 9-16
LINE infout 1-8
LINE out 9-16
LINE out 17-24
LINE out 25-32
AES infout BNC
Masterboard
~Redundant masterboard
PsU
--Redundant PSU

DSP Resources (8 channels)

- (- G- - - -

The alias names are also used by the 'Signal_List Editor’ (within the Hardware Tree), and if you use

the Generate Automatic Signal List button.

To enter an alias name:

1. Double-click on the component - e.g. the Core - within the 'Core_Browser', and select the

Data tab in the 'Parameter Box':

:I Core1

o B

Plugin server\

Core alias
Router module model number
Router module type

Router module

Connection ~ Data \‘. System settings \\ Map\ External \\ Network\

||'r1cZ Studie 1

[o80/22

[HD Core8k (48 kH2)

Multi-channel sync port

2. Enter a name into the Core alias field.

Redundant router module =
Redundant PSU
Black burst synchronised switching [
Internal sync activates alarm O
Enable sync port O

If the field is left empty, then a default system name is used to describe each component.
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Control System IP Address

These parameters set the TCP/IP address of the control system (for the Lawo system_network port -
Ethernet B).

» To edit the system's IP Address:

1. Double-click on the Core within the 'Core Browser', and select the Connection tab in the
'Parameter Box':

o [

[~] corel ;

Plugin ;erver\
Connection \Data \ System settings \I\Map \ External \\ Network\\

Remote IP enable

Remote IP address 19216810256 |

Remote IP redundant enable [

Remote IP address redundant

2. Ifasingle Router Module is fitted to the Nova73, then enter the main Remote IP address only.

3. If main and redundant Router Modules are fitted, then also tick Remote IP redundant
enable. This enables the redundant Router Module and automatically sets the Remote IP
address redundant - always 1 above the Remote IP address.

We recommend keeping the default IP_address, where possible, as this will simplify remote
maintenance. However, if your mc256 MKIl is part of a larger network, then it will need a unique IP.
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Multi-channel Sync

The Nova73 offers a fully redundant clock source structure, including the ability to lock to sync from
an incoming multi-channel signal.

> To define the multi-channel sync source:

1. Double-click on the Core within the '‘Core Browser', and select the Data tab in the 'Parameter
Box':

.!anrel |

Plugin SEI’VEF\“
Connection ~ Data \‘. System settings \\ Map\ External \\ Network\

Core alias |mc25tudiol |
Router module model number [o80/22 |
Router module type | HD Core 8k (48 kHz) ‘
Router module
Redundant router module O
Redundant PSU
Black burst synchronised switching [
Internal sync activates alarm |
Enable sync port O

Multi-channel sync port

2. Click on the Enable sync port box.

A pop-up appears where you can select the multi-channel sync source:

':l Core 1

Data \\ Systern settings \Map \

ot E

Core alias |HD Core Central Rouker |

Routet module model number

Select redundant sync-port
Router module bype 2

Ruouter module [v] I
H-Module 2 [AES3]
IP address router module 192.168. 1| E} tModule 4 [MADI]
i -Port 1 MADI
Fedundant router module o art 2 Mabl

odule & [MADI]
#1-Module 9 [D5P]
E-Module 11 [D5F]
B-Module 13 [D5F]
Router module
LePSL

Ink | tivates al i

nternal sync activates alarm [ - Redundant PSL
Enable sync port

Multi-channel sync port

IP address redundant router module | 192, 165, 1]

Black burst synchronised switching [

3. Select the source — for example, Module 4 Port 1 MADI - and click on OK.
The multi-channel sync source is displayed as a system address — for example:

Enable sync port [v]

Multi-channel sync port | 1:1:4:1:00:0
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Operating Levels

These parameters specify the operating levels which the system resets to after a cold start. Users
can change the levels later from the console GUI's System Settings display.

There are three level settings which interact to define the internal and analogue-to-digital operating
levels of the system:

e Maximum Analogue Level = Reference Level + Headroom

The system supports a maximum analogue level = +24dB, and a minimum analogue level = +12dBu.

Warning

Changing the Reference Level or Headroom options move the internal 0dB operating
point for the system and therefore will change the behaviour of any level dependent settings
such as dynamics processing and metering. Therefore, it is not advisable to alter these
levels once dynamics processing has been set.

/(_j For systems fitted with fixed level analogue I/O cards:

e The Headroom and Reference Level cannot be altered independently. For
example, with a +15dBu fixed analogue /O card and +9dB Headroom, the
Reference Level must be +6dBu.

e The Maximum_Analogue Level of the whole system is defined by the DALLIS card
with the lowest GDA (General Device Address) - this is the card with the lowest
address fitted to the DALLIS frame connected to the lowest port number of the first
Nova73. (If a different fixed level analogue card is fitted elsewhere within the
system, then a warning appears in the log file; however, the card with the lowest
GDA still wins.)

> To set the levels:

1. Double-click on the Core within the '‘Core_Browser', and select the System settings tab in
the 'Parameter Box':

o E

=] core1 :

Plugin server\
Connection \ Data * System settings \,IMap \ External \ Network\

Analog full-scale level [dBu] [15 -

Reference level [dBu] ‘ a }%

Headroom [dB] ) |

Sampling frequency [kHz] ‘48 v|

Disable global alarm

2. Select the Analog full-scale level from the drop-down menu options.
3. Then set the Reference level by clicking on the up and down arrows.

The resultant Headroom is calculated automatically.

mc256 MKIl Technical Manual V5.0/1 177



% Chapter 3: AdminHD
Core Configuration: Editing Parameters

Internal Sampling Rate

This parameter specifies the internal sampling frequency which the system resets to after a cold
start. Users can change the sample rate later from the console GUI's System Settings display.

Note that the maximum sample rate (96kHz or 48kHz) is defined when you select the type
of Nova73.

» To set the internal sampling rate:

1. Double-click on the Core within the 'Core Browser', and select the System settings tab in
the 'Parameter Box':

o

[=] Core1

Plugin server\
Connection \ Data System settings \".Map \ External ‘\ Network\

Analog full-scale level [dBu] 15 |

Reference level [dBu] ‘ 6 l%

Headroom [dB] ) |

Sampling frequency [kHz] ‘48 v|

Disable global alarm

2. Select the Sampling frequency from the drop-down menu option.

The available options are defined by your choice of Core.
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Mapping Tables

Lawo’'s Remote MNOPL protocol is a freely available Ethernet (TCP/IP) protocol providing control of
virtually any system parameter from an external device.

A typical application is to provide third-party matrix control so that crosspoints within the mc256 MKII's
routing matrix can be controlled by external control systems such as VSM, Evertz, Quartz, BFE,
Pharos and others. (If your preferred supplier does not support the protocol, then please ask them to
contact Lawo for further details):

Router control
system

Video matrix 1
{video layer)

Nova73 HD
{ (audio layer) !

Within your AdminHD configuration, each signal may be given a mapping address. Up to 16 different
mapping tables can be defined so that different control systems can be supported simultaneously.

» To configure the mapping tables:

1. Double-click on the Core within the 'Core Browser', and select the Map tab in the 'Parameter
Box':

| core 1 2 E

Daka \System settings " Map \External ‘\

Mapping table 01 unknown signal address I:I
Mapping table 01 no signal address OaFFFFFFFF]

2. For your chosen mapping table (01 to 16), enter the signal addresses which will be submitted
to the external control system:

e unknown signal - submitted when an undefined source is connected to a defined destination.

e no signal address - submitted when a signal is disconnected.

Please refer to your external control system’s documentation for details on which addresses to enter.
Our example shows the addresses for a Lawo zirkon control system.

3. Now select the first signal you wish to map to the controller, and select the Map tab.
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4. For your chosen mapping table (01 to 16), assign the Mapping table address:

o [

"= signal In 1

Signal |, DSP ' Map |,

Mapping table 01 address |l

Mapping table 02 address |

The format of the address will be specified by your external control system.

5. Repeat for all the signals you wish to control from your external device.

6. You can get an overview of the assignments by selecting Extras -> Show Mapping Table

from the main menus.

In our example, Mapping table 1 assigns signals to a Lawo zirkon system:

File Remote Window 7 Mapping table 1
@ H Show mapping kable 1 Core DFFFFFFFF
(-& Check configuration  Ctd-K Show mapping table 2 [Care 0
[T Core brow ) D01A01mL MICO1,01 BOR:000:000:000 1
LT e
o 2R T O Breferences kP St i) s 3 n01AO1M2 MICOL,02 BOR:000:001:000 2
= = BT Shaw mapping kable 4 001A01m3 MIC01.03 BOR.:000:002:000 3
System Show mapping table 5 D01A01M4 MICO1, 04 BOR:000:003:000 4
N ore 1| Show mapping table 6 N01A01mS MICO1,05 BOR:000:004:000 5
-Router module . 001A01me MIC01.06 BOR.:000:005:000 &
psy St g s 7 D01A01M7 MICO1,07 BOR:000:006:000 7
...... Redundant PSU Shaw mapping table & D01A01MS MICO1,08 BOR:000:007:000 8
Show mapping table 3 n01A02m1 MICOZ,01 BOR:000:008:000 9
Show mapping table 10 n01A02m2 MIC0Z2, 02 BOR:000:009:000 10
) n01A02m3 MIC02, 03 BOR:000:010:000 11
Sy e s 1 n01A02m4 MICO2, 04 BOR:000:011:000 12
Show mapping table 12 D01A02mS MIC02, 05 BOR:000:012:000 13
Show mapping table 13 n01A02mE MIC0Z, 06 BOR:000:013:000 14
Show mapping table 14 n01A02m7 MIC02,07 BOR:000:014:000 15
) n01A02mS MIC02, 08 BOR:000:015:000 16
Show mapping table 15
Show mapping table 16
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Signal List Configuration

This section deals with how to edit and update a Signal List.

Signal Lists are created by the ‘Signal List Editor' and stored as separate .sIx files to the Core
configuration (.csv file).

The 'Signal List Editor' can produce a cold_start file (gui_config.tcl) to modify the console GUI's
Signal List display, or a signallist.slx file to customise the signals visible in the 'Connect Manager'.

/Lj The gui_config.tcl can ONLY be uploaded to the remote system's cold start data. This
means that you MUST be prepared to restart the mc256 MKII in order to change its Signal
List configuration.

The principles are similar to editing the Core configuration (config.tcl); the best approach is as
follows:

1. AdminHD must have a Core configuration with some relevant signals. Therefore, first
download or open a Core configuration as described earlier.

2. Open the 'Signal List Editor' sub window.

3. If possible, download the existing Signal List configuration from the mc256 MKIl control
system.

Alternatively, if you can't connect to the mc256 MKII, open an existing signallist.six file. This may
be a file which you saved earlier or requested from your configuration engineer.

If you have neither a network connection or an existing signallist.six file, then you will need to
create a new Signal List and build a configuration.

4. Save the configuration as a signallist.slx file - this allows you to open it later, or move it to
another AdminHD computer.

5. Edit the Signal List.
6. Backup the system's existing cold start files.

7. Export the Signal List configuration as a gui_config.tcl file - this puts the data into a format
which can be read by the control system.

8. Upload the gui_config.tcl file from your computer to the mc256 MKII control system.

6. Cold start the mc256 MKII to see your changes take affect.

Workflow Suggestion:

If you are making changes to both the Core and Signal List configurations, then download and save
both sets of data (config.csv and signallist.slx) while you are connected to the control system.
Once editing is complete, export both cold start files (config.tcl and gui_config.tcl), and upload
them to the control system. You can then perform a single cold start to action all your changes.
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The 'Signal List Editor’

The ‘Signal List Editor’ is used to download, create, edit and upload the Signal_List configuration used
in the console GUI's Signal List display or AdminHD's 'Connect Manager'.

1. Click on ““ from the main toolbar to show the ‘Signal List Editor’.

Or select Window -> Signal list editor (from the main_menus) or press CTRL + SHIFT + S (on
your computer keyboard).

AdminHD analyses its Core configuration and opens the ‘Signal List Editor’ window:

| i= signal list editor

Source \Destination \
Directories & signals Hardware Tree selected signals

RHBEHEBOULGBOOEONMAGD |- T -
-Bus Out [@-MOZPO1DALED

F#-Direct Out [ MOZPOZRAWMADT G4

- Insert Send [ MO4POIRAWAESS

-Mew dir_0001 [} MO4PDZR AWMADI_S6

jlewe subdir_0001

AdminHD creates a new ‘empty’ Signal List each time you open the ‘Signal List Editor’. If you wish to
edit an existing Signal List, then either download the Signal List configuration from the mc256 MKII

control system, or open an existing signallist.slx file.
The ‘Signal List Editor’ is divided into two pages — Source and Destination.

2. Click on the Source and Destination page tabs to change between pages.
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Each page has three columns:

i = signal list editor - C:,Documents and Settings',Sue McdonaldiMy Documents', AdminHD_Configs'Studio 2'signallist.s... Pl G e |

Source \ Destination \

Directories & signals Hardware Tree Selected signals

: ~ - P ey

NN =N = [ QOT @& N &Y - o
#-Bus Out | [ MOZPUIRANAESS M1

[+ Direct OUE - MD2POZRAWMADT 64 Mz

[} Insert Send
[}-Stageboxes

[#-Card 3 [MIC]
~Card 4 [MIC]
~Card 5 [MIC]
Card & [MIC]
tagehox 2 F-Card 11 [LINE]
[#-Machines #- MO4POZDALSZ

- MO4POZ0SP4

- MO4POZDSPS

i} MOSPOLRAWMADL_64
- MOGPOZRAWMADL_64

[ETI TN s T es]

1 Directories & signals  This column displays the configured Signal List.
Signals are organised into directories and subdirectories which may
be added and renamed as you wish. Use the + and — signs to open
and close branches of the Directories & signals column to
interrogate the configured signal list.

2 Hardware Tree This column lists all the signals within the Core configuration. The
list uses the alias names (if entered). Otherwise, default system
names are used to describe each component — for example,
MO4PO1DALG60:

e MO4 — indicates the Nova73 Module (e.g. Module 4).
e PO1 —indicates the port on the Module (e.g. Port 1).

e DALG6O - indicates the device on the port (e.g. a DALLIS
Device with 60 audio channels).

Use the + and — signs to open and close branches of the Hardware
Tree. Click on an individual signal, or a card, and the signal(s)
appears in the third column - Selected signals.

3 Selected signals This column is used to build a list of signals, which you can add to

the selected subdirectory using the * button. Signals in red are
already used somewhere within the configuration; those in black are
not.

For more details, see Editing a Signal List.
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The Signal List Editor Toolbar
EHBEHEBOLINGNFOO T @M ™

1 2 3 4 5 E T 8 5 10 11 12 13 14 15 16 17

The toolbar, at the top of the 'Signal List Editor', is used to action most of the editor's functions.

Note that buttons are "greyed out" if they are unavailble - for example, you cannot Add a new
directory (12) if you have a signal selected in the Directories & signals column.

1 New Creates a new signal list.

2 Open Opens an existing Signal List file (signallist.sIx).

3 Save Saves the current Signal List configuration as a signallist.slx file.

4 Save as Saves the current configuration under a new filename.

5 Export Exports the current Signal List configuration as a cold start gui_config.tcl
file.

6 Download Downloads the Signal List configuration from the mc256 MKII control system
into AdminHD.

7 Copy Copies the selected signal or directory, from the Directories & signals
column, to the clipboard.

8 Cut Cuts the selected signal or directory from the Directories & signals
column.

9 Paste Pastes the clipboard data to the selected directory in the Directories &

signals column.

10 Move up Moves the position of a signal or directory in the Directories & signals
11  Move down  column.

12  Add directory/ Adds a new directory to the Directories & signals column.
subdirectory

13 Delete Deletes the selected signal or directory from the Directories & signals
column.

14  Locate signal Select a signal within the Directories & signals column, and then click this
button to locate its position within the Hardware Tree.

15 Generate Adds the directories and signals from the Hardware Tree into the
automatic Directories & signals column. Use this button to quickly generate a Signal
tree view List from your hardware components.

16  Update Updates the Hardware Tree column if you make changes to the Core
hardware configuration while the ‘Signal List Editor’ is open.
signal config

17 Duplicate Copies the directory structure, within the Directories & signals column,
directory from the Source to the Destination page (or vice versa).
structure
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Downloading the Signal List

The best way to ensure that you are working with your system's latest data, is to download the Signal
List configuration, from the mc256 MKII.

To perform a successful download, you will need a valid network_connection between your computer
and the control system.

9 Open the 'Remote Log' to monitor the progress of the download.

1. Click on €2 (Download GUI signal list config) from the 'Signal List Editor' toolbar.
2. If you have made changes to the current Signal List, then the following dialogue box appears:
Confirm @1

@ Config has not been saved yet! Changes will be discarded if not saved. Would You like to save now?

| Yes | || MNo ||

e Select Yes to save the configuration (as a .slx file) before proceeding.
e Select No to continue without saving.

AdminHD downloads the configuration data from the remote system; the 'Remote Log' reports on
the progress.

When the download is complete, the 'Signal List Editor' updates:

i = signal list editor - C:\Documents and Settings',Sue Mcdonald'My Documents', AdminHD_Configs'Studio 2\signallist.sl: *

- Source \Destination \

Directories & signals Hardware Tree Selected signals

L) a1 B eO0FenEH™ = + =
[#-Bius Qut [#-MOZPO1RAWAESS

---D\rect Cut [F-MO4POLDALED

Insert Send MOSPOLRAMWDSP_256

---Stageboxes ~M11POLRAWDSP_Z56

[]-Machines [-M1I3P0IRAWDSP_256

If there is a problem with the download, then:

0 Check the network connection and TCP/IP_settings of your computer's network interface
card.

0 Check that AdminHD is compatible with the mc256 MKII system.

0 See the trouble-shooting tips.
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Opening a Saved Signal List

To open an existing signallist.six file:

1. Clickon @ (Open signal list config) from the 'Signal List Editor' toolbar. (If you have made
changes to the current Signal List, then you will be asked if you wish to Save the changes first).

2. Select your file and click Open:

,7"-‘-‘ Signal list editor *

Source ' Destination \

Directories & signals Hardware Tree Selected signals
DEMERO QUEeaB S ™ = =
F - — = e —
inpui:;:n A+g % Open signal list config file... : M 0264011
~Insert Return

Dallis ;
B-Madi1 LookIn: |C3 Studio 2 CRE]
B-Madi 2 e
'"MUﬂitUring B signallist.sh
&1 Unknown

File Name: |5igna|li5t.s|x ‘

Files of Type: | mc” console series signal list config file "

The file opens, and the path and file name appear at the top of the 'Signal List Editor' window.

| 7= Signal list editor ‘ C:\Userst\Sue\Documents\Documentation & TrainingiLawo - All Documentation\Admin HOVAdminHD_Configs\Studio 2signallist.shx 7
o

Source ' Destination \Il

Directories & signals Hardware Tree

Selected signals
LatEEo QOLiena®™ |= ||+ =
&-Input/Mon A + B B MO2POLDSPS 026A01 il
&-Input/Mon B M02POZRAWMADL 64
---In sert Return B-Local /O

i -Machines

If there is a problem opening the file, then check:

e |s the file an AdminHD .slx ?

e Was the file saved by a newer release of AdminHD?

/O Configurations saved by an earlier version of AdminHD can be opened in a later release.
However, configurations saved by a newer release are not backwards compatible.

¢ Does the file contain signals which are not supported by the current Core configuration? If so,
then some parts of the Signal List may not load.
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Creating a New Signal List

A new ‘empty’ Signal List is created each time you open the ‘Signal List Editor’. However, if you

already have a Signal List open, and wish to clear its data, create a new file as follows:

1. Clickon (New Signal List Config) from the 'Signal List Editor' toolbar.

A new list is created, in the Directories & signals column, which includes the system's default

directories and an unnamed entry (New_dir_001 and New subdir_001).

In the Hardware Tree column, you will see all the signals available within your Core configuration:

. i = signal list editor 7

Source \Destlnatlon \l

Directories & signals

DEEEHEBOLHBOOE @M G D

Hardware Tree
L

selected signals

e

Bus Out

F-Direct Out

---Insert Send

Sh-Mew dir_0001
(2w subdir_0001

MOZPO1DALED

- -MO4PO1RAWAESS

- -MOZPOZRAWMADI_64

[B-MO4P02RAWMADI_S6

from your Core configuration.

@ Use the Generate automatic tree view from config button to quickly generate a Signal List
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Default Directories

For the mc2 mixing consoles, you will see some default Source and Destination directories which
cannot be edited or deleted.

These provide access to the console's channel DSP resources (Input/Mon A+ B, Bus Out, Direct
Out, Insert Send/Return), and other options dependent on your Core configuration (mxDSP
Signals and Plugin Server):

Source Page Destination Page
.,7‘ Signal list editor 7= Signal list edito

Source\l Destination \ Source " Destination \Il
Directories & signals Directories & signals

LRBERGL QO @ &s ™ RHEEMEOL QOE @M & m
[#-Bus Qut E-Input/Mon A + B

---Direct Out ---Insert Return

---Insert Send ---meSP Signals

B-mxDSP Signals "'Plugin Server

---Plugin Server E}New dir_0001

ENEW dir_0001 B ew subdir 0001

B ew subdir 0001

You can select whether the Input/Mon A + B directory appears from the Extras ->
Preferences -> Signal List Editor menu.

You will only see the mxDSP Signals directory if an mxDSP module has been added to the
Core configuration. Similarly, you will only see the Plugin Server directory if a MADI /O
Port has been defined for the plugin server.
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Saving the Signal List

Having downloaded, opened or created a new Signal List, it is a good idea to save the data as an
AdminHD signallist.six file. This will allow you to open the file later, move it to another AdminHD

computer, or import it into the 'Connect Manager'.

1. Click on either H (Save) or H (Save as) from the 'Signal List Editor' toolbar:
e Save overwrites the current file name (if one exists).
e Save as asks for a new file name:

Source ' Destination \l

Directories & signals Hardware Tree

[ MEs O FOQO G @mEs |- \

&-Input/Mon A + B[ T : i

I:EE:'MZ: N B Save signal list config file as.. @
" /

- ‘Insert Return

Machines Save In: |I‘:I Studio 2 v| @ Iy

signallist.she

File Mame: ‘Studio2J5igna|Iist.s|x ‘

Files of Type: ‘ mc® console series signal list config file "

2. Select a path and enter a suitable file name.

@ You can use any name as long as it keeps the .slx suffix. As the Signal List relates to the
Core configuration (.csv file), it is a good idea to store the two files in the same location.
See Organising Your Files.

3. Click Save to save the Signal List configuration onto your computer’s hard disk.

4. From here on, you can quickly update the file by clicking on @ (Save).
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Editing a Signal List

The current Signal list configuration is shown in the Directories & signals column. Directories and
subdirectories can be added and named as you wish. Signals can then be added to subdirectories as

follows:
-EE Signal list editor - C: Documents and Settings',Sue Mcdonald'My Documents’, AdminHD_Configs', Studio 2' signallist.sl... n"ﬁ' E
Source \'t Destination ‘1'.
Directories & signals . . Hardware Tree Bsted signals
Y a H F1 H L The Signal List A 5 — = 2 i
[#-Bus Out ---MDZPDIRAWAESS 025805m4
[#--Direct Out E}-MO4P01 DALED
[#--Insert Send [#--Card 1 [MIC]
[ Card 3 [MIC]
= Card 5 [MIC]
; - 025A05m]
- 025A01M2 - (2EANEM2
----- 025401m3 ~025405m3
..... 025a801m4 125,405 m+
----- 025A03m1 [#-Card 7 [MIC]
----- 025803mz2 - Card 9 [MIC]
- 025803m3 [ Card 11 [MIC]
- 0Z5803m4 [F-MO9PO1RAWDSP _256
----- 025405m1 [F-M11POIRAWDSP _256
- 0Z5A05m2 [F-M1ZPOIRAWDSP _256
----- O25A05m3
----- 025A05m4
[=}-Machines
EH-4TRs
[-Hard_Disk
= Step 1 : Define your E Step 2 : Select Step 3: Select the signals h Step 4: Add the II—
Directories & Subdirectorias a directory to add to the directory signals.
Note that:

e The Signal List structure supports three levels: directories, subdirectories and signals; you
cannot configure additional levels or add signals directly to directory. These restrictions are
required in order to support the GUI's Signal List display.

e The 'Signal List Editor' can add, remove and rename directories and subdirectories, and
organise signals into subdirectories. To rename the signals themselves, use the 'Parameter
Box' to edit the Signal name field.

* You can add a signal to more than one subdirectory.

Some tips:

e Keep the 'Signal List Editor' open, while adding components to the Core configuration. Then
use the Update hardware signal config button to refresh the Hardware Tree.

¢ You can generate a signal list automatically from the Core configuration. This is a quick way of
getting a useful starting configuration.

¢ Use Copy, Cut and Paste to duplicate or move subdirectories.

e Use the duplicate directory structure function to copy the structure of your Source directories
to the Destination page, or vice versa.

e The context menu (available from a right-click in the Directories & signals column) offers a

number of keyboard shortcuts.
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Adding & Naming Directories & Subdirectories

> To add anew directory, or subdirectory:

1. Select a position in the Directories & signals column.

2. Right-click and select Create new directory:

The new directory, or subdirectory, is added below your selection and given a default name.

| i= signal list editor - C:\Documents and Settings',Sue Mcdona

Source \Destination \
Directories & signals
DB EES L 0T éen
F-Bus Out
[-Direct Out

. - Stageboxes
Stagebo——
F-Machines @ Move up Ctrl-Page Lip
O Maove down <t-Page Down
w Create new directory
Copy -
& Cut Cre-K
Paste Ch
@ Delete Delete

== Add chosen signalis)

Note that the Signal List structure supports three levels: directories, subdirectories and
signals; you cannot configure additional levels.

» To rename adirectory, or subdirectory:

1. Double-click on the existing name.

The text is highlighted:

| + = signal list editor - C:\Documents and

Source | Destination |

Directories & signals

AMEMe
~Bus Qut
~Direct Out
-Insert Send
[Z}-Stageboxes
A -Skageboxl
[S®) e dir 0003
“...New subdir_0001
[-Machines

2. Type in the new name on your computer keyboard and press Enter - you may enter up to 16

characters.

@ For easy operation from the GUI's Signal List display, try and keep the names as short as

possible.
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Adding Signals to a Subdirectory

To add signals to a subdirectory:

1. First, use the Hardware Tree to build up a list of signals in the Selected signals column -
you can select single or multiple signals, and use the = button to edit the Selected signals list.

See Selection tips.

Source \ Destination \

Directories & signals

DRBEEE®

Hardware Tree

A BOOFenHE |-

Selected signals

b -

[#-Bus Qut:
[#-Direct DUt
[H-Insert Send

- MOZPOLRAWAES
- MOZPOZRAWMADL_&4
[=}-MO4POLDALED

Card 1 [MIC]

~Card 2 [MIC]
[#-Card 3 [MIC]
[F-Card 4 [MIC]
[#-Card 5 [MIC]
[#-Card & [MIC]
[#-Card 11 [LINE]

£} MO4PO02DALSZ
t}-MO4PO0Z0SP4
th-MO4PO0Z05PE

e MOGPO1RAWMADI_ &4
e} MOGPOZRAWMADI_54

[Er eI =]

2. Once you are happy with the Selected signals content, click on the * button to add all the
Selected signals to your subdirectory:

Source ' Destination |

Directories & cignals

=N =N=0=

Hardware Tree

I BOOGenEE™ |-

Selected signals

g -

Bus Qut
[#-Direct Cuk
[#-Insert Send
[=}-Stagebaoxes
0

-Stagebox 2
[H-Machines

MOZPO1RAWAESS
- MOZPOZRAWMADL_E4
=-MO4POLDALED

B ard 1 [MIC]
Card 2 [MIC]
~Card 3 [MIC]
~Card 4 [MIC]
-Card 5 [MIC]
Card 6 [MIC]
[1-Card 11 [LINE]
- MO4POZDALSZ
- MO4POZDSP4
- MO4POZDSPS
E
B

#-MOGPO IR AWMADL_54
#-MOBPOZRAWMADI_B4

Note that you can click the * button multiple times if you wish.

Note that in the Selected signals column, signals in red are already used somewhere within the
configuration; those in black are not.
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Selection Tips and Tricks

When adding signals, you can use the following tips and tricks to edit the contents of the Selected
signals column.

(The same tips can be used when deleting signals, but you would make selections in the Directories
& signals column.)

¢ To select all the signals from a card, click on the card within the Hardware Tree - all signals
within the card are added to the Selected signals list.

¢ To select a range of consecutive signals or cards, select the first signal or card; press and
hold SHIFT (on your computer keyboard), and then select the last signal or card - all signals
within the range are added to the Selected signals list:

Source | Destination |

Directories & signals Hardware Tree Selected signals

DAMENe  HBOOGONHHD ™ | + =
- MOZPOLRAWAESS M1 |~
0ZPOZRAWMADT_64 Mz i

Insert Send
[=1-Stageboxe
b

lachines

[-Card 5 [MIC]

[-Card & [MIC]

F-Card 11 [LINE]
th-MO4POZ0ALSZ

E

- MO4P0ZDSP4 M13

[ MO4POZDSPE 14

- MOSPOLRAWMADT_64 MiS

[ MOGPOZRAWMAD]_64 M 16 E
M7 B
M 18 7
M 19 =
M 20
Mz1
M2z [l

e To select non-consecutive signals or cards, press and hold CTRL (on your computer
keyboard) and then click on the signals or cards. As long as you continue to hold the CTRL
button, your selections accumulate within the Selected signals list:

Source \\Destinatiun \

Directories & signals Hardware Tree selected signals

UprbBEHHeUGHBOGFeAGE ™ = 5 =
Bus Out MOZPOLRAMAAESS M1
Direct Out MOZPOZRAWMADI_64 #mz
Insert Send - MO4POLDALED M7

l‘_;! Stageboxes =] Cgrd 1[MIc]

[-Machines

[#-Card 2 [MIC]
[#-Card 3 [MIC]
[#-Card 4 [MIC]
[#-Card 5 [MIC]
[#-CZard 6 [MIC]
[1-Card 11 [LINE]
[#-MO4POZDALSZ

- MO4P0ZDSP4
[#-MO4POZDSPE

e Toremove a signal, from the Selected signals column, select the signal and click on the =
button. Note that this function only edits what is in the Selected signals column. If you wish to
remove a signal from a subdirectory, then see deleting signals.

mc256 MKIl Technical Manual V5.0/1 193



w Chapter 3: AdminHD

Signal List Configuration

Deleting Signals, Subdirectories & Directories
> To delete signals from a subdirectory:

1. Select the signals, from the Directories & signals column, see Selection tips and tricks.

2. Right-click and select Delete:

i= signal list editor - C:\Documents and Settings'Sue Mcc

Source \Destinatinn \

Directories & signals

DRHEHEMES N HMEBEOOF @ |
[#-Bus Out

- Direct Out

B Insert Send
[=-Stageboxes
E---Stageboxl

4% Selected signals

o Move up Cirl-Page Up
4 @ Maove down t-Paga Down

BF Create new drrectory  Insent

Copy Sl
akal [ cut el
| I Paste il

ML @ Delete Delete

3. Confirm by clicking Yes.
The selected signals are deleted from the Signal List.
» To delete directories or subdirectories:

1. Select the directory or subdirectory, from the Directories & signals column. You can make
multiple selections if you wish, see Selection tips and tricks.

2. Right-click and select Delete:

Source De:tination\

Directories & signals
DRBEHEBOLUNEIEOOE @
F-Input/Mon A + B

“Input/Maen
~Insert Return

=] Machines
o P
[-Hai YIRS
O Move up Ctrl-Page Up
@ Move down Ctrl-Page Down

[y Create new directory Insert

Copy Ctrl-C
[ Cut X
Paste -y

'JI}' Add chosen signal(s)

3. Confirm by clicking Yes.

/O Note that deleting a directory deletes all subdirectories and signals within it.
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Editing the Position of Signals, Subdirectories & Directories

» To move the position of a signal, subdirectory or directory:
1. Select the signal, directory or subdirectory, from the Directories & signals column.

2. Right-click and select Move up or Move down:

= signal list editor - C:\Documnents and Settings\Sue Mcdon.

Source \Dest\nation \

Directories & signals

DRrHMEHEOLGEBOOT@N
Bus Out

F-Direct Out

---Insert Send

I‘_;}---Stageboxes

Machines e Move up Ctr-Page Lp

@ Move down <trl-Page Down

E, Create new directory  Insen

Copy St
| ue Ctrkx
| raste Gl
@ Delete Delete

'{',3 Add chosen signal{s)

Or, click on the @ or @ (Move node) buttons from the 'Signal List Editor' toolbar.

The selection moves accordingly.

mc256 MKIl Technical Manual V5.0/1 195



w Chapter 3: AdminHD

Signal List Configuration

Copy, Cut and Paste
The Copy, Cut and Paste functions provide a quick way to edit your signal list. For example:
> To cut asubdirectory from one directory to another:

1. Select the subdirectory you wish to copy from the Directories & signals column.

2. Right-click and select Cut:

[ = signal list editor - C:Documents and Settings'Sue Mcdon:

Source \ Destination \

Directories & signals

DRrREFEGL MEBOOT @ N
[#-Bus Qut

[+ Direck Cut

~Insert Send

[=}-Skageboxd

tagebol

ebox 2,
tagehox Stagebox 2
..... StagehoxB @ Mave up <irl-Page Up
[#-Machines @ Move down Ctd-Paga Down

[[J Create new directory  Inser

Copy el

B Faste Stagebox 2 W

@ Delets Delete

=k #dd chosen signal(s)

Or, click on the (Cut) button from the 'Signal List Editor' toolbar.
The selected subdirectory is copied to the 'Signal List Editor' clipboard.
3. Now select the directory where you want to paste the selection.

4. Right-click and select Paste:

[ = signal list editor - C:} Documents and Settings\Sue Mcc

Source \ Destination \

Directories & signals

DB BEOOF @ |
[#-Bus Qut

F-Direct Out

-Insert Send

E| Stageboxa

-Stagebaxl

-Stagebox 2

-Stagebox 3
0B @ bonb
Machines |odenos
@ Mowe up CtH-Page Up
@ Move down tr-Page Down

E,' Create new directory  Inser

Copy Sl
B oo Ci¥

I Fast= Stagebox 2

@) Delete Delete

= Add chosen signal(s)

Or, click on the (Paste) button from the 'Signal List Editor' toolbar.
The selected subdirectory is pasted accordingly, along with all of its contents.

Directories and subdirectories may be copied and pasted in a similar manner.
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Duplicating the Source/Destination Directory Structure

This function copies the structure of your Source directories to the Destination page, or vice versa.
It can be very useful if you wish to use similarly named directories and subdirectories in your Source
and Destination lists.

1. First, edit either your Source (or Destination page):

Scmrce\,I Destination \
Directories 8 signals
NN =N =) QOG @mEd

B-Bus Out

+--5StageboxB
Local Dallis
B-Madi1
Madi 2
---Momtorlng

r
2. Then click on the J (Duplicate directory structure) button, from the 'Signal List Editor’
toolbar, to copy the directory structure to the alternate page:

Source Destination\,I
Directories & signals
B CR=R=F =N~ .0 FemEd ™

E-Input/Mon A + B

E-Madi1
B Madi 2
Meonitoring

Note that you can click the J button multiple times if you wish - the structure is duplicated
multiple times.

mc256 MKIl Technical Manual V5.0/1 197



% Chapter 3: AdminHD
Signal List Configuration

Updating the Hardware Tree

This function forces the 'Signal List Editor' to re-analyse the Core configuration and update the signals
in the Hardware Tree.

You should use it if you have added components to the Core configuration, while the 'Signal List
Editor' has been open.

1. To perform the update, click on the E (Update hardware signal config) button from the
'Signal List Editor' toolbar.

The system analyses the Core configuration, and the Hardware Tree updates.
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Locating a Signal within the ‘Signal List Editor’

To quickly locate the hardware position of a signal:

1. Select the signal from the Directories & signals column.

2. Click on the @ (Locate signal) button from the 'Signal List Editor" toolbar.

The Hardware Tree opens to show the location of the signal:

Source ', Destination ',
Directories & signals Hardware Tree Selected signals
DrREIMEBEOLUMBOOFGMAC D W T -
-Bus Out [a] [E-MozPOLRAWAESS s
- Direct Out - MOZPOZRAWMADT G4
- Insert Send E-MO4POLDALED
[=+-Stagebaxd
L::_}--Stageboxl
M 2
3
I 4
o
M T
M & G--Card 2 [MIC]
Mg [h-Card 3 [MIC]
M 10 [#-Card 4 [MIC]
M1 [ Card 5§ [MIC]
M 12 [--Card 6 [MIC]
M 13 [#-Card 11 [LINE]
M 14 [ MO4POZDALEE
M 15 [ MO4POZDEP4
M 16 - MO4PO2DSPE
M 17 - MOBPOLRAWMADL_64
M 18 [+h-MOGPOZR.AMWIMADI_G64
M 19
Mz0
e 21
e 22
[#-Stagebox 2
L
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Generating a Signal List from the Core Configuration

This operation adds all the directories and signals from the Hardware Tree into the Directories &
signals column, and can be used to quickly generate a Signal List from your hardware components.

9 It is a good idea to add this structure below your "user" directories, so that service
technicians can easily locate signals using the Hardware Tree naming structure.

1. Click on @ (Generate automatic tree view from config) from the 'Signal List Editor'
toolbar.

All the directories and signals from the Hardware Tree are added to the bottom of the Directories
& signals column:

(e B

7~ Signal list editor *

Source\'l Destination \
Directories & signals Hardware Tree Selected signals
URHEEEO .- QUG @mEy ™| |- =
F-Bus Out [-Dallis 3RU

- Direct Out ---MOEPOZRAWMADde

sert Send ---MCIdDUlRAWAESS
ew dir_0001 [ MO4PO2RAWMADL 56

02P02RAWMADIL 64
- MO4POLRAWAES3
- MO4PO2RAWMADL 56

The structure uses the alias_names (if entered). Otherwise, default system names are used to
describe each component — for example, MO4PO1DAL60:

e MO4 - indicates the Nova73 Module (e.g. Module 4).
e POl -indicates the port on the Module (e.g. Port 1).
¢ DALGO - indicates the device on the port (e.g. a DALLIS Device with 60 audio

2. The button may be selected multiple times to repeat the structure.

9 For example, you might add the structure twice; leave the lower structure unchanged (for
your "service view"), and then edit the upper structure to provide more "user friendly"
directory and subdirectory names.
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Exporting the

Cold Start gui_config.tcl

To update the Signal List configuration on a mc? mixing console, you must export the 'Signal List
Editor' contents, as a gui_config.tcl file, in preparation for a cold start upload.

@ If you have also edited the Core configuration, then export and upload both cold start files
(config.tcl and gui_config.tcl).

1. Clickonthe

(Export to cold start config) button from the 'Signal List Editor' toolbar.

2. You are asked to specify a folder location for the file - in our example, we have chosen the
Studio 2 folder created earlier, see Organising Your Files.

KES
[#--5tagebox 1

[ = signal list editor - C:\Dok te und Einstell ‘kronent1'Desktop AdminHD_Configs',Studio 2\ signallist.sl ﬂ' E |

Source \Destination \

Directories & signals Hardware Tree Selected signals
LpEEMBo L. BEOOTONnG | | + =

[-Bus Cut [=F-MOZPOLDALED 009A02m 1

[-Direck Out ard 1 [MIC] 002402m2

[l Inssrt Send I 1C] O09A02m3

-8 — C 009A02m4

O09A02mS
O09A0ZmE
O09A02m7
O09A02m3

Card 16 [5UM] oo

~Card 18 [GPT] I

G Export signal list config as... LI

Save In: |EI Studio 2 '| @
=] corfig.td

[£] console_config.kl

File Mame:

Files of Type: |mc266 HD series signal lisk config File V|

Save Cancel

system.

/O Do NOT rename the file; it must be named gui_config.tcl in order to be read by the control

Preferen

@ You can specify a default directory for your Coldstart config files from the Extras ->

ces -> Common Directories menu.

3. Click Save.

The configuration is exported from the 'Signal List Editor' and saved on your computer.
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Uploading the Cold Start gui_config.tcl

Having exported the gui_config.tcl file, it may now be uploaded to the mc256 MKII control system.

This operation is similar to uploading the cold start config.tcl file, except this time upload the GUI
cold start config (gui_config.tcl):

I
m

I

Extras  Window 7 W, Select file for FTP upload

ﬁ Online to remote system
[ 7 Reconnect mode

o :

i R

W = +

LookIn: |23 Studio2

MREIRIE: - =

&l

W DSHS b
= Led [E] BACKUP_configitcl
2 ) Upload all data to remote HD =
Syste [El config.tel
= ﬂ Core cold start config (config.tcl) Ia | fiatcl
console_config.tc
BH €3 Download all data from remote HD -0 Console cold start config (console_config.tcl) 3 " o !
B gui_config.tcl
Download file » GUI cold start config (gui_config.tcl) -

i

‘s Reset system (cold send)

File Name: | gui_config.tcl

Files of Type: | Coldstart gui config files

Cone

Y

If you have edited both the Core and Signal list configurations, then you should export and
upload both cold start files (config.tcl and gui_config.tcl).

You will need to cold start the mc256 MKII to see your changes take affect.
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Online Operation
You should switch AdminHD online, in order to:
e Monitor the status of your remote system.

e Control matrix crosspoints, signal labels and /O settings via the 'Connect Manager'.

e Update the online configuration (in memory) - available for the Core configuration only.

Note that you will need a valid network connection between your computer and the mc256 MKII control
system.

» To switch between modes:

4

1. Clickon from the main toolbar (Online/Offline to remote system).

Or select Remote -> Online/Offline to remote system (from the main menus).

When switching online, AdminHD connects to and synchronises with the system. The IP address
of the connected host is displayed in the Status bar and the 'Core Browser' and 'Graphic_View
update:

G AdminHD - C:\Dokumente und Einstellungen'zuegerda'iDesktopiSue tech manualiconfig.csv *

iz Remote Extras  Window 7

PN OO0 B < TR MW D + =
[T core browser [=| card 11 [AES3] 2 B
NS =)

System

Eh-Core 1

Ei-Hodule 1 [MADT]

E-Port 1 MADT

E3-Dallis 3R (60 channels)
E}-Card 1 [MIC]

Device alias | |

Model Mumber | 94352

Typename 943/52 AES3 In (5RC) JOUE D-5ub

Signal In 1
Signal In 2
Signal In 3
Signal In 4
Signal In'S
----- Signal In &
----- Signal In 7

|
J
slot number 11 ]
|

Interface type [AES3

/7 |
=

e

Card 2 [LINE]

Signal In 4
Signal In 5
Signal In6
Signal In 7
Signal In 8
Signal Cut 1
Signal Out 2
Signal Ouk 3
----- Signal Out 4
----- Signal Ot 5
Signal Out &
Signal Out 7
----- Signal Out &

= 3
[ Card 12 [AES3)
BCard 13 [AES3)
B Card 14 [AES3)
[E
[

7 Card 16 [LINE]

- Card 18 [GPI]
Masterboard

=]

fedundant PSL
[-DSP Resources (4 channels)
Port 2 MADI

B -Modle 3 TMADTT

[ meaee ”ﬁOr\\ine(lQZ.lE-S‘lDZ.E-S)

If the connection fails, then the ‘Remote Log’ will report that the connection has timed out:

e Check the network connection and TCP/IP_settings of your computer's network interface
card.

e Check that AdminHD is compatible with the mc256 MKII system (the first three digits of the
software versions must match.)

e See also the trouble-shooting tips to resolve the problem.
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| ~
2. Click on the same button , to switch offline.

3. Select Remote -> Reconnect mode (from the main_menus), if you wish AdminHD to
reconnect to the remote control system if network communication is interrupted.

Eile - Extras  Window 7

l'j :‘__j Online to remote system
5 Reconnect mode

[Fl e
9 D5HS »
= (_) Upload all data to remote HD Crrl-
Systern
BE-Co Upload file ¥
@ Download all data from remote HD  Ctr-D

3

Hl«

Download file

;
Reset system (cold send)
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System Diagnostics

Once AdminHD is running online, you can use the 'Core_Browser' and 'Graphic_View' to monitor the
real-time status of hardware components:

(G AdminHD - C:\Dokumente und Einstellungen’zuegerd1\Desktop}Sue tech manualconfig.csv *

Fle  Remote Exbras indow 7

=M oo B < [CDEw o + &

[T core browser || card 11 [AES3] = E

=T hsr @ Data',
System
ECore 1 Device alias | |

Ef-Module 1 [MADIT]

(-Part 1 MADT

- Dallis 3RU (50 channels)
ECard 1 [MIC]
Signal In 1

Model Mumber | 94352

Typename [943/52 AES3 In {SRC) [Out D-5ub

slot number  [11

Signal In 2
Signal In 3
----- Signal In 4
----- Signal In'5

Interface type | AES3

Signal In 2
Signal In 3
Signal In 4
Signal In'S
Signal In6
Signal In 7
Signal In 8
Signal Cut 1
----- Signal Ouk 2
----- Signal Out 3
----- Signal Out 4
----- Signal Out 5
----- Signal Out &
----- Signal Ouk 7
----- Signal Out &

§-Card 12 [AES3)
i}-Card 13 [AES3] @ Remote log
- Card 14 [AES3)
- Card 16 [LINE]
- Card 18 [GPI]
Masterboard

=]
fedundant PSL
F-DSP Resources (4 channels)
~Port 2 MADT

F-Modle 3 TMADTT

All components are monitored, including the status of the Nova73, DALLIS units and their PSUs.

Components which are operating normally are coloured green; faulty components are highlighted in
red. In our example above, one of the DALLIS plug-in cards is missing or faulty. Check the card's
connections, and if necessary replace the card.

In addition, the 'Remote_Log' records all messages generated by AdminHD and the online system.
You can save the contents of the 'Remote Log' to help diagnose any errors.
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The System Message Log

The mesages logfile is generated and stored by the control system during operation. It can be
downloaded from remote system and saved on your computer using AdminHD.

Note that this is the one of the system_logfiles which can also be copied to USB, from the console
GU], using the File display, or monitored using the Web Browser Interface.

To download the logfile:

1. Select Remote -> Download file -> System log messages from the main menus:

File - Extras  Window 7

g Online to remote system

=

| # Reconnect mode

w D5HS ]

W

M=+ -
M — o

i

= O Upload all data to remote HD Cer-U
System
o Upload file 3

E‘ G Download all data from remote HDY  Cid-D

Download file Core cold start config (config.tcl)

Reset system (cold send) Systemn log messages

. E-Card 7 [AES3]
E-Carel 8 [SDI]
| E-Card 14 [LINE]

Console cold start config (console_config.tel)

GUI cold start config (gui_config.tcl)

A ‘Save As'’ file selection box appears.

2. Select a folder location and enter a filename:

& save core log message file as ...

Save In: |D Studio 2 v| @
File Mame: |system_log_message.txt |
Files of Type: |C0re log message files V|

@ You can specify a default directory for your Core logfiles from the Extras -> Preferences -
> Common Directories menu.

3. Click Save.
AdminHD downloads the file.

The log is stored as a plain text file, and can be opened by any common text editor.
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The ‘Connect Manager’

The ‘Connect Manager’ can be used to control matrix crosspoints, signal labels and /O settings
within your remote system. And save and recall snapshots - a snapshot stores connections to or
from a signal, the signal’s label and I/O parameter values.

] 4 Connect manager

o &

M+ =L E i R’
Lisk \Matrix | Snapshat |
Source directories Source signals Destination signals Destinztion directaries
Eh-@ MO1POIDALSD ) 001A01m1  AMAD1L.01 O 001AOLml AMAOLOL | (B0 MolPO1DALEO
=Y card 1 [LINE] @ 001A0ImZ  AMAD1L.0Z (o] 001A0ImZ  AMAOD1L,0Z NN -rd 1 [LINE]
(O Card 3 [LINE] = 001A01m3  AMADL.O3Z ] 0o1A0im3 AMADL.O3Z (O Card 3 [LINE]
O Card 5 [LINE] @ 001AOIm4 AMAO1.O4 o] 001AOLM4  ANAOL.O04 Card 5 [LINE]
O Card 7 [LINE] @ 001A01mS  AMADL.OS (@] 001A01mS  AMADL.OS Card 7 [LINE]
O Card 9 [LINE] = 001ADImG  ANAOL.06 (:,'l 001ADImG  ANAOL.06 cCard 2 [LINE]
Olaitng | |9 v sy |0 muow M || G e
O Card 13 [LINE] m : m : (D Card 13 [LIME]
& C) MO1POZDALSO [0 MOLPOZDALS0
F-- (O MO1PO3DALS0 [0 MO1PO3DALE0
B O MO1POIDSPY_1 [0 MOL1PO9DEP4_1
- () MO1PO9DSPE 3 () MOLPOIDSPE 3
Connected destinations \'\50““3 parameters ‘.l Connected source \Destination parameters \'l
Mame |Label |Superdevice |Device Mame |Label |Superdevice |Device

/(_j Note that online mode must be enabled, in order to open the ‘Connect Manager'.

The end-user operation is identical for both AdminHD and ControlHD. Therefore, please see the
separate “ControlHD User Manual” for full details on operation.

To determine which signals are "seen" by the 'Connect Manager', Control[HD opens a Signal_List
(signallist.six file). By creating different Signal Lists for different ControlHD clients, you can provide
users with access to different parts of the matrix.
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The Connect Manager Toolbar

# Connect manager

I'Q‘“' [ B fﬁ?E *‘% H

1 Open Opens a Signal List file (signallist.sIx) from your computer.

2 Export Exports a list of all matrix connections as a .csv file.

3 Update Updates the Source and Destination signals if you have made changes to
hardware the Core configuration while the 'Connect Manager" is open.
config

4 Connect Click to connect the selected source to the selected destination.

5 Disconnect Click to disconnect the selected destination.

6 Overwrite When enabled, you are asked to confirm each Connect and Disconnect
Lock operation.

7 Easy Step When enabled, the '‘Connect Manager' automatically steps down to the next
Mode source/destination after a Connect occurs. This is similar to Step mode on

the console GUI's Signal List display.

8 Special User When enabled, you can edit signal labels incrementally (e.g. Guest_01,
Label Edit Guest_02, Guest_03, etc.) This is similar to Easy Edit mode on the GUI's
Mode Signal List display.

9 Clear all Click to clear all the snapshot selection flags (blue flags).
snapshot
flags

Please see the separate “ControlHD User Manual” for full details on operation.
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Exporting a Connection List

You can export a list of all matrix connections from the 'Connect Manager' as a .csv file. This can be

opened by a 3rd party editor, such as MS Excel, to check which connections are made or document
the system.

To export the connection list:

1. Clickon = (Export connection list) from the ‘Connect Manager' toolbar.
Note that the button only becomes available once a connection made.

2. Select a folder location and enter a filename:

+ Connect manager :

B +=0F ¢ B

List \Matrix \‘ Snapshot \

Source directories Source signals Destination signals Destinztion directories

[+ @ MO1POLDALED | [@ 4 aFszs  AFs1401] [ O 4 aEses  aESL40L | [=.-G mmipninaian
------ O card 1 ) x|
@ Card 2 [LINE]
...... O Card 4 [LINE]  Speichern in: |&I Sue kech manual " @
------ @ Card 11 [AES3

...... O Card 12 [AES3 [E config.csv
------ O Card 13 [AES
. Card 14 [AEST
------ O Card 18 [GPI]
-0 MO1POLDSP4
[ @ MO3PO1DALSZ
B0 MO3POLDSPS

Connected destinations \\
HEITE % Dateiname: | Salylyl=eaiay) F =y

[AES3]
Dateityp: Connection list files

'|

3. Click Save.

The connection list is stored as a .csv file on your computer.
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Documenting the Configuration

AdminHD provides two tools to help document the system once you have programmed your
configuration:

e Copy Image / Write Image to File

e Export a Component List
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Documenting the Configuration

Copy Image / Write Image to File

You can save the graphical images used within AdminHD to help document your system - for
example, to save the front panel configuration of your Nova73 and DALLIS.

Saving the 'Graphic View'
1. Open the 'Graphic View' and hover your mouse over the frame of the Core or DALLIS.

The frame is outlined in orange.

2. Right-click and select one of the drop-down options:

. _ﬂ, Dallis 2RU [52 channels) - Dallis 3RU [Channels left IM: 36 f OUT: 3

Graphic frame G",& Gj:\m
copy image to clipboard @

write image to file

LAWO

e copyimage to clipboard - saves the graphic to your computer's clipboard.

e write image to file - saves to graphic as a .png image file. You are asked for a folder location
and filename.

Saving the 'Console Panel’

This is similar to above, but saves the image of the console front panel. Note that the 'Console_Panel
can only be used to configure MKI mc266 systems, and does not represent your control surface
configuration for the mc256 MKIL.
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Export a Component List

You can export a component parts list as a .csv file. This can be opened in a 3rd party editor, such as
MS Excel.

To export the list:

1. Select File -> Export file -> Component list from the main menus:

u Mew
[4 Open

Open recent
@ Close
[ File info
e NDANT]
ﬁ Save as hannels)

Core cold start config (config.tcl)

Component list

BFE controller (config.bfe)

---Card 3 BFE controller new foermat (config.bfe)
~Card 7 [A]
i E-Card14

Remote log

2. Select a folder location and enter a filename:

G save component list file as ... |Z|

Save In |D Studiol 'l @

B svstemlist.csv
[E] T¥Production_config.csv

File Mame: |systemlist.csv |

Files of Type: | Companent list Files vl

Save Cancel

3. Click Save.

The component list is stored as a .csv file on your computer.
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1%

Core Configuration: Parameters

This section covers all the Core configuration parameters for the mc256 MKII system.

Please see First Steps, Defining the System and Editing Parameters for the operating principles.

Component and signal parameters are covered according to their hierarchical order within the 'Core
Browser' System. For more details on functionality, please consult the relevant data sheet, available
in the "mc2_Nova73_documentation” guide.

In each case, you should open the 'Parameter_Box', for the component or signal, to access its

parameters:

'_Tf] Core browser

| =] signalIn 1

System
S-Corel
= Medule 2 [MADI]
EF-Port 1 MADI [REDUNDANT]

-
s

El-Dallis 3RU (52 channej
B Cagd

¥

+Signal In 3
“-Signal In 4
#-Card 3 [MIC]

#-Card 7 [AES3]
#--Card 14 [LINE]

#--Card 16 [LINE]

- Card 18 [MA]

- Masterboard

- Redundant masterboard
- PSU

-~Redundant P5U

[#-DSP Resources (4 channels)
[+-DSP Resources (8 channels)

-

[

#--Port 2 MADI

~Madule 4 [MADI]
~Madule 11 [DSP]
~-Madule 13 [D5P]

Madule 15 [DSP]

R

-
R

outer module
Su
edundant P5U

o
B

signal | DSP | Map |

HLSD [BoR

~|{008 4000 {000 |

Signal name | MICOL01

Signal label |MIC01.01

Group | MIC
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System
] system
Data\
D | |
System alias | |
ID Usually all Lawo projects receive a project ID, made up of 6 integers. You
can log your project ID here; you may be asked for it when servicing your
product. The field can be left blank.
System alias Enter an alias name for the System.
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Core

Parameters for the Core are divided into pages:

Core -> Connection

Core -> Data

Core -> System Settings

Core -> Map

Core -> Network

Core -> Plugin Server
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Core -> Connection

':l Core 1

Plugin ser\.rer\
Connection \Data \ System settings ‘I\Map \ External \\ Natwork\

RemoteIP enable

Remote IP address 10216810256 |

RemoteIP redundant enable ||

Remote IP address redundant 192158 10257 |

These parameters define the TCP/IP address of the mc256 MKII control system. See Editing_the IP
Address for details.
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Core -> Data

Core alias

Router module model
number

Router module type

Router module

Redundant router
module

Redundant PSU

Black burst
synchronised
switching

Internal sync activates

alarm

Enable sync port

Multi-channel sync
port

[=] core1

Plugin server\
Connection ~ Data \ Systern settings \ Map\ External \ Network\

Core alias |r"r1cz Studio 1 |

Router module model number |9\80.‘32 |

Router module type | HD Core 8k (48 kHz) |

Router module

Ll

Redundant router module

<]

Redundant PSU

Black burst synchronised switching
Internal sync activates alarm

Enable sync port

] O OO

Multi-channel sync port

Enter an alias name for the Core.

These fields are for information purposes only and cannot be edited. They
show the serial number and type of Router Module. The type of Router
Module is defined when you add a Core to the System (in the 'Core
Browser").

This box should always remain ticked, as every Core requires at least
one Router Module.

Tick this box to add a redundant Router Module to the Nova73.

Tick this box to add a redundant PSU to the Nova73.

Tick this box to make matrix cross point switching synchronous to an
external Black Burst sync source.

Tick this box to activate the Global Alarm if the system switches to internal
sync.

Tick this box to enable the multi-channel sync port. A pop-up appears
asking you to select the sync source, see Multi-channel Sync.

This box displays the multi-channel sync port source as a system
address (if Enable sync port is active).
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Core -> System Settings

...... | Core 1

Plugin server\

Connection \Data ! Systern settings \ Map\ External \ Network\
Analog full-scale level [dBu] |15 -
Reference level [dBu] | EI%
Headroom [dE] ] |
Sampling frequency [kHz] |48 v|
Disable global alarm

Analog full-scale level This option sets the analogue level which corresponds to digital full scale

(dBU) level (OdBFS). You can select 12, 15, 18, 21 or 24 dBu.

Reference Level This field sets the internal reference level of the system. The maximum
(dBU) reference level is 24dBu.

Headroom (dB) The resultant headroom is calculated from the first two options. See

Operating Levels for details.

Sampling Frequency  This parameter sets the internal sampling frequency which the system
resets to after a cold start. See Internal Sampling Rate for details.

Disable Global Alarm  Tick this box is you wish to disable the Global Alarm.
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Core ->Map
El Corel

Plugin ser\rer\

Connection \ Data \ Systemn settings ' Map \ External \ Network\

Mapping table 01 unknown signal address I:I
Mapping table 01 no signal address I:I

Mapping table 02 unknown signal address I:I
Mapping table 02 no signal address I:I

Mapping table 03 unknown signal address I:I
Mapping table 03 no signal address I:I

Mapping table 04 unknown signal address I:I
Mapping table 04 no signal address I:I

Mapping table 05 unknown signal address I:I
Mapping table 05 no signal address I:I

-

-

These parameters are used if you wish to control matrix crosspoints from an external device. See

Mapping Tables for details.
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Core -> External

[=] core1

Plugin server\
Connection \Data \ System settings \Map " External \ Metwork \

Path NoMount |

User | |

Pazzword | |

These parameters are used to connect an external file server to the system. Once configured, the
server is available to users via the console GUI's File Import/Export page.
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Core -> Network

.!:ll::nrel
Plugin serl.rer\
Connection \Data \ Systemn settings \Map \l\ External ' Network\
HLSD index | 1=
HLSD index This parameter is used if your Core is part of a larger network, see

Networking /O Resources.
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Core -> Plugin Server

D Corel

Plugin server\
Connection \ Data \\ Systern settings \Map\ External \\ MNetwork \\

IP Address Plugin-Server |ilpRlaiR (iRl T |

IP Address Plug-in  Enter the IP Address of the optional Plugin Server.
Server The default address is shown above.
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Modules

Parameters for a Module depend on the module type:

I/O, & Channel DSP Module Parameters

Matrix DSP Module Parameters

[ Module 2
Data\
Module alias
Slot number |2

Module model number |9\81,’31

Module type [981/31 MADI 2 MMF

Module alias

Data \

Medule alias |

Slot number |15

Medule model number |983f03_ﬂﬂ?

Module type |983f03—ﬂﬂ? mxDSP

Config-ID ||Ur|iversa|

|

Enter an alias name for the Module.

Slot number These fields are for information purposes only and cannot be edited. They

Module model show the Slot number used in the Core, and the serial number and type of

number module, see Nova73 Module Options.

Module type

Config-ID On the 983/03_007 mxDSP module, this parameter defines how the matrix
DSP is configured. See mxDSP configuration for details.

Backplane On the 981/02 AES3 module, this parameter defines the rear connector

Hardware panel (either D-Sub or BNC).
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Ports

Parameters for a Port depend on the port type:

MADI, ATM & RAVENNA Port Parameters AES Port Parameters
[ Port 1 MADI " Port1AES3
Data \L Data \
Port Murnber |9 | Port Mumber |41 |
Interface type | MADI | Interface type | AES3 |
Is redundant

Corresponding port |1:1:4:2:U:U:U

Port Number These fields are for information purposes only and cannot be edited. They
Interface type show the logical port number, which is dependent on the module's slot
position in the Core, and the interface type (MADI, RAVENNA, etc.)

Is redundant Tick this box to enable port redundancy. You will be prompted to select the
redundant port.

Corresponding port Shows the system address of the linked port, if Is redundant is enabled.
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Super-Device

Super-Device is the generic term used to describe the /O port's definition: DALLIS, Tie-Line, etc.

Tie-Line, Plugin Server and Local I/O all display similar parameters; DALLIS frames display some

additional options.

Tie-Line, Plugin Se

=] Tie-Line (64 channels) &

rver & Local I/O Parameters DALLIS Parameters

g B[] Dallis 3RU (52 channels)

Data \

Super-device alias |

Super-device alias

Model number &
Type

Redundant PSU

Audio channels IN
left

Audio channels
OUT left

Data \
| Super-device alias |Stagebnx.ﬂl |
Type [ Tie-Line (54 channels) | Model number 047/05 |
Type | Dalli= 3RU (52 channels) |
Redundant PSU

Audio channelsIN left |36 |

Audio channels OUT left |36 |

Enter an alias name for the DALLIS,Tie-Line, Plugin Server, etc.

These fields are for information purposes only and cannot be edited. They
describe the serial number (of a DALLIS frame) and the type of Super-
device.

Tick this box to add a redundant PSU to the DALLIS frame.

These two boxes cannot be edited and show the number of ‘free' audio
channels left in the DALLIS frame. These are channels which could be used
by fitting additional plug-in cards.)

mc256 MKIl Technic

al Manual V5.0/1 225



oo

Chapter 3: AdminHD
Core Configuration: Parameters

Cards

Parameters for the DALLIS Cards depend on the card type. Below are two examples. See also SDI

Parameters.

941/53 Mic Card Parameters 924/02 Line Card Parameters
| Card 5[MIC] ' card 2 [LINE]
Data \ Data \
Todrelfes | | Device alias | |
Model number | 941{53 | Maodel Mumber |g42,|I|:|2 |
P [041/53 Mic/Line In D-Sub | Typename [942/02 Line Out krafo 15d6u D-Sub |
Slot number |5 | Slot numnber [2 |
Interface bype  [LINE |

Interface type | MIC |

Device alias

Model number
Typename
Slot number
Interface type

Monitoring device

Manitoring device [

Enter an alias name for the card.

These fields are for information purposes only and cannot be edited. They
show the serial number and type of card, the slot position within the DALLIS
frame, and the interface type.

For 942/02 and 942/12 cards only.

Tick this box to release the card from the system reference level, if the card
is to be used for monitoring.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation” guide.
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Core Configuration: Parameters

Signals
Parameters for Signals are divided into pages:

¢ Signal In -> Signal

¢ Signal Out -> Signal

¢ Signal In/Out -> DSP

¢ Signal In/Out -> Map
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Signal In -> Signal

Signal In parameters depend on the type of signal (Mic, Line, AES, SDI, etc.). Below are two
examples. See also SDI Parameters.

Mic Signal In Parameters AES Signal In Parameters (with SRC)

I Signalin1 I signalln1
Signal\DSP\Map\ Signal\DSP\Map\
HLSD BOR ~ 2008 000 000 | HLSD BOR ~ 2008 048 2000 |
Signal name | MIC01.01 | Signal name | AES07.01 |
Signal label | MIC01.01 | Signal label | AES07.01 |
Group MIC | Group |AES |

SRC
HLSD High Level Signal Definition - this is the Lawo system address for the

signal. it MUST be unique, and normally you should not modify this address
from its default setting.

Signal name This is the system name of the signal. It can only be defined by AdminHD,
and should be used to provide a "fixed" signal name relevant to the
installation.

Signal label This is the user label which the system resets to after a cold start. Users can

change labels later, from the console GUI's Signal List display, or from
AdminHD's 'Connect Manager'.

Group This is the group name for the signal. It can be used when interfacing to an
external controller. Please refer to your external system’s documentation for
details on how to implement the group name.

SRC For AES cards with SRC only.

Tick this box to enable the sample rate converter. Users can change this
parameter later, from the console GUI's Signal Settings display.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation” guide.

/(_) To make a digital path suitable for Dolby E operation, you should turn off the /O DSP for
both the input and output, and disable any sample rate conversion.
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Signal Out -> Signal

Signal Out parameters depend on the type of signal (Line, AES, SDI, etc.). Below are two examples.
See also SDI Parameters.

Line Signal Out Parameters AES Signal Out Parameters (with SRC)
5] Signal Out1 [ Signal Out 1
Signal | DSP | Map ', Signal | DSP ' Map |
HLSD B80S ~|:008 104 000 | HLSD lpos___ ~Jioos  |d000 Jiooo |
Signal name |009A14m1 | Signal name 0100011 |
Signal label | ANAL4.01 | Signal label | AESD1.01 |
Group B00S02P1 | Group B00502P2 |
Sampling frequency [Khz] | System |
Word length [bit] 24 ~|
SRC l
AES consumer format | Professional ~|
HLSD See Signal In: HLSD.
Signal name See Signal In: Name.
Signal label See Signal In: Label.
Group See Signal In: Group.
Sampling frequency For AES cards with SRC only.
Word length Sets the sample rate and word length for the output.
SRC Note that the SRC field cannot be edited and shows the status of the sample

rate converter. To disable the SRC, you must set the Sampling frequency
to System and Word length to 24-bit. For all other combinations, SRC is
always enabled.

Users can change these parameters later, from the console GUI's Signal
Settings display.

AES consumer For AES cards released after 2006.

format Sets the channel status of the AES output to either Consumer or
Professional. Please refer to the AES3 standard definition for details.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2 Nova73 documentation” guide.

To make a digital path suitable for Dolby E operation, you should turn off the /O DSP for
both the input and output, and disable any sample rate conversion.
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Signal In/Out -> DSP

These parameters adjust the /O DSP and Silence Detect alarms. Note that not all cards support
these parameters.

Signal In -> DSP Parameters Signal Out -> DSP Parameters

=] Signal Out 1

I SignalIn1
Signal * DSP | Map | Signal ' DSP | Map |
1/0-DSP /0-DSP i
Offset [dB] | 0.00 = Offset [dB]
Digital gain [dB] | 0.0/~ Digital gain [dB]

Mono matrix
Stereo link for silence detect [
Mono matrix mode

Silence detect O
Threshold [dBFS] | -60.00}% Mono attenuation left channel [dB]
Attack time [sec] | 15 Stereo link for silence detect O
i | 15 Silence detect O
Threshold [dBES] | -60.00
Atack time [sec] | 15—
Release time [sec] | 15=
Signal In: I/O DSP
I/O-DSP Tick this box to enable the I/O DSP. Once enabled, the following parameters
become active:
Offset (dB) Enter an offset and/or digital gain value in dB. The resultant gain (Offset +

Digital gain (dB) Digital gain) is applied to the signal within the /O card, and therefore affects
all destinations.

The two separate parameters (Offset and Digital gain) allow you to apply a
‘permanent’ and a ‘temporary’ gain change. For example, to compensate for
a low level line input, use the Offset parameter to apply a ‘permanent’ gain
change. In addition, for today’s production you may also need to compensate
for a badly recorded signal; for this ‘temporary’ adjustment, use the Digital
gain. At the end of the production, you can easily reset the Digital gain to O
dB while keeping the Offset gain intact.
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Signal Out: /0O DSP

Mono matrix Tick this box to enable the mono matrix settings and link the output signal to
its odd/even partner.

When the mono matrix is enabled, you can then adjust the following
parameters:
Mono matrix mode The mode can be set to:

e Channel mix —sums the left and right inputs and routes the mono sum
to both left and right outputs.

e Channel swap — routes the left input to the right output and vice versa.
e |eft to both — routes the left input to both outputs.
¢ Right to both — routes the right input to both outputs.

Mono attenuation When working in Channel mix mode, you can set attenuation (e.g. -3dB) to
left channel (dB) compensate for the mono sum. This is applied to the left output signal.

/Lj To make a digital path suitable for Dolby E operation, you should turn off the /O DSP for
both the input and output, and disable any sample rate conversion.

Silence Detect Alarm

These parameters can be applied to inputs and/or outputs, to trigger an alarm state if signals fall
below a certain threshold level. The silence detect alarms can be output to an external control
system, via Lawo’s Remote MNOPL protocol, or monitoring using the Web Browser Interface.

Silence detect Tick this box to enable the Silence Detect alarm for the signal.
Stereo link for Tick this box to link the left and right sides of a stereo input or output for
Silence Detect 'Silence Detection'. When linked, the alarm is only issued if both signals fall

below the Threshold level.
Only odd and even adjacent signals may be linked.

Threshold (dBFS)  Set the threshold below which the Silence Detect alarm will be triggered.
The level can be adjusted in 0.25dB steps and is referenced to digital full
scale level (dBFS).

Attack Time (sec) This sets the length of time for which the signal must fall below the
Threshold level before the Silence Detect alarm is activated. The time is
set in steps of 1 second.

Release Time (sec) This sets the length of time for which the signal must remain below the
Threshold level before the Silence Detect alarm is cancelled. The time is
set in steps of 1 second.
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Signal In/Out -> Map

[=] Signal In 1

Signal ', DSP ' Map |,

Mapping table 01 address
Mapping table 02 address
Mapping table 03 address
Mapping table 04 address
Mapping table 05 address
Mapping table 06 address
Mapping table 07 address
Mapping table 08 address
Mapping table 09 address
Mapping table 10 address
Mapping table 11 address
Mapping table 12 address

Mapping table 13 address

-

These parameters set the signal's address for each of the mapping tables 1 to 16. You should use
these parameters to map a signal to an external controller, see Mapping Tables.
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mxDSP Configuration

This section covers additional notes for the mxDSP module (983/03-007).

An mxDSP module provides a pool of DSP resource which may be applied to signal paths within the
routing matrix. For example, to apply fixed DSP settings to line arrays.

Physically, each mxDSP module is identical to a normal channel DSP board and occupies one slot
within the Nova73. However, rather than DSP channels, which can be assigned to the console
surface, the mxDSP provides DSP “chains” which can be viewed and controlled from the mxDSP

Settings display.

Several configuration options are supported, providing up to 192 DSP chains plus a 64 x 64 mixing
matrix per module. The DSP chains are configured from various elements including level, mute,
delay, EQ, etc. The number of DSP chains, and their signal flow, is determined by the AdminHD
configuration:

Miscellaneous
DSP variations

(Operation mode

~otandby® provides

n+m redundancy)

IR

ralrirals ar aa

mxDSP board
To configure a 983/03 DSP board for mxDSP operation, the following steps are required:
1. Edit the Core configuration using AdminHD.
2. Edit the Signal List configuration using AdminHD.
3. Update the cold start configuration (config.tcl and gui_config.tcl) using AdminHD.
4

Update the firmware on the mxDSP module via a Telnet session.
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Editing the Core Configuration

1. Download the online Core configuration to make sure that you are editing the latest
configuration data.

2. Select the slot and change the module type to 983/03-007 mxDSP:

Slot 15

| ; ] ] f—
|

981/02 AES3 SRC + MADI Port

| 981/31 MADI 2 MMF
2 (¢ | — 981/32 MADI 2:2 MMF
E E E B 981/36 MADI 6x2 MMF
981/38 MADIS MMF
981/41 MADI2 SMF
981/53 ATM 3 MMF

= = = = . . Zl 981/56 ATM 6:x2 MMF
983/02 DSP 24

983/03 DSP 48/24

i wnomy |
983/03-060 DSP WFS (mix)

0983/03-061 DSP WFS (filter)

983/03-062 DSP spatial mixer

981/61 Ravenna Link 4:128ch

981/61 Ravenna Link 2x256/2x128ch
981/61 Ravenna Link 2x128ch + 1x256ch

3. Open the module's ‘Parameters Box’ and select an option from the Config-ID menu:

Roelowboli, ... . -8

] Module 15 S ¢ 5
Data\
- . -
Module alias | |
o=
r 5 i — Slot number 15
| ! I | N [ ]
i e Matrix DSP card | Module model number [983/03_007 |
| Module type [983/03-007 mxDSP |
- 7| 7| 7| = -
E‘ E E W Config-ID Universal E
e

These options determine the number, and signal flow, of the DSP chains, see Config-ID Options.
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Config-ID Options

The Config-ID defines the signal flow of the DSP chains, and whether the card supports the 64 x 64
mixing matrix:

Miscellaneous
DSP variations

(Operation mode

,otandby® provides

n+m redundancy)

I

mxDSP board

» Standby

Select this option to run the mxDSP module in standby mode. Use this mode to configure a
redundant mxDSP module.

> Playout (no PPM)

This option provides 184 channels of DSP only (no mixing matrix):

Provided in
“Playout”

(only 48 kHz)
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» Universal

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:

Provided in
R
(only 48 kHz)

[ S0° -3umme s [ I F
L ger - » L »

> Universal (no PPM)

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:

Provided in
“Universal , ,ﬁ @ .I ,
(no ppm)”

(only 48 kHz)

Hl - @ i
48 x r—r. [
8x b—b.

. [ . S0° -summs [
L =

No PPM
= lower system
requirements

T —
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> Line Control

This option provides 184 channels of DSP plus the 64 x 64 mixing matrix:

Provided in
“LineControl”

(only 48 kHz)

» Line Control (no PPM)

This option provides 184 channels of DSP, as above, but with less system resources, similar to
Universal (no PPM).
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Editing the Signal List

In order for the DSP chains to appear within the console GUI's Signal List display, the mxDSP
module must be added to the Signal List configuration (gui_config.tcl).

Having added the mxDSP module to the AdminHD configuration:

1. Download the existing Signal List to make sure that you are editing the latest configuration

data.

2. Click on the Update hardware signal config button.

The mxDSP signals from the newly configured card are added to the existing Signal List:

o Signal list editor *

Source\'l Destination \
Directories & signals

=N =N =)

Hardware Tree

Selected signals

ugin Server
EH-New dir 0001
“New subdir_0001

[#-Bus Qut .
"'Direct Out
: sert Send
4 Local /'O

[#--Stagebox A
B MO4POZRAWMADL 64
Fh-MOBPOLRAWAES2

3. You can organise the signals, and name and label them, in the usual manner See Editing a

Signal List.
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Updating the Cold Start Configuration

1. Export and upload both of the cold start configuration files (config.tcl and gui_config.tcl), in
the usual manner.

2. Cold start the mc256 MKII control system so that the new configuration data is active.

You can check the configuration by opening the console GUI's mxDSP Settings and Signal List
displays.
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Updating the Firmware
Before the mxDSP module will operate correctly, its software must be updated:

1. Using a computer connected to the Lawo system network, open a telnet session to the mc256
MKII control system.

2. At the main control system prompt, type mcxsh and press Enter.
This opens the mcx shell programme.
3. Then type the command mcx_software_auto_update and press Enter.

The software on each card is automatically updated according to the Core configuration:
| Nreinet 19216822291 =81 x]

b login: voot
Password:

Welcome to

4-18-B-(A)-aschevolke <(build Jun 7 2818 16:22:

6 in HD C

in path .~
ard 983_83 i

f most recent software versi for 3_83
current software version for Nova?3 I-0 card 98

in path ~

version for 983_83 in path Aus

The mxDSP module is now ready for operation.
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The 'Console Panel

The 'Console Panel' can be used to edit the control surface layout for a MKI mc266 system (classic or
topl), and export a cold start Console Configuration (console_config.tcl) file.

/(_') For all other mc? systems, the console_config.tcl must be factory-configured. Please
contact your local Lawo representative or email service@lawo.com if you require further
assistance to modify its configuration. In these systems, do NOT attempt to use the
'‘Console Panel' to generate a new.tcl file, as the control system cannot read the data.

The console_config.tcl file is not required for a stand-alone Nova73.

@ You can use AdminHD to upload a console_config.tcl file on any mc? system. This could
be a file emailed to you from Lawo service.
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Editing the Control Surface Configuration (MKI mc266)

1. Clickon 'ﬂ from the main toolbar to show the ‘Console Panel'.

Or select Window -> Console frame (from the main_menus) or press CTRL + SHIFT + O (on
your computer keyboard).

An image of the MKI mc266 control surface configuration appears:

ﬂﬂ mc266 HD control panel configurator

Select console frame size:  |[Z4+5+24

G+8+3

i | l i l i 16+8+8 i
e .l R 164516
= 24+8+16
RalhEnE kA :

i iiiH HEE

2. Select the console frame size from the drop-down menu (e.g. 24+8+24).
The window updates accordingly.

3. [If your console frame is larger than the fader panels fitted, then right-click on the fader panel
you wish to remove and deselect the Assign fader panel to slot option.

The display updates to showthe blank fader panel.

4. You can save changes to the ‘Console Panel’ configuration by selecting File -> Save or File -
> Save As from the main menus.

The ‘Console Panel' configuration is stored with the rest of the Core configuration within the
config.csv file.

5.  Now export the configuration, by clicking on the Export config button at the top right of the
‘Console Panel’ window:

il mc266 HD control panel configurator

Select console frame size:  |24+8+24 =

/
[Export control panel config
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6. Select a folder location and click Save:

. 1l mc=66 HD control panel configurato

Select console frame size:  [2446+24 =

..... .
VRE]

=] config.kel

File Mame: |conso|e_config.tcl |

Files of Type: |COIdstart console config Files v|

Save Cancel

/O Do NOT rename the file; it must be named console_onfig.tcl in order to be read by the
control system.
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Uploading the Cold Start console_config.tcl

This operation is similar to uploading the cold start config.tcl file, except this time upload the
Console cold start config (console_config.tcl):

@ £ Online to remote system
=== |—,3 Reconnect mode

% DSHS »
O Uplead all data to remote HD

Lookln: |C3 Studio 2 P REI

[E] BACKUP_canfig.tcl

Core cold stait cenfig (config.tcl)

0 Download all data from remote HD  Cwi-D Console cold start config (console_config.tcl)

Download file 3 GUI cold start config (gui_config.tcl)

{'L Reset system (celd send)

File Name: | console_config.tel |

Files of Type: | Coldstart console config files 'J

You will need to cold start the mc256 MKII to see your changes take affect.
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Chapter 4. Service/Maintenance

Introduction

This chapter covers service and maintenance, including software diagnostics and hardware

procedures.

@ See also trouble-shooting for a list of example problems and fault-finding tips.
For further assistance, contact your local Lawo representative or the service department

at service@lawo.com.

Topics covered in this chapter are:

e Software Versions

e System Shutdown and Restart

e Restarting a Bay Server

e System Logfiles

e GUI Diagnostics

e AdminHD/ControlHD Diagnostics

* Web Browser Interface

e Telnet Sessions

e File Transfer via FTP

e Nova’/3

e DALLIS Unit(s)

e RAVENNA Interfaces

e Control Surface
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Software Versions

Software Versions

Compatibility

From version 4.0.2.2 onwards, all Lawo products have adopted a consistent software release
numbering system to indicate compatibility. This affects system networking, mxGUI and AdminHD. In
each case, the first three digits of the software version must match.

Checking the Software Version

You can check the software version of your mc? system from the Global Options in the System
Settings display.

Upgrading Software

Please register at www.lawo.com (click on Login) and go to the Download-Center to download
software and documentation for your product.

Information about each software release can be found in the "Release _Notes X.xx".

Instructions on how to perform each upgrade are included with the first software release candidate
("Product_systemupdate VX-xx-x-X"). To perform a system update, you will need a computer
connected to the Lawo system network, and installed with suitable FTP and Telnet clients.
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System Shutdown and Restart

Shutdown

The console should be shut down by powering off the control surface (mains connections at rear) and
Nova73 (mains connections at front).

Note that the control system is located on the Router Module (MKII) within the Nova73. Therefore, it is
here where your user data is stored.

Following switch-off, power is provided to the control system for a further 18 seconds. During this
time, all current settings are saved to flash memory; this is known as the warm start data. You will
hear several tones signalling that the shut down operation has been successfully completed. The
system is shut down when the blue LED of the trackball is off.

You may switch off the power to other system components (e.g. DALLIS units) at any time.

Starting the System (Warm Start)

To start the system, turn on the power to the control surface (mains connections at rear) and Nova73
(mains connections at front). The components may be powered in any order, but note that the control
system resides within the Nova73. Therefore, the system boots when you turn on power to the
Nova73.

You may switch on the power to other system components (e.g. DALLIS units) at any time.

The control system boots in a few seconds; during this time the Central GUI reports back on the boot-
up progress.

By default, the warm_start data is loaded at the end of boot-up. This means that the system comes
back exactly as it was when you last shut down, ensuring fast recovery of all previous settings
following a loss of power.

Depending on who was last using the console, you may be sat in front of a fully configured control
surface with DSP settings or a series of blank fader strips! In either case, the fastest way to reset the
console is to load a production.

@ The control surface and Nova73 may be booted before DALLIS units. This enables you to
prepare settings, including signal routing, before remote DALLIS stageboxes are connected
or have received power.

Starting the System (Cold Start)

Alternatively, the system may be set to cold start, following the next reboot, using the Prepare
Coldstart option in the System Settings display. Or, the Prepare Coldstart button on the front of the
Router Module (MKII).

Select the Prepare Coldstart option, and then force a restart by powering off, and then on, the
Nova73.

A cold start boots without loading any warm start data. You should perform a cold start only if there is
a problem with the warm start data, or if you wish to clear all warm start data from the system.

@ The best way to reset the console for a new job or show is to load a production. (A cold
start resets the system back to its cold start data and factory default settings.)
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Warm Start & Cold Start Data

Warm Start Data

The following settings are stored in the warm start data, and are recalled following a warm start:

Matrix crosspoints.

The DSP configuration.

The console’s complete settings (control surface layout, etc.)
All DSP parameters (EQ, Dynamics, etc.).

All VO parameters (Mic preamp gain, SRC on/off, etc.)

Any Core configuration settings changed by an online AdminHD computer.

Cold Start Data

Following a cold start:

All matrix connections are cleared, unless protected by a factory configuration (.tcl) file.

The default DSP configuration is loaded. This can be defined from the Custom Functions
display.

The control surface will appear blank (no fader strip assignments).
All DSP parameters are set to factory default values.
All /O parameters are set to factory default values

All configuration files return to their cold start defaults (config.tcl, gui_config.tcl, etc.)

248

V5.0/1 mc256 MKIl Technical Manual



Chapter 4: Service/Maintenance %

Restarting a Bay Server

Restarting a Bay Server

Each TFT display on the mc256 MKII has its own Ethernet_ Bay Server which can be restarted from
the front panel. You should perform this procedure, rather than a system restart, if:

¢ the graphics on an individual display freeze or look odd.
¢ the controls on a panel are not responding; indicators not updating.

These symptoms can sometimes occur if a Bay Server looses its Ethernet connection to the control
system.

1. Using a pointed object, press the recessed button on the top of the display:

The Bay Server restarts.

Once the restart is complete, communication with the control system is re-established, and the
selected display reinstated.
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System Logfiles

During operation, the system generates and stores logfiles on the control system. This allows you to
export the files to assist Lawo service with fault-finding.

There are 4 principle logfiles:

alarm.log - global alarm errors (the last 5000).

alarm.log.old - archived global alarm errors (the previous alarm.log file).

* messages - messaging errors generated by the control system (the last 5000).

¢ messages.old - archived messaging errors (the previous messages file).

Logfiles can be copied to USB, from the console GUI, using the File display, see the "mc256
Operators Manual'":
Production Files
Name | Date (m/d/y)

[~ Productions

[~ system logfiles

B alarm.log o /10 06:41:32
i [ ] alarm.log.0 106/02/10 15:04:25

- | ] messages.0 Log  06/08/10 05:25:54] 4

Alternatively, you may monitor the contents of a log file, remotely from your computer, using the Web
Browser Interface.

» Timestamping a logfile
From V4.24 software onwards, two enhancements have been made:

e Timestamping - click on the LAWO logo, from the Central GUI's title bar, to create a time
stamp in the messages file. This marks the logfile at a moment in time, and can assist Lawo's
service department when diagnosing system behaviour.

e DSP change - whenever the DSP configuration changes (by loading a production, changing
the DSP configuration or switching to a redundant DSP card), information about every DSP
card is printed in the alarm.log. The information is formatted as follows:

New DSP card role for {HDCore 0, Slot 14}: active (role index 1)
New DSP card role for {HDCore 0, Slot 12}: active (role index 2)

New DSP card role for {HDCore 0, Slot 10}: active (role index 3)
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» Reading a logfile

From V5.0 software onwards, each line within the messages file is formatted in three sections:
<Sof tware Mdul e> <Error Type> <Detail s>
The <Error Type> indicates the severity of the error as follows:

e DEBUG - information for developers, not usually seen once a release is issued.
¢ INFO - general information, not a real error.

¢ WARNING - an error with low impact.

e ERROR - an error with moderate impact.

e FATAL - a serious error which may lead to system crashes.

By searching the messages file for the appropriate text - e.g. FATAL - you can quickly identify the
relevant information.
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GUI Diagnostics

The console's Central GUI, or an mxGUI computer running online, provides the following system
diagnostics:

Nova73/DALLIS Status

If a Nova73 or DALLIS component fails, or a connection is lost, then a hazard warning flag appears in
the title bar of the console GUI. Use the Signal Settings display to interrogate the source of the
problem. This display monitors all the Nova73 and DALLIS components which are defined in the Core

configuration.

Control Surface Connection

If a redundant Router Module and Ethernet connection to the control surface are installed, then the
operator is presented with an error message should the active connection fail. They may then decide
to force a takeover or investigate the cause of the problem.

Control Surface Power

On the right of status bar, the console GUI offers status monitoring for all power supplies. You will see
a red circle with an exclamation mark if a supply has failed.

Redundant Control System Takeover

If a redundant Router Module (MKII) is fitted to the Nova73, then you may force a manual takeover to
the redundant control system, either from the System Settings display or by pressing the recessed
button on the front of the Router Module.

Prepare Cold Start

The system may be set to cold start, following the next reboot, using the Prepare Coldstart option in
the System Settings display.

Bulb Test, Fader Calibrate, OLED Saver Enable

These options, in the System Settings display, can be used to test the control surface illumination,
calibrate the faders or enable the OLED display saver (recommended to prolong their lifespan). See
the "mc256 Operators Manual" for details.
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AdminHD/ControlHD Diagnostics

An AdminHD, or ControlHD computer, running online provides the following system diagnostics:

Nova73/DALLIS Status Monitoring

Once AdminHD is running online, you can use the 'Core Browser' and 'Graphic_View' to monitor the
real-time status of hardware components.

In addition, the 'Remote Log' records all messages generated by AdminHD and the online system.
You can save the contents of the 'Remote Log' to help diagnose any errors.

& AdminHD - C:\Dokumente und Einstellungen'zuegerd1\Desktop}Sue tech manualiconfig.csv *

iz Remote Extras  Window 7

=M o0 B < CDEw o + =

LTl core browser [~ card 11 [AES3] 2~ E

== nEe Data |
System
E-Cors 1 Device alias | |

Ei-Hodule 1 [MADT]

E-Port 1 MADT

E3-Dallis 3R (60 channels)
E}-Card 1 [MIC]
signal In 1

Model Mumber | 94352

Typename 943/52 AES3 In (5RC) JOUE D-5ub

slot number 11

Signal In 2
Signal In 3
Signal In 4
Signal In'S
----- Signal In &
----- Signal In 7
----- Signal In 8
LI

Interface type [AES3

/7 |
=

s

----- signal In 2
----- signal In 3
signal In 4

Signal In 5
Signal In6
Signal In 7
Signal In 8
Signal Cut 1
Signal Out 2
Signal Ouk 3
----- Signal Out 4
----- Signal Ot 5
----- Signal Out &

- 53
[ Card 12 [AES3)
BCard 13 [AES3)
[
[E
[

7 Card 14 [AES3]

7 Card 16 [LINE]

- Card 18 [GPI]
Masterboard

=]

fedundant PSL
[-DSP Resources (4 channels)
Port 2 MADI

B -Modle 3 TMADTT

Hﬁ Oriine (192,168, 102.65)
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Web Browser Interface

The control system includes an integrated web server. This allows status information to be monitored
from a remote computer, via any normal web browser:

1. Connect your computer to the Lawo system network.

2. Configure the TCP/IP settings on your computer's network interface card.

3. Open your browser software, and enter the IP address of the mc256 MKII control system into
the URL field.

You can check the IP address of your control system from the console GUI (using the Signal
Settings display). See also TCP/IP_Addresses for a list of the default IP addresses for different
Lawo products.

For example, to connect to a mc?56 with a default IP address, you would type
"http://192.168.102.56" and press Enter.

The System Overview page opens within the browser:

HD Core System Information

Surz reresh: Soard

Frmem petpony System ovarview
R ENTLTT]
A0 ednes Conirsd ggeinm Hedpngarecy rode Hedimancy 3l Hapundnay parfasr
FANEH A 1l irlemzl peirvary Aitine
Svmem alam
Dewre zaalshliy + Emouct emar G-0H1-0_TCI0S
3 o e €] 01
P T 4 oniml svsiem vereion: 42500
[I5P vean: Metwork configuration
Syrzem g lze Copfguration of primary contral sysiem
17 aklieas 10312388
Flzhiste mzzk 2IG2IG2400
Lielanil gelesses 107012 10
Lomhgunmlae of ssiammlen g conliol sy lan
17 add oo 10.3.12337
Hebaani ez AabehMnn
Dzfoulgaizecy 103425104
Ceensisl cn T 4 Jan 2204 2207 41 CRT
b L= L e ne 125 12382

If the page does not open, then see the trouble-shooting tips.

4. To automatically refresh any page turn on the Auto Refresh option at the top right of the
screen.

5. Use the navigation buttons on the left to access the other page options.
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System Overview

The main System Overview provides information on system software versions and the network
configuration:

HD Core System Information

Sz reresh: Soar

e cutremy System overview
LU RN
A0 edwes Conirod system Hedingarcy role Hedimiancy slmie Ragandnay pariaet
SANEH S sl irlzmal ey At 4R,
Swemem alam
O=wee avalzhily + Srodurt seemar G-0H1-0_TC0E
Slznce dmecs + Lol system vemion: 42500
5P 5ege Metwork configuration
Svrzm o flzs Canfguration of primary coniral sysiem
- 17 andieas 10312336
Hzhivore mask 2IGZIG24DD
Cietann ] ijalemes 10138104
Lm

17 agd- 10.2.12347
Hebear e mexk Aeh=hMIn
Defulgolzsacy 133425404

Gl con Tus M Lan 2294 1505 11 CRT
FETR ERT LT TERR I BT TR T iy Rk )

Select Netlink usage to view the usage of tie lines within a networked system:

HD Core System Information

Ao rcfrozk: Start
et apt cvapiny Metlink Usage
mdin vane
CFI0 e Corkrol spstem RFodumsiuecy role Fedomvdaecy shaic Bedundancy partner
sestam slam esdamal primsey arihea s
L axalaalny

Silancn Dhacts m Primay P Srcondary B Lot stars MsEEimarkan ks Solrcs lnks
1 192 1E0.222353 JCn Connmled L] X0
3 IR A awnn Couwered L i
Swctem lug fics 1 13T1EEIIZED 1321E£.222.57 Comacted ity .30
& 132 1EE.222942 T2 IEE. 222944 Couwaled iG] L]
£ 1AZAEEAMAT 193 1EE 117 A% Cuwared AN i

ID: 1, Hoet: 192.168.222 69

Soumces

Faat wnadabibty HL=L A Soun ce HLSL Loecal deslinalion HL S0k
(212 050 M stk il B R 004855200 Wanl onty PR T ARPA SRS
(1LY LR BRI L e | BT R4 a0 D WAL PE S L RPE T INFE |
ak RN | A =] - =

0K AT EkE=s 3 - -

LA]2 LR | (L e e i)

0K MLE1.DE RN VA =] & J

0K KIE1TF ST e f - -

oK KLR:A:07 o5 3Ny o T

(]} HLR.1.0E 08N skl - z

K MLE1TE MR TN k= d - -

0K HLFR:1:07C D53 N siddenin

LH]LY KLk.1.27 1 Lo Iy shdden || = &

0K HLEA:01 32 50N e 1 2 E =

a]2 KLR:1:07 = [ RIS T ) - -

(138 LR 1.0 4 LIRRR | L e ) : -

K HLR: DS R R = - 3

0K HLR:1:07E [l U i T

L13 (o] W PR LB-BN I L e B - =

0K HWLEA:DIC L5 2R EE= 0 - =

0K KLEANT & A I sk 19 - -

il LA I SEL U By TR R e =
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Select GPIO states for an overview of the High/Low status of GPIOs:

HD Core System Information

Aro rcfresk: Start

Bysn oy GPIO States
rdin v
e Pysical GI'ls
Sieatanm slamm (F ) Ll gl nanins Tl Hlale
[eana seilzalny T st leen AP _FE& 13RI _FRY, 2l iyl LW
Sinncedatetts A4:ziddened BFIZ 5541 3F0E_EEA el Fhyzered Low
§ ER T T ] GPO2 G f BP0 _ERA —=vel biaered Lowm
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Select RAVENNA config to view the configuration of RAVENNA devices fitted to your system. The
information includes the IP address of each device:

HD Core System Information
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System Alarm

This page lists the last 5000 errors which have triggered the Global_Alarm. Every error has an explicit
ID, description and time stamp for an easy overview of the alarm events. The errors are stored within
the system logfile: alarm.log.
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Select the Backlog sub page to view archived errors (the previous alarm.log file). These errors are
stored within the system lodfile: alarm.log.old.
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Device Availability

This page contains sub pages for each system component - in our example, one sub page for HD
Core 1 can be selected. Here you can find detailed information, including feedback on sync, alarm
status, slot status, etc.
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Silence Detects Page

This page lists any silence detect errors generated during operation.

Mulmaking AMo Imlara

HD Core System Information

Solo mchzss: Slam
YRIm e Silence detects

wvetom zlom
Lizwez aaalzh ks el ApsdWir Isdnmlan y s Isahnatuniyy Wil Hudimibney panlis
ilmnme Seemer u-lﬂl{'} prmAy Aelrs L]
e ~ Fomaliaz! Sgeal akel Descripdon Chaane Positen Adrcss
Hyzacm bag hics Mz zlherk sigraks doloded
Cownwealms 1 Fii, 27 Fale 5013 13 57 R GWT

Irg Dams=Hual'D * ronmiog o 1003 28R 20

mc256 MKIl Technical Manual V5.0/1 259



w Chapter 4: Service/Maintenance

Web Browser Interface

DSP Usage

This page shows the DSP usage of the system:

LAWD

HD Core System Information

Bubg refresh Siam

Syl cnira Mixing console DSP usage
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260 V5.0/1 mc256 MKIl Technical Manual



Web Browser Interface

Chapter 4: Service/Maintenance %

System Log Files

This page provides access to all logfiles stored on the control system, allowing you to view system
log files (messages) or alarm log errors. Select an option to view the contents of the file.

HD Core System Information

Auby refresh Start

e System log files
Syatm dam
Devici dvai abdicy = Caairead sy slam log e
P + Last syste ik (Might not ba avai alal
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Telnet Sessions

Many parameters on the mc256 MKIl can be adjusted by opening a telnet session to the control
system.

Warning

Adjusting parameters via telnet will make low level changes to your system. Therefore,
these procedures should only be performed by a fully trained member of staff.

To open a telnet session:

1. Install a telnet client on your computer. We recommend using Tera Term Pro Web 3.1.3, a
free telnet client for Windows, which can be downloaded from www.ayera.com/teraterm/

2. Connect your computer to the Lawo system network.

3. Configure the TCP/IP settings on your computer's network interface card.

4. Openthe Tera Term Pro Telnet client.

5. Select TCP/IP from the Setup menu, and add the TCP/IP_address of your control system to
the host list:

x
~Haost list
| Add
192.168.102.90 Up
192.168.102.65
Hemove
Down |
¥ History

¥ Auto window close  Poriff: |23
¥ Telnet  Term type: IVH 00
0K | Cancel | Help |

6. Now open a new Telnet connection using File -> New connection:

=0l x|

File Edit Setup Control ‘window Help

Mew conneckion...  Alk+n ﬂ

Log...

Send file. ..

Transfer 3
Change directory. ..

Print... Ale+p

Disconnect
Exit Al
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7.

Choose the TCP/IP Host address of your control system:

Default IP Address of mc266 shown:

Tera Term: New connection

xl
& TCPAIP Host: 192.153.102.55 -
¥ Telnet TCPportt: [23
€ Seral  por; [comMz -]

4] 4 | Cancell Help |

8. When prompted, enter the login name: root and the password: hong

File Edit Setup Control ‘Window Help

=101
-

The session opens, and you will see the command prompt for the control system

ronos login: root
Passtrord:

File Edit Setup Contral Window Help

=101 ]

lrronos login: root
Password:

[Telcome to

Lawo mcZ 66 Shell
Current Filesystem Version
1-10-0-5

lronos:~ §

9.

L

Now follow the specific instructions for the task you wish to perform.

Some parameters are not saved on the main control system, and therefore you may need
to remotely login to another part of the system.

@ You can reboot the control system from the telnet client by typing reboot and Enter.
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Logging in to a Remote Control System
To remotely login to another control system (for example, the GUI_0 Bay Server):
1. Atthe main control system prompt, type ipinfo and press Enter.

A list of all system IP addresses is displayed:

Telnet Session to mc256 shown:

IR R ENE]

Lawvo Router Mk2 Shell

helobh:™ # ipinfo
IP ADDRESS HOSTHAME

Judas_GUI_2
paunlus_GUI_3
gilvanus_GUI_4

5

timotheus_GUI_
simonpetrus_BAY_ B
andreas_BAY _1
Jakobus_BAY_2
Johannes_BAY_3
philippus_BAY_4
bhartholomaeus_BAY_ 5
thomas_BAY_6
matthaeus
zehedaeus _
alphaeus_BAY_9
harnabas_BAY_108
andronikus_BAY_11
Junia_BAY_12
linus_BAY_13
silas_BAY_14
timothy_BAY 1%

For our example, the IP address we require is 192.168.105.100 (thaddeus_GUI_0).

2. Type telnet xxx.xxx.xxx.xx (where xx.. is the IP address of the remote control system) and
press Enter.

3. When prompted, enter the login name: root and the password: hong

The session opens, and you will see the command prompt for the remote control system:

heloh:™ # telnet 192.168.185.188

[Entering character mode
scape character iz *~1°.

haddaeus_GUI_B login: root
[Password:

EE R

Lawo mc2 56 Bayserver Shell

4. Now follow the specific instructions for the task you wish to perform.

5. Once you have finished, you can return to the main control system by typing quit.
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File Transfer via FTP

All files stored on the control system can be accessed by a suitable FTP client.

You will need this tool to transfer files, such as system software or factory configuration (.tcl) files,
which are "hidden" from normal console GUI, mxGUI and AdminHD operation.

Warning

File transfer via FTP may make low level changes to your system. Therefore, these
procedures should only be performed by a fully trained member of staff.

To perform a file transfer:

1. Install a suitable FTP client on your computer. We recommend using Filezilla, a free FTP
client for all platforms, which can be downloaded from www filezilla-project.org

2. Connect your computer to the Lawo system network.

3. Configure the TCP/IP settings on your computer's network interface card.

4. Open the Filezilla FTP client, and enter the following information:
Host = the IP address of your control system
Username = root

Password = hong

Default IP address of mc?56 shown:

[ Filezillz

File Edit View Transfer Server Bookmarks Help

A-FER 2R adFn
Host: 152.168.102.56 Username: root Password: sess Port: E]

5. Click on Quickconnect to make the connection.

The session opens, and you will see the filing system of the control system on the right (under
Remote Site):
Erun|@192.168.56.101—FlleZ\IIa - — "”& m .:.,.Eu&

File Edit View Transfer Server Bookmarks Help

B Sl (5] B8 [l SRR AN B SRR

Host:  192,168.56,101 Username: root Password: seee Port: [‘quickeonnect (=]
Status: Directory listing successful -
Status: Retrieving directory listing. ..
(Command: CWD data
Response: 250 OK. Current directory is jmedia/hdb1
ICommand: PWD
Response: 257 "fmediafhdb1”is your current location L3
Status: Directory listing successful >
Local site: | C:\Users\Sue \DesktopTemp) = [| Remote site: | fmnt/mxqui_config_sharejmess -
: i i Contacts - ER =
Cookies 1|, mxgui_config_share
Desktop Lo
Ebay Pics
pdfs
Temp
- | Documents b =
= =
Filename Filesize Filetype Last madified Filename Filesize ~Filetype Last modified  Permissions  Owner/Gro...
consnle confintcl 142 TCI File DRA0/201212:07:26 o 2 L 3 Eileiold S LOn UL o an )
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6. BEFORE transferring files, check that the Transfer Type is set to Binary:

'H FileZilla i »

4 - | Process Queue CTRL+P

Host: 192, 158-105 Default file exists action...

Transfer type 2
Preserve timestamps of transferred files CTRL+U |
Speed limits 3
Manual transfer... CTRL+M

Warning

It is VERY important that file transfers use "Binary" mode, and not "ASCII".

7. You can now transfer files from the control system (Remote site) to your computer (Local
site), or vice versa:

e Use the upper areas to navigate through the filing structure - the contents of the selected
folder are displayed beneath (under Filename).

¢ Right-click on a filename and select Upload or Download - the file is transferred to/from the
selected folder.

A ro0t@12.168.56.101 - FileZilla - " o - i g s 7 ystiod <

File Edit View Transfer Server Bookmarks Help
[ - IEEER) 2 v B &[T F 0N
Host: 192.168.56.101  Userame: root Passward: eass Port: [ Quickcomnect |+

Status: Directory listing successful

Status: Retrieving directory listing...
[Command: CWD data
Response: 250 OK. Current directory is jmedia/hdb1
ICommand: PWD .
Response: 257 "fmedia/hdb1”is your current location 8 |
Status: Directory listing successful -
Local site: | C:\Users\Sue'\Desktop\Temp), ~ | Remote site: | /mnt/mxgui_config_share/mc56 -
T & Contacts - - . mnt o
Cookies = mxgui_config_share
B Desktop 2 .production
~ |, Ebay Pics 2 trash
pdfs 2 internal
H Temp me56
- *| Documents i tobe ) mcbb ki
Filename = Filesize Filetype Last modified Filensme Filesize Filetype Last modified Permissions  Owner/Gro...
] console_config.tcl 142 TCLFile 08/10/2012 12:07:26 custom_template_inst... File folder 23/11/201011:... 0777 00
L cor 4 TCLFile 12/10/201016:... 02767 00
[#] cot ¥ Download TCL File 12/10/201016:... 02767 00
7] cut B Addfiles to queue TCLFile 12/10/201016:... 02767 oo
17| gu View/Edit TCLFile 12/10/201016:... 02767 Qo
qu . TCLFile 12/10/201016:... 02767 0o
= Create directory
gu TCLFile 03/10/201216:... 02767 oo
= Refresh
me TCLFile 12/10/201016:... 02767 Qo
Delete
5 T e [ Rename
1 file. Total size: 142 bytes Selecte Copy URL(s) to clipboard
Server/Local file Direction Remote file Size Priority  Status File permissions...
Queuved files Failed transfers Successful transfers (1)

Further information on system files can be found in the relevant technical documentation.

266 V5.0/1 mc256 MKIl Technical Manual



Chapter 4: Service/Maintenance
Nova73

oo

Nova73

This section covers hardware servicing for both the Nova73 HD and Nova73 Compact core:

Replacing the Fans

Replacing a Power Supply Unit

Router Module MKII: LEDs & Switches

Replacing a Router Module

Replacing a System or User Data Flashcard

Updating Configuration and Software in a Redundant System

I/O & DSP Modules: LEDs & Switches

Replacing an /O or DSP Module
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Replacing the Fans

Each of the cooling fans can be replaced individually while the Nova73 is running:

Nova73 HD rear view

Screw Sc‘rew

N itng Y\
"\?o 3
.\.' )
)
>

e

Connector

Nova73 Compact rear view

Unplug the 4-pin connector from the rear of the frame as shown above.

Loosen the screws and remove the fan from the frame.

Insert the replacement and fasten the screws to secure.

p O D PF

Plug the 4-pin connector into the coupler of the frame.
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Replacing a Power Supply Unit
Each of the PSUs are individually hot pluggable.

To operate the Nova73, one PSU is sufficient. Therefore, when two supplies are fitted, you can
replace a PSU without affecting the operation of the system.

Warning

If only one PSU is operational, then powering off will shutdown the system.
The replacement PSU must be of the same type; you cannot mix PSU types.

Nova73 HD front view

! !
PSU 1 PSU 2

Nova73 Compact front view

1

PSU PSU

2

Power SWItih S(irew

j/

(~]
)

20000000

0

A,

/ Sc‘:\rew
Mains Socket
(IEC)

Power Switch

Mains Socket
(IEC)

Screw

Screw
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Switch off the PSU you wish to replace from the front of the frame as shown above.
Disconnect the mains from either the PSU 1 or PSU 2 IEC mains connector as appropriate.
Unfasten the four screws and, using the handle provided, pull out the PSU.

Before fitting the replacement PSU make sure that it is switched off.

Insert the new PSU and slide it into position until it locks into place.

Secure the unit by fastening the four screws.

N o g M v DN PRE

Re-apply the mains to the PSU IEC mains connector and switch on!

Warning

For air conditioning reasons, both PSU slots MUST be occupied when the Nova73 is
operational:

e Nova73 HD: if only one PSU is installed, then please fill the empty slot with a
dummy plate (Type 980/21).

¢ Nova73 Compact: leave both PSUs in the frame until a replacement can be fitted.
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The Router Module MKII (980/33) provides the following front panel connections, LEDs and switches:

ACTIVE LED

STANDBY LED

Flashes green when the control system is booted and
running.

The ACTIVE LED on each Nova73 module, or DALLIS
card, should blink in time with all other ACTIVE LEDs
(at approximately 100Hz). This shows that the card is
synchronous to the rest of the system. If an LED is out
of sync, then check that the card is fitted correctly, and
if the symptom persists, replace the card.

lluminates in yellow if the module is in standby.

If you have a main and redundant Router Module fitted
to the Nova73, then one module will be ACTIVE while
the other is in STANDBY.

= ®

@ acTive

@ sTanpey

@ cHARGE

@ aLarm

) MULTI-CHANNEL
E € INPUT 1
o @mNpuT2

@ INTERNAL

E PREPARE COLD START

@ LAMP TEST

CHARGE LED lluminates when the backup power unit is charging. @ woouLe TakeovER
Off = unit is fully charged.
ALARM LED lluminates in red when the global alarm is active.
SYNC LEDs These four LEDs indicate the system's sync source: |
Flashing green = current sync reference.
Solid green = available redundant sync reference. "’fg:cwm
PREPARE Press this button (the LED illuminates) to prepare a oo oo
COLDSTART cold start. The system will then cold start on the next [
power cycle (or reboot). -
LAMP TEST Press this button to test all the LED lamps within the
Nova73 plug-in modules.
MODULE If you have a main and redundant Router Module fitted
TAKEOVER to the Nova73, then press this button to force a U
takeover to the redundant control system.
After a few seconds, the ACTIVE and STANDBY LEDs
on the two modules update accordingly. &
ETHERNET A Connects to the control surface.
ETHERNET B Connects to the Lawo system network.

POWER Button

Silk Screen

Both connections are RJ45. The ACTIVITY LEDs flash
in green when data is being transferred.

This recessed button will power cycle the Router
Module. It should only be used as a last resort if all
other restart methods fail.

Shows the part number of the module.

Further information can be found in the data sheet, available in the "mc2 Nova73 documentation”

guide.
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Replacing a Router Module
Router modules are individually hot-pluggable.

If main and redundant Router Modules are fitted to the Nova73, then you may replace the redundant
module (in STANDBY) without affecting the operation of the system.

Warning

If only one Router Module is fitted, then replacing the module will shut down the system!

See Installation: Mounting the Nova73 Modules for instructions.
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Replacing a System or User Data Flashcard

A backup image copy of the System Flashcard and/or Data Flashcard can be created and stored,
so that it can be replaced if necessary.

Full instructions on how to create the image copies are provided in the separate technical
documentation "Creating CF Cards using the Virtual Machine".

Once you have the new flashcard, it can be replaced as follows.

/(_') You must power off the Nova73, thereby shutting down the system, in order to replace a
flashcard.

If main and redundant Router Modules are fitted to the Nova73, then please see the
additional instructions on updating data in a redundant system.

Both flashcards are located on the Router Module MKII (980/33) within the Nova73:

1. Power off the Nova73 (both PSUs if fitted) and remove the Router Module.

You will see the System and Data Flashcards slotted into the Control System; each should be
clearly labelled.

2.  Remove the appropriate card and slide in your replacement.
3. Replace the Router Module and power on.

The control system boots and reads the new data.
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Updating Configuration and Software in a Redundant System

For redundancy to work, both main and redundant control_systems must hold identical information
and mirror each other.

User data (productions and warm start data) is mirrored at all times. However, the cold start
configuration and system software are only synchronised when the control system boots up. This has
implications if you wish to upload a new AdminHD configuration or update system software.

Let's take an example where your main control system is called A and the redundant control system
is called B. If you upload your new configuration or software to control system A and then perform a
cold start, the following will occur:

e The system responds to the cold start of the main control system (A) by automatically
switching to the redundant control system (B).

e At the end of the cold start, data from the active control system (B) is copied back to the
redundant control system (A). In other words, your new data is overwritten!

To avoid this, and upload a new configuration or update software successfully:
1. Disable the redundant control system.

This can be achieved by releasing the locking catches, fitted to the top and bottom of the redundant
Router Module (in STANDBY):

This unlocks the module from the Nova73 and automatically disables it; the module's LEDs should be
off. Note that it is not necessary to pull out or remove the module.

2. Now upload your new AdminHD configuration, or upload the new software, and cold start.
The system restarts using the new configuration files or software.

3. Once the control system is running (ACTIVE LED flashing), lock the redundant Router Module
back into place to reactivate it.

The redundant Router Module boots up, and all data from the main control system is copied
across.

4. Cold start the system once more to confirm that step 3 was successful.
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/O & DSP Modules: LEDs & Switches

The front of each /O and DSP module provides some useful LEDs:

bl e g g b g g g B aun o | o | o 7 g -
07 e el B ] e e i e v ,r
A BT H S BT H S i s e e e e SO o o
Q. Ra s, -
w | @@ w| @@ . u e Qs o
o o0 e -
.| e 1| s 1| - B e E
2UELL | &
S o ]
=0 =0 !‘ E‘ Socenaveaznn Seccnaniazes !
El=l=0 00| [ E .
=0 Q=] =0 Q=]
100 100 = &l [
® || 5| g 5 o o o, -
E o o o N N E
Al | (= - E

e ACTIVE LED - shows that the module’s internal control system is booted and running.

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE
LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the system. If
an LED is out of sync, then check that the card is fitted correctly, and if the symptom persists,
replace the card.

e Other LEDs & Switches — some modules include additional status LEDs and switches. For
details, please consult the relevant data sheet, available in the "mc2 Nova73 documentation”
guide. See also RAVENNA Port Status LEDs.

e Silk Screen — shows the part number of the module.
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Replacing an I/O or DSP Module

All /O and DSP modules are individually hot-pluggable enabling modules to be replaced without
affecting the rest of the system.

See Installation: Mounting the Nova73 Modules for instructions.
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DALLIS Unit(s)

This section covers servicing the DALLIS hardware:

Replacing a Power Supply Unit

Master Board: LEDs & Switches

Replacing a Master Board

Replacing the Lithium Battery

I/O Cards: LEDs & Switches

Replacing an /O Card
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Replacing a Power Supply Unit
Each of the PSUs are individually hot pluggable.

To operate the DALLIS, one PSU is sufficient. Therefore, when two supplies are fitted, you can
replace a PSU without affecting the operation.

Warning

If only one PSU is fitted, then powering off will cause an interruption in audio from the
DALLIS unit!

The replacement PSU must be of the same type; you cannot mix PSU types.

1. Onthe rear of the DALLIS frame, disconnect the mains from either the PSU 1 or PSU 2 IEC
mains connector as appropriate.

2. Unfasten the two screws on the right hand side of the hinged PSU cage door (marked by the
arrows below).

3. And pull the door open to access the PSU docking bays:

Unfasten these screws: Pull door open to reveal PSUs:

4. Unfasten the metal catch which holds the PSUs in place by pushing on the catch as shown:

- ...—‘

5. Remove the relevant power supply unit and replace with the spare.
6. Fasten the catch back into place.

7. Replace the cage door and fasten the two screws.

8

Re-apply the mains to the PSU IEC mains connector and switch on!
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Master Board: LEDs & Switches

A choice of DALLIS master_boards support different connections to/from the Nova73. All versions
provide similar front panel functions:

ACTIVE Flashes green when the card’s internal control E; ¢ ;
LED system is booted and running.

The ACTIVE LED on each Nova73 module, or
DALLIS card, should blink in time with all other
ACTIVE LEDs (at approximately 100Hz). This shows
that the card is synchronous to the rest of the
system. If an LED is out of sync, then check that the
card is fitted correctly, and if the symptom persists,
replace the card.

MASTER RAVENNA

WCLK OK llluminates in green when the DALLIS is receiving a
LED valid sync signal.

POWER OK llluminates in solid green when the DALLIS PSUs are
LED running normally.

If the LED flashes, then there is a PSU error.

ALARM [luminates in red when the local DALLIS alarm is
LED active.

WCLK Port The DALLIS may be synchronised to an external sync
reference connected to this BNC.

I/O Ports See DALLIS master boards for details on the different
IO connections.

On some boards, LEDs show the status of the
signals arriving at the connection.

CTRL Port This port may be used to connect a local computer to
update firmware or provide diagnostics.

Silk Screen Shows the part number of the master board.

Further information can be found in the data sheet, available in the "mc2 Nova73_ documentation”
guide.
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Replacing a Master Board
Master boards are individually hot-pluggable.

If main and redundant master boards are fitted to the DALLIS, then you may replace the redundant
board without affecting the operation.

Warning

If only one master board is fitted, then its replacement will cause an interruption in audio
from the DALLIS unit!

See Installation: Mounting the DALLIS Cards for instructions.
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Replacing the Lithium Battery

The DALLIS master board is fitted with a lithium battery. This battery guarantees that user data
remains saved when the system is powered off. As a precaution we recommend that the battery is
replaced after about eight years of operation. Please send the master board to your local Lawo

service representative to perform this procedure.

Only Lawo service staff may replace batteries.
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I/O Cards: LEDs & Switches

The front of each /O card provides some useful LEDs:

R T TR A T2 TTE

B oo g g s .
L BNS S ||

e i) e ‘ z i
e |8 @& & |@® -]

alglalalesle oo le e & :y g ol ole e lels]

e ACTIVE LED - shows that the module’s internal control system is booted and running.

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE
LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the system. If
an LED is out of sync, then check that the card is fitted correctly, and if the symptom persists,
replace the card.

e Other LEDs & Switches — some cards include additional status LEDs and switches. For
details, please consult the relevant data sheet, available in the "mc2_Nova73 documentation”
guide. See also RAVENNA Port Status LEDs.

e Silk Screen — shows the part number of the card.
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Replacing an 1/O Card

With the exception of the Phantom Power card, all cards are individually hot-pluggable enabling cards
to be replaced without affecting other aspects of the system.

See Installation: Mounting the DALLIS Cards for instructions.
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RAVENNA Interfaces

This section covers information relevant to RAVENNA interfaces: the
981/61 Nova73 module and 947/21 DALLIS master board:

MASTER RAVENNA

e AdminHD: Configuration Options

e RAVENNA Port Connections

e QOptical Fibre SFP Modules

e RAVENNA Port Status LEDs

e The Control Port

e Control Port IP Addresses

e Updating and Servicing RAVENNA Interfaces

For more details, please refer to the relevant data sheet, available in
the "'mc2_Nova73 documentation” guide.

981/61 ravennA
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AdminHD: Configuration Options

The 981/61 Nova73 module provides 4 RAVENNA ports which
are defined by the AdminHD configuration. The channel count
per port is defined by the module type, see Fitting Modules to
the Core.

’Al
wad
/Al

empty
981/02 AES3 SRC + MADI Port
1 981/31 MADI 2 MMF

< 981/32 MADI 22 MMF

g 981/36 MADI6:x2 MMF

oo 981/38 MADIS MMF
-~ 981/41 MADI 2 SMF

|| 981/53 ATM 3 MMF
981/56 ATM 6:x2 MMF

Three different options are available:

e 981/61 Ravenna Link 4 x 128 channel

e 9081/61 Ravenna Link 2 x 256 channel/2 x 128 channel
e 981/61 Ravenna Link 2 x 128 channel; 1 x 256 channel

Each RAVENNA port is then configured for its application. See Defining the /O Ports.

e 128 channel ports - can connect to a DALLIS, the mc256 MKIl Local I/O board or be
configured as Tie-Lines.

e 256 channel ports - must be configured as Tie-Lines.

RAVENNA 128 channel Port Options RAVENNA 256 channel Port Options

@ Core browser Core browser

= = @ A

System

ECorel
EH-Module 1 [RVL]

Define Dallis 3RU (128 channels)
Define Dallis 6RU (128 channels)
Define Tie-Line (128 channels)

Define Local /O

If you select a DALLIS, then the DALLIS frame is automatically fitted with the 947/21 RAVENNA
master board:

Master Ravenna

You may configure a redundant 947/21 master board in the usual manner, see Port Redundancy.

@ RAVENNA can provide link redundancy, without a second master board, by installing both
the copper and fibre optic connections between the Nova73 module and DALLIS master
board.
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RAVENNA Port Connections

Each RAVENNA port provides:
¢ Ravenna Link 1.0, multi-channel digital audio over IP interface.
¢ Two physical connections, per port, for standard CAT 5 Ethernet and optical fibre:
o CAT 5/6/7 Gigabit Ethernet, RJ45 connectors, crossed or straight (1:1) cable, up to 200m.

0 Opitical transceivers (SFPs) can be installed for multi-mode or single-mode fibre. These
must be Lawo-certified, see SFP Modules.

e Up to 128-channels at 48kHz, and 96kHz*, per port, for DALLIS interconnects. (RAVENNA
supports 128/256-channels per port for non-DALLIS applications.)

/(_') * 96kHz RAVENNA is a future option.

RAVENNA links should be directly wired to the corresponding RAVENNA port. The interface is
completely self-configuring. Thus, once you have connected the ports (from your Nova73 to DALLIS),
no further network configuration is necessary.

Warning

To guarantee low latency, reliability and easy setup, do NOT connect any network
equipment between the two RAVENNA ports.

When both copper and fibre are installed at start-up, fibre is the preferred medium. In either case, the
second medium can be hot-plugged without disturbing the current operating link. If a link breaks, then
the card automatically switches to the second medium (if installed) - note that there will be an audible
audio interruption until the automatic link/stream setup re-establishes the connection.

9 Close any unused optical connectors, with a protection plug, to avoid performance
degradation by dust or dirt.
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Optical Fibre SFP Modules

Each RAVENNA port provides an optical fibre connection which can be used by installing a Lawo-

certified SFP module:

SFP Module Description

Part Number

1000 BASE SX: 850nm, -7dBm, multi-mode fibre, 550m

981/60-10

1000 BASE LX: 1310nm, -3dBm, single-mode fibre, 10km

981/60-20

1000 BASE ZX: 1550nm, 0dBm, single-mode fibre, 80km

981/60-30

CWDM: 1270-1610nm, single-mode fibre; up to 40km

981/60-40 to 981/60-57

Warning

The SFP modules must be Lawo certified (from the table above).

The SFP transceivers are hot-pluggable. To install:

1. Push the SFP module into the rectangular slot:

| .

g}%‘@ @s
&

2. Press gently and firmly until the module locks into position.
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RAVENNA Port Status LEDs
Each RAVENNA port provides the following status LEDS:

Lock LED Off = no signal.

Green, steady state = the link is active, and the signal and
streaming are ok.

Red, steady state or flashing = the link is active but has one of oox sl

the following errors: ] J

e Streaming format error

e Streaming lock error

e Stream is asynchronous

Stdby LED Off = port is active.

(Standby) Yellow = port is configured as a redundant port and is in
standby (inactive).
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The Control Port

All RAVENNA interfaces include an Ethernet control port (labelled SERVICE on the 981/61 and CTRL
on the 947/21).

You should connect the RAVENNA control ports to the Lawo system network, so that you may
access each interface from a service computer (via FTP or Telnet).

/O You will need this connection in order to update or service the interface.

Network Connection
Using either a crossed or straight (1:1) network cable (STP-CAT 5 with RJ45 connectors):

1. Connect each RAVENNA control port, and your service computer, to the Lawo_ System
Network. For example:

Ethernet B

RAVENNA
Control Ports

4 Dl 3L CL78 chanmeis] [Channchs keft N 128 § 040T: 1381 & B
[

Network Switch

to other mc2
LAN (Ethernet) systems

or 3rd party
controllers
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Control Port IP Addresses

To establish communication, you will need to know the IP address of the RAVENNA control port.

The IP addresses are pre-configured, as shown in the table below, and are dependent on the Nova73
slot position.

Note that the Network segment and Gateway can be configured from a file called the "pre_config.tcl”,
and so may vary from those shown below.

Note also that the 947/21 DALLIS master board has a standard IP address if it is NOT connected to
the Lawo control system = 192.168.110.253.

The table lists all the pre-configured RAVENNA control port IP addresses:

¢ QOrange = 981/61 Nova73 modules, according to slot position.

e Yellow

RAVENNA link port).

e Grey = reserved for future implementation.

947/21 DALLIS master boards, according to their Nova73 connection (via the

Nova? 3 5lot 1 2 3 4 5 6 2
RALINK Ports 1101 1109 11017 11025 11033 11041 110,49 11057
active 1102 110,10 11018 11026 11034 11042 110,50 11058
1103 11011 11019 11027 11035 11043 11051 11059
1104 110,12 11020 11028 11036 11044 110.52 11060
RALINK Ports 1105 110,113 11021 11029 11037 11045 110.53 11061
future option 1106 110,14 110.22 11030 11038 11046 110,54 11062
1107 110,15 110.23 11031 11039 11047 110,55 11063
1108 110116 110024 11032 11040 11048 110,56 11064
| Nova7 3 5lot 9 0 1 1z 13 14 15 16
RALINK Poris 110,65 11073 11081 11089 11057 110,105 110,113 110,121
active 11066 11074 11082 11050 11088 110,106 110114 110,122
11067 11075 11083 11091 11099 110,107 110115 110,123
110,68 11076 110,84 11092 110,100 110,108 110116 110,124
RALINK Ports 110,69 110,77 11085 11095 110,101 110,109 110,117 110,125
future option 110,70 110,78 110.86 11094 110,102 113,110 110,118 110,126
11071 11079 11087 11095 1101108 110,111 110119 110,127
110,72 110,80 11088 11056 110104 110,112 110,120 110,128
For example:

e The IP address of a 981/61 module fitted to Nova73 slot 5 is 192.168.110.205.

e The IP address of a 947/21 master board connected to this module's first RAVENNA port is
192.168.110.33.
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Interrogating RAVENNA devices via the Web Browser Interface

You can open the Web Browser Interface (from a service computer connected to the mc256 MKII
control system), to view all configured RAVENNA devices on the network.

This is especially useful if the IP address Network segment or Gateway have been modified. Our
example shows three RAVENNA link devices, with IP addresses configured using the "pre_config.tcl"

file:

HD Core System Information

R System Network Configuration

Mk g

GO shame Canfiguration of pramary conbiol system
F addiess
Siystam alarm Hebwark mazs
Desice avilability Dafault galewar:
ZiknEEiiuacs Canfiguration of secondary cantrol syatam
P address
Systam Ing dlas Netiork mase
T | DeRulgslewar.

RAVENNA Configuration Address Overview

HAVERNA Node Conbgurabon Addresses
Gox St Porl  Hame

L

Futu rehesh. St

Gateway

\ B G LMK B0 Rarsenna Link 2x123eh - 1x256eh 10.3.130.208 103120104
T piiriary DALLIS Masler Hudule 10.2.130.41 10.2.126.104
kS WL SE U1 BT Ravenna Link 2x123ch - 1x2h6ch 10.2.120208 10.3.128. 104

Gerzrated an Fr. U1 Mar 2012 121543 G

, Ery Lanl Hpil 1 running on 103 153 66

esxcample with 3 RA Link devices configured with 2
fila czlled pre_config kol
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Updating and Servicing RAVENNA Interfaces

To update or service a RAVENNA interface, you will need to open a FTP and Telnet session from
your service computer to the device.

/(_) To achieve this, the RAVENNA interface must be connected to the Lawo system network
via its control port.

» To update the software on a RAVENNA interface:

1. Using a computer connected to the Lawo_system network, open a FTP connection to the
RAVENNA interface.

You will need to know the IP address of the interface you wish to update, see Control Port IP
Addresses.

In our example, we are connected to a 947/21 master board with an IP address = 192.168.120.33

The username (root) and password (hong) are the same as for the main mc256 MKII control system.
See File Transfer via FTP for more detalils.

2. Upload the software update file from your computer to the /data/update folder on the remote
device:

J @ - "Eh—;'ﬁl 0, B @ R | 7 H Address; (19216812033 User: |root Password I“" Part: |21 Qu\ckgonnectl‘l

Fesponse: 200 Operation successhul
Command: Fi
Response: 227 PASY ok [192,168.120.33.213.233)
Command: LIST -a
Response: 150 Directory listing
Fesponze: 226 Dperation successhul
Status: Directary listing successful
Local Site: |§ j Remote Site: | RETEVNaeEEY
) e Lokaler Datentrager {C:) d Filename ¢ Filesize | Date Time: I Permissions | Owner { Group |
{3 Config.Msi || W
i) canvertshaw = radama-0.91 tar.gz 9163KE 26.09.2012 12:00  -nw-r--r-- root ook I
) Cwaz
i) desk.
{2 Documents and Settings
{2 Dokumente und Einstellungen
= Drivekey ﬂ
Filename ¢ I F\Ies\zel Last Modified | -
.
ZaCaonfig. Msi 04,10.2012 1537
[Eyconvertshow 25.04,2010 10:33
:]CWSZ 02.07.2012 17:16
Ddesk 08.02.2010 17:56
|[Z)Documents and Settings 17.12.2008 18:46
[C)Dokumente und Einstell. .. 04.07.2011 03,58
:lDriveKey 02.05.2012 15:09
[C)Fader 04.05.2010 16:57 =
_:]FADERS 10.03.2010 16:31
[CIFIRMWARE 25.04.2010 10:33
3GL|I_49224 10.07.2009 10:04
[Chimages 08.02.2010 17:56
[ INSTALL_TEMP 25.05.2011 1446
[ntel 17.12.2008 17:18
Chlotus 06,02,2009 13:51
[CmsoCache 05.02.2009 18:13
_'jmxgu\_ﬁrst 09,03,2010 13:05
[Cymequi_setup 09.02.2012 14:25
[Dinova 25.,04.2010 10:33
aplugremnta 25.04.2010 10:33
[ APLUGS 25,04,2010 10;33 LI
29 folders and 18 files with 5891472261 bytes, 1 file with 9403055 bytes,
[ Local Filename | Size | Direction | Remote Filename Host | status
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3. Then open a telnet session to the RAVENNA interface - use the same IP address as before

(e.g. = 192.168.120.33) and username (root) and password (hong).
4. Atthe RAVENNA control system prompt, type updateSystem and press Enter.

A list of software update files appear - this should include the file you uploaded earlier.

5. Select the correct file number, press Enter and follow the instructions to perform the update:

Tera Term - 10.3.130.41 VT

[=

2

File Edit Setup Control Window Help

Ravenna Dallis Master Board
Service Console

Version 1_06&

Lawo RE 2012

service —> Start the service menu
factory presets —> Reset card to factory preset

BusyBox w1.20.Z2 () built-in shell (ash)
Enter 'help' for a list of built—in commands.

root@ravenna-dallis-master_00_Ob_7%_04_Zb _b& ~3[updateSystem

Please select a version to update
1) radama-1.03.tar.gz

2) [radama-1_.06.tar.gz

To abort press CIRL4C...
3
Brchive radama-1.0&6.tar.gz selected for update

Verify archive ...

Ereparing system update. For completion a restart will be requized.
Do NOT power off device during update seguence !
Continue (y/n)?
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» To download the Log file from a RAVENNA interface:

1. Using a computer connected to the Lawo_system network, open a FTP connection to the
RAVENNA interface.

You will need to know the IP address of the interface you wish to update, see Control Port IP
Addresses.

In our example, we are connected to a 981/61 Nova73 module with an IP address = 192.168.120.205

The username (root) and password (hong) are the same as for the main mc256 MKII control system.
See File Transfer via FTP for more detalils.

2. Download the messages file, from the /var/log folder, to copy the log file to your computer.
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Control Surface

This section covers servicing the control surface hardware:

%

Replacing a Panel

Using the Hood Fastener

Calibrating a Touch-screen

Replacing a TFT Display

Bay Server Rotary Switch Settings

Replacing a Power Supply Unit

Replacing the Local /O Board

Adjusting the Local /O Jumper Switch Positions

If the graphics on an individual display freeze, or the controls on a panel are not
responding, then try restarting the Bay Server.
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Replacing a Panel

Each control surface panel is individually hot-pluggable enabling panels to be replaced without
affecting the rest of the system.

Channel bays are fitted with one 16-fader_panel per bay. The centre section is fitted with one central
panel connecting to two circuit boards.

» To replace a panel:

1. Remove the panel screws (along the front buffer) using a T20 Torx driver:

You should remove the screws completely and place them carefully to one side, so that they do
not fall into the frame when the panel is lifted. The springs beneath the panel will raise it slightly
from the frame.

2. Gently lift the panel using your fingers:

oW -

@ If you are lifting the central panel to gain access to the components beneath, then use the
Hood Fastener to keep the panel in place while you work.
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3. Remove the USB and power connectors taking notes on where each one should be fitted:

Fader panels have one USB and one power connector. From the central panel, there are two USB
and two power connectors.

Channel Bay: Centre Section:

4. Carefully remove the panel by lifting it out of the frame.

5. Check that the rotary switch settings on your replacement panel are correct - they should both
be set to O, irrespective of the frame position. For details, please check the panel's data sheet,
available in the "'mc2_Nova73 documentation” guide.

6. Insert and reconnect the replacement panel, and fasten the screws back into place.

If the control surface is powered, the panel will boot within a couple of seconds.
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Hood Fastener

The Hood Fastener can be used to keep the central panel in place while you work inside the console.
This avoids having to disconnect cables, and remove the panel, when you need access to other
components.

1. Follow the previous section's steps to lift the panel - you will see the Hood Fastener, stowed
safely along the front buffer:

Central Panel lifted: Hood Fastener Stowed:

s distribution

2. Release the fastener from its catch, and position it against the metal plate (to the left of the
trackball) as shown:

3. When you have completed your service procedure, replace the fastener safely back into its
catch, before lowering the central panel.
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Calibrating a Touch-screen

The Channel and Central touch-screen displays can be calibrated as follows:

1. Select the GUI's System Settings menu, GUI topic and Calibrate Touchscreens:

Settings

Local Time

Level

Calibrate Touchscreens

Loudness Metering

F

2
b
3
3
P GUI
3
b
b

Channel Display

Word clock

Fader/Joystick

Remote

Touch-screen calibration is activated across all displays.

2. Follow the on-screen instructions to calibrate the first display. You will be prompted to touch
various points on the screen.

When the last point is touched, calibration is complete, and all displays revert to their normal
operation.

3. Repeat steps 1 and 2 to calibrate a different touch-screen.
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Replacing a TFT Display

Each of the touch-screen displays is individually hot-pluggable, enabling you to replace a display
without affecting any other bay within the console. (Note that you will lose control from panels within
the bay, as the Ethernet Bay Server is mounted behind the TFT display.)

@ If you need to replace the centre section display, then connect an mxGUI computer so that
it may run online and provide continued access to central GUI operations.

> To replace adisplay:

1. Unfasten the three screws at the top of the display using a long T20 Torx driver, and gently tilt
the unit forwards:

Warning

The Torx driver shaft MUST be long enough to turn the countersunk screws without
scratching the front panel. If you attempt to use a short driver, or driver attachment,
damage may occur.
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2. Lift the display unit out of the frame and lay it carefully face-down on a piece of foam, or similar
protective material, on top of the control surface:

3. Remove the LVDS, USB and power connectors taking notes on where each one should be
fitted.

4. Check that the Bay Server's rotary switch settings on your replacement panel are correct.
5. Fit the replacement in the reverse manner.

If the control surface is powered, the display will refresh within a couple of seconds.
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Bay Server Rotary Switch Settings

Each channel and central bay is supported by an Ethernet Bay Server, mounted behind its TFT
display. The Bay Server has a rotary switch with two settings:

e Function - determines whether the Bay Server supports a channel or centre section bay.

e Address — determines the Bay Server index, counted from left to right across the frame
starting at O.

You may need to adjust these settings if you are replacing a TFT display or adding an extender.

The settings also determine how the Bay Server control system is named; this will help locate its IP
address should you need to perform a remote login.

Bay Server .
Location Function Address Control System Naming
Centre Section 8 0 "nickname"_GUI_0

Channel Bay 0 0, 2, 4, etc. "nickname"_BAY_0, BAY_1, etc.

Note that for channel bays, address 0 is the left-most bay.

The example below shows the settings for a 32+16C+16 frame:

Bay Server Rotalry Switch Settings

Control System = BAY_0 Control System = BAY_1 Contrel System = GUI_0 Control System = BAY_2
Addr=0 Addr=2 Addr=0 Addr=4
Function =0 Function =0 Function =8 Function =0

Lotk i Lot i -  _ bt iy

Adding an Extender Bay

If an extender is added to the left of the main frame, then the addresses of each main frame bay must
be shifted upwards.

If the extender is added to the right, then its address can be counted upwards from the main frame.
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To Adjust a Bay Server's Rotary Switch Settings

1. Remove the TFT display from the bay you wish to adjust. If you lay the display on top of the
control surface panel, you do not need to disconnect any cables.

2. Locate the two rotary switches on the Bay Server control board. This is the board mounted at
the top of the display unit (closest to you in the pictures below):

3. Adjust the Function and/or Address settings.
4. Replace the TFT display.
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Replacing a Power Supply Unit

Depending on the frame size, either one or two PSU blocks are fitted to each control surface frame.
To replace one you will need to disconnect the PSU block from its distribution board (located beneath
the control surface panel), and remove the TFT display (to access the PSU block).

There is always one PSU block fitted to the central bay:

PSU Block

For larger frames, the second PSU block is fitted to the left-most channel bay:

PSU Blocks

Extenders are also fitted with their own PSU block:

PsSU B\Iock
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» To replace a PSU block:

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors - press the
red button on the IEC connector to release the plug.

Warning

DO NOT attempt to access the power supply unit without disconnecting the mains.

You must remove the MAINS connectors from the frame, rather than from the wall, as the
IEC sockets form part of the PSU module. If you do not, then the PSU module will get stuck
during step 7.

2. Lift the control surface panel in the PSU bay, to gain access to the distribution board. In the
central bay, the distribution board is located on the right below the Overbridge:

4 1] | |
; 01
J 7
\ = 1
/1

Network Switch

3. Using a T20 Torx driver, disconnect the PSU block from the distribution board by removing the
4 wires shown below:

Do NOT disconnect any wires other than those shown.

4. Lower the control surface panel back into place, but do not fasten the panel screws as access
will be required again in step 11.
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5. Now remove the TFT display within the PSU bay. If you lay the display on top of the control
surface panel, you will not need to disconnect any cables.

You will see the power supply block mounted at the rear of the frame:

6. Using a 7mm hex socket, remove the two screws holding the power supply block in place,
followed by the single screw attaching the protective earth:

Warning

Take care NOT to drop any nuts or washers into the desk.

7. Remove the PSU block from the frame, taking care to extract the distribution and protective
earth cables along with the unit.

8. Now fit the replacement block (which comes with its own 4-wire distribution and protective
earth cabling). The 4-wire distribution cables should be fed down the distribution board area.

9. Screw the protective earth to the frame, and replace the two securing screws (see step 6).
10. Then replace the TFT display (see step 5).

11. Lift the control surface panel once more, and connect the PSU block to the distribution board
(see step 3).

12. Replace the control surface panel, and fasten into place.

13. When everything is back in place, re-connect the rear mains IEC power connectors, and
power on.
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Replacing the Local I/0O Board

The local_l/O board is mounted inside the control surface beneath the central panel. It may be
replaced as follows. The instructions apply to both local /O board types - 958/55 (MADI) and 958/50
(RAVENNA).

Central Panel Lifted (no local I/O fitted) Local I/O Carrier Unit (disconnected)

. A"

ns distribution

> Toreplace the Local I/O:

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors - press the
red button on the IEC connector to release the plug.

Warning

DO NOT attempt to access the local /O board without disconnecting the mains.

2. Lift the central panel to gain access to the local /O (on the left hand side), and use the Hood
Fastener to keep the panel in place while you work:
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3. Remove all of the connectors from the local /O carrier, in the order described below, taking
notes on where each one should be fitted:

Local I/O (side view)

Master connector
(MADI)

, Numbered |10
connectors

a. Disconnect the power connector from the backplane, and open the clamp to release the
cable.

b. Disconnect the master connector - either MADI (optical SC) or RAVENNA (CAT5 RJ45). The
connector type depends on the version of your local /O board.

Note that on the 958/55 MADI board, the 9-pin D-Sub and BNC are unused. On the 958/50
RAVENNA board, the master cable connects to the left-hand RJ45 socket, while the right hand
RJ45, BNC and SFP cage are unused.

958/55 MADI 958/50 RAVENNA

c. Disconnect all of the /O cables by unlocking and removing each D-Sub connector. The
numbers beside the connectors correspond to the ribbon cable labelling. The following reference
diagram can be found on the cable duct to the right of the local I/O:

37 female 2 Master 37 female 3
LINE IN 1-8 SC for MADI LINE IN 9-16

37 male 1 RJ 45 for 37 male
LINE OUT 1-8 Ravenna LINE OUT 9-16

15 male [|15 female 50 Femala 5 male []15 female 37 male |round
AES3 AES3 Gl AES3 AES3 PHONES 1-4 |cables
OUT 1-4 IN 1-4 0uT 5-8 IN 5-8

1 2 6 5 3

Start with the two upper 37-pin D-Subs (2 & 3); then the two lower 37-pin D-Subs (1 & 4); then the
50-pin GPIO D-Sub (6); the four 15-pin D-Subs (1, 2, 5 & 3); and finally the 37-pin PHONES D-Sub
(no number, it is the only rounded connector).
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Some D-Subs are unlocked by loosening the two connector screws. Others unlock by moving the
sliding lock mechanism (use a small flat-bladed screwdriver to slide the mechanism carefully to
the left or right).

D-Sub Unlocked/Locked by Screws D-Sub Sliding Lock Mechanism

There are two versions of the /O carrier in the field, using different directions for the sliding lock
mechanism. You can verify the direction by looking at the position of the screws; when open, the
screws are not covered by the sliding part:

Version 1: To open, slide to the right Version 2: To open, slide to the left

4. Once all the cables have been disconnected and carefully stowed, loosen the local /O carrier
from the console frame. There are two nuts, one at the front (near the console arm rest), and one
at the rear (below the Overbridge).

The front nut should be removed completely and placed to one side. The front of the carrier unit
may now be lifted over the bolt, and if the rear nut is loose, the unit will slide forwards.

If the rear nut has been tightened, then you may need to loosen it by opening the Overbridge (see
Replacing a TFT display for how to gain access).

Front Nut Rear Nut
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5. Carefully remove the carrier by sliding it forwards and out of the console frame. Take care that
the frame does not scrape the unit, and that the cables do not get caught:

You are now ready to fit the replacement.

6. Check the replacement unit - all D-Sub connectors should be in their open position, and the
DIP switches set to ON (to enable remote control of headphone volume):

7. Slide the unit into the console frame (see step 5), taking care not to scratch the unit or get any
cables caught underneath. The unit should slide underneath the rear nut; fit and tighten the front
nut to secure (see step 4).

/O In mobile installations, such as an OB van or fly-away kit, the rear nut should also be
tightened. To access to the nut, you will need to open the Overbridge (see Replacing a TFT

display).

8. Replace the /O, master and power connectors (see step 3), making sure that you lock each
of the D-Sub connectors.

9. Replace the central panel, and fasten into place (see step 2).

10. If not already connected, replace the Nova73 connection (MADI or RAVENNA) and audio
connections on the rear panel of the console.

11. When everything is back in place, re-connect the rear mains IEC power connectors, and
power on. Then check the functionality of the local I/O.
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Adjusting the Local I/O Jumper Switch Positions

The local /O connector board includes four adjustable jumper switches (JP 1,2 and JP 3,4) which
determine two settings: the choice of "internal talkback mic source" and the connection to Line input
16. See Jumper Switch Positions for an overview.

To adjust the switch positions:

1. Remove the Central GUI's TFT display to gain access to the local /O connector board:

The following reference diagram can be found on the cable duct to the right of the local /O board
(beneath the central panel):

Connector Board in Qverbridge

I 1 | ey W
D> E PED
[<]
1
LINE IN 16 from O JP 34 o 8 ? o 0-Sub 9pol from
O[o0] E Ol3 18K M
1 2 3 - Default setting I
D-Sub  TBK Mic shown P12

2. Locate the correct pair of jumper switches: either 3 & 4 (JP 3,4) or 1 & 2 (JP 1,2) - the
locations and default positions are shown above and below:

Jumpers 3 & 4 (adjust Line In 16) Jumpers 1 & 2 (adjust the TBK source)
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3. Ineach case, take care to move BOTH jumpers to change a setting:

e Jumpers 3 & 4 = position 1, 2: Line input 16 comes from the talkback source (the default
setting).

e Jumpers 3 & 4 = position 2, 3: Line input 16 comes the LINE IN 9-16 connector.

e Jumpers 1 & 2 = position 1, 2: Internal talkback comes from the standard talkback mic
preamp.

e Jumpers 1 & 2 = position 2, 3: Internal talkback comes from the optional 962/16 talkback mic
preamp.

For more details on the options and signal flow, see Local /O Wiring.
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Trouble-shooting

Introduction

This section includes a series of example problems and tips to help you fault find the mc256 MKII
system.

9 For further assistance, please contact your local Lawo representative or the service
department at service@lawo.com.

e The system will not boot or does not boot correctly

e The system boots up but | have no audio

e The complete control surface is not responding

e One of the control surface panels is not working

e The graphics on the TFT displays freeze temporarily

e The graphics on one of the displays freezes or looks odd

¢ The network connection between my computer and the control system is not working

¢ Running a PING test (to check network communcation)
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The system will not boot or does not boot correctly

The system will not boot or does not boot correctly
1. Power off the Nova73 and wait for the system to shutdown.
The system has completed its shutdown when the blue LED of the trackball is off.
2. Power onto try a warm start.
3. [Ifthis is unsuccessful perform a cold start.

If the system now boots correctly, then your warm start user data is corrupt. Check your production
data by loading a production. If this is the cause of the problem, perform another cold start and try a
different production. If there is a problem with all production data, then you may need to replace the
Data Flashcard.

4. If this is still unsuccessful, then you should try replacing the System Flashcard with a backup
copy.
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The system boots up but I have no audio

The system boots up but | have no audio

1. Checkthe System Settings display to see if there any reported errors.

If a Nova73 module or DALLIS I/O card is shown in red, then there is a problem with the connection or
module/card.

2. Check the connections between the Nova73 /O module and any DALLIS units.
Are the fibres reversed?

3. Check that all the ACTIVE LEDs on modules within the Nova73, and cards within the DALLIS,
are green and flashing synchronously.

The ACTIVE LED on each Nova73 module, or DALLIS card, should blink in time with all other ACTIVE
LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the system. If
an LED is out of sync, then check that the card is fitted correctly, and if the symptom persists,
replace the card.

4. If everything still looks ok, then try reloading the DSP configuration from the DSP
Configurations display.
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The complete control surface is not responding

The complete control surface is not responding

1. Check the Ethernet A connections between the control surface and Nova73 Router Module.

2. Ifmain and redundant Router Modules are fitted to the Nova73, try forcing a manual_takeover
to the redundant control system.

3. Ifnot, power off the Nova73 and wait for the system to shutdown. And power on to try a warm
start.
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One of the control surface panels is not working

One of the control surface panels is not working
1. Tryrestarting the Ethernet Bay Server.
2. Carefully remove the panel, and check the connections.
3. Trydisconnecting and reconnecting the USB and power connectors to the panel.

Try this a few times to see if the panel will boot. If not, then the panel may be faulty so please contact
your local service representative.
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The graphics on the TFT displays freeze temporarily

The graphics on the TFT displays freeze temporarily

This may occur if the load on the CPU exceeds 95% - for example, during a production load. Audio
processing is unaffected, and therefore the behaviour should be ignored. Once the production has
loaded, and the CPU returns to normal levels of operation, all graphics should update correctly.
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The graphics on one of the displays freezes or looks odd

The graphics on one of the displays freezes or looks odd
This may occur if a Bay Server looses its Ethernet connection to the Control System.
1. Tryrestarting the Ethernet Bay Server.

If the problem persists, then the display or Bay Server may be faulty so please contact your local
service representative.
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The network connection to the control system is not working

If you cannot establish network communication between your computer and the control system:

1. Check the network connection and TCP/IP settings of your computer's network interface card.

2. If applicable, check that the software you are running is compatible with the mc? system.
When connecting from mxGUI or AdminHD, the first three digits of the software versions must
match.

3. TryaPING command to test whether you have a valid network connection:

¢ [f the ping test fails, then there is something wrong with your network configuration.

¢ |f the ping test is successful, then this confirms that the network communication is working. If
you still cannot connect to the mc256 MKII control system, then something on your computer
is blocking the network connection. Try disabling any firewall and/or antivirus software.
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Running a PING test

The PING command is a built-in Windows and Mac function, that allows you to test whether you have
a valid network connection to and from any networked device.

1. Make sure that your computer is connected to the Lawo system network, and that you have
configured the TCP/IP settings of your computer's network interface card.

2. On a Windows 7 PC, type cmd into the "Search programs and files" field under the Start
menu and press Enter.

i o y
:;},J Windows Fax and Scan rograms (2)
R EN cnd

5 CmDust

> AllPrograms

| Search programs and files o | (3 - See more results

|cmd| % | | Shutdown | » |

This opens the DOS command prompt window:

B C\Windows\system32iomd.exe —

Microsoft Windows [Uersion 6.1.76811
Copyright (c> 2087 Microsoft Corporation. All rights reserved.

C:~Users Suex_

Alternatively, on a Mac, open the Terminal program (found in the Applications -> Utilities folder).
3. On both platforms, perform the ping test as follows:

Type ping XXX.XXX.XXX.XX (where xx.. is the IP address of the device you are trying to connect to)
and press Enter.

You can check the IP address of your control system from the console GUI (using the Signal Settings
display). See also TCP/IP Addresses for a list of the default IP addresses for different Lawo products.

For example, to test the connection to a mc256 with a default IP address, you would type:
ping 192.168.102.56

Your computer will nowtry to establish communication...
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» Ping Test Fail

If the ping test fails, then the request will time out, and you will not receive any successful packets:

=% C:\WINDOWS\system32\cmd. exe I HE ﬂ

Microsoft Windows XP [Version 5.1.260881
(C» Copyright 1985-2001 Microsoft Corp.

C:\Documents and Settings“Sue McDonald>ping 192.168.161.248

Pinging 192.168.101.248 with 32 hytes of data:

timed out.
timed out.
timed out.
timed out.

Ping statistice for 192.168.161.240:
Packets: Sent = 4, Received = B, Lost = 4 {188+ loss).

C:\Documents and Settings\Sue McDonald>

There is something wrong with your network configuration, so check the network connections, and
TCPI/IP settings again. Or contact your network administrator.

» Ping Test Success

If the ping test is successful, then the result will show that the Sent packets have been successfully
Received:

C:AWINDOWS\system 3 2\emd.exe
Microsoft Windows XP [Uersion 5.1.26881]
<G> Copyright 1785-20801 Microsoft Corp.
C:“\Documents and Settings“8ue McDonald>ping 1%2_.168.2 .1
Pinging 192.168.2.1 with 32 bytes of data:

Reply from 192.168.2.1: bytes=32 time=Ltms TTL=255
Reply from 192.168.2.1: bytes=32 time=2ms TTL=255%
Reply from 192.168.2.1: bytes=32 time=1ms TTL=255
Reply from 192.168.2.1: bhytes=32 time=25ms TTIL=255

Ping statistics for 1%22.168.2.1:

Packets: Sent = 4, Received = 4, Lost = B <(Bxz loss).
fipproximate round trip times in milli-seconds:

Minimum = ims, Maximum = 25ms. Average = Bms

C:\Documents and Settings“Sue McDonald>_

This confirms that the network communication is working. If you still cannot connect to the mc256
MKII control system, then something on your computer is blocking the network connection. Try
disabling any firewall and/or antivirus software.
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Control Surface

Frame widths from 16 to 80 faders.
Remote stand-alone extender frames from 16 faders.
6 banks each with 2 layers.

100mm fader + two freely adjustable rotary controls (Free Controls) + Input-Gain rotary control
+ Channel GUI display for each fader.

TFT display: mono, stereo or up to 7.1 metering + bus assignment + gain reduction for
dynamics + AfV status + VCA assignment + Mix Minus bus assign.

External display of GUI pages (via mxGUI), e.g. metering.
Fader colour coding, reset via snapshots.

Fader notch and PFL overpress (Backstop PFL).

12 channel user buttons.

9 central user buttons.

Optional: one integrated user panel (automation, 40 user buttons, reveal fader surround or
intercom), RTW goniometer integration, script tray.

Signal Processing

888 channels + 144 summing busses, 40bit floating point.*

Up to 760 inputs with A/B input, up to 64 sub-groups, 32 aux sends, up to 96 track busses, up
to 48 main sums.*

Rapid switching of channel and bus to mono/stereo/surround.

Up to 96 surround masters + 128 VCA groups with metering + 256 GPCs (General Purpose
Channels).

Surround formats: DTS/Dolby ® Digital 5.1, Dolby ® Prologic 4.0, DTS ES/Dolby ® EX 6.1,
SDDS 7.1 or DTS-HD 7.1. Diverse panning characteristics + surround aux bus.

2 AFL: 1 surround 8-channel + 1 stereo.
2 PFL, both stereo.

Audio-follow-Video with 128 events, controlled via RemoteMNOPL, GPI or matrix connection.
Envelope adjustable up to 10s fade time.

Solo in place (enabled/disabled from System Settings display).

Permanent input meter beside fader + adjustable INPUT, PF, AF, DIROUT meter point in
Channel display.

Loudness Metering according to EBU R128 and ATSC A/85, momentary or short term in every
channel, integrated measurement on sum channels with display of integrated LUFS value in
the Central GUI headline.
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¢ Processing Modules**: INMIX with MS decoder, digital amp (DAMP), 2-band fully parametric
FILTER, 4-band fully parametric EQ, 2-band fully parametric side chain filter (SCF), INSERT,
DELAY up to 1800ms (switchable to metres, milliseconds or frames), 4 independent dynamic
modules: EXPANDER, GATE, COMPRESSOR, LIMITER, stereo IMAGE, METER point, and
DIRECT OUT.

e AMBIT Upmix, available on every 5.1 channel, fully Downmix compatible.
¢ Inline configuration, with per channel or global send/return switching.
¢ Fully-equipped surround channel with coupling of all channel parameters and hyperpanning.

* Figures are for a Nova73 HD fitted with 8 DSP boards running at 48kHz. At higher sample rates, the
number of channels and summing busses is halved.

** The processing modules listed are for a Recording channel. Broadcast channels offer less
processing modules in return for twice as many channels.

See Channel Types for more on the differences between Recording and Broadcast channels.
Routing Matrix

e Up to 8192 cross points, non-blocking.

e Up to 96kHz, 24-bit. (Higher sample rate operation is defined by AdminHD).

¢ Fully redundant signal path.

¢ Level adjustment for all inputs and outputs.

e Downmix from surround (up to 7.1) to stereo.

¢ Integrated monitoring devices for remote locations, e.g. director's room.

e Full networking of up to 16 systems, share and import sources and destinations, studio
intervention.

¢ Full snapshot and production portability independent of matrix and DSP size.

e Level control for every input and output.

Plug-in Server

e Full VST plug-in integration with storage of plug-in parameters in snapshots and production
data.

Static and Dynamic Automation
e Snapshot automation.
e Sequence automation with trim and cross fade.

¢ Dynamic timecode-based automation for all parameters including bus assign. Modes include
touch, glide, join, punch in/out and absolute/trim (including trim "on the fly").

e Offline timecode automation editing (copy, paste, delete, cut, insert, etc.)

324 V5.0/1 mc256 MKIl Technical Manual



Technical Data %

Interfaces

Mic/Line, Line Out, AES, 3G SDI, MADI, ATM, GPIO, Serial, MIDI. (For details, see DALLIS
product information.)

Stereo and surround monitoring systems.

Local /O within console frame: 16 Line /O, 8 AES I/O, 8 GPIO, 2 Headphones.

Synchronisation

2 redundant sync inputs with automatic Blackburst, Wordclock, AES 3, MADI detection.

Redundancy

Redundant PSUs (standard).
Redundant DSP board (defined in the DSP Configurations display).

Optional Redundant Router card provides redundant routing matrix and control system,
exchangeable during run time, with full data redundancy.

Optional Redundant DALLIS cards offer fully redundant signal paths.

Control Features

Bay Isolate (ISO BAY) with separate bank and layer switching + second PFL/AFL bus.
Global A/B input switching.

Enhanced mix-minus control with independent off-air conference.
Direct out mute by fader.

Fader control of all level parameters.

Diverse tally and fader start modes.

Program switch.

Machine control.

Audio-follow-Video, up to 128 camera tallies, Ethernet or GPI controlled.
Extensive talkback system integration.

Camera mic remote via GPI or voltage control.

Remote desktop access from TFT to external computer.

mxGUI: remote control of GUI pages via external computer.

iPhone App: remote control of fader level, monitoring and snapshots.

Remote Maintenance

Connection via Internet remote software.

Software updates, error diagnostics, remote assistance.
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External Control Systems

¢ Remote control of all routing parameters via network.
¢ Remote control of monitoring units in remote locations.
e Remote control of integrated matrix monitoring units.

¢ Remote control of signal parameters such as SDI, silence detects, mic gain, etc. (for details,
see the Remote MNOPL documentation).

e Online configuration with AdminHD, graphical configuration of Nova73 and DALLIS
components.

e External matrix controllers: VSM, Evertz, Quartz, BFE, Pharos, and others.

e EmBER+ control protocol (available 2013).
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Appendices

This section includes the following appendices:

System Part Numbers

Control Surface Options

Nova73 Compact

Nova73 Module Options

DALLIS Interface Options

Local /O Wiring

DSP Configurations

SDI| Parameters

GNU Public License

Control System Locations

TCP/IP Addresses
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System Part Numbers

The following part numbers will help you locate data sheets for the principle system components:

System Component Part Number
mc256 MKIl Frame: 16C 959-09
16 + 16C 959-10
16 + 16C + 16 959-11
32+ 16C + 16 959-12
32+ 16C + 32 959-13
Extender (16-fader) 959-22
Control Surface Modules: Fader Panel 958-10
Central Panel 958-20
Channel Display 958-13
DALLIS Unit Frames: 3RU DALLIS Frame 940-30
6RU DALLIS Frame 940-60
Nova73 HD Frame 10RU Nova73 HD Frame 980-02
Nova73 Compact Frame 7RU Nova73 Compact Frame 980-06

See also Control Surface Options, Nova73 Module Options and DALLIS Interface Options.
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Control Surface Options

This section summarises the main control surface options. For more details, please refer to the
relevant data sheet, available in the "mc2_Nova73 documentation” guide.

See also Installing the Control Surface and Service/Maintenance: Control Surface.

Note:

e Monitoring, Headphones, External Metering & Talkback - the local /O, integrated within
the control surface, provides audio connections for monitoring, headphones, external metering
and talkback. Therefore, there is no need to specify these as additional options. See Local_IO
Wiring for details.

e 19" Integration/User Panels - there are no 19" or USER panels (other than those permitted

in the Overbridge).

e Power Cables - country-specific power cables are supplied for all system components.
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Frame Layouts

The mc256 control surface comes in a range of predetermined frame sizes. Any frame may be
expanded by fitting stand-alone extenders:

16+16C+16

\\ i =

16C

Extender
w‘.‘l\\\i\\'\\'\\'\\\\\\-\ .

Frame Layout Part Number
16C 959-09
16+16C 959-10
16+16C+16 959-11
32+16C+16 959-12
32+16C+32 959-13
16 Fader Extender 959-22

Ethernet and PSU connecting cables are available in a variety of lengths and must be ordered
separately.
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By default, frames come fully-fitted with the appropriate control surface panels:

Control Surface Panel Part Number
Fader Panel (1 per 16-fader decentral bay) 958-10
Central Panel (1 per console) 958-20
Channel display (1 per bay) 958-13

You may fit dummy panels within a frame, to reduce the initial cost of the system, and allow for future
expansion.
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Control Surface Options

Frame Version

Two different frame versions are available, designed for either studio or OB van installation.

The version affects the side panels fitted to the console. You should specify the OB version for
narrow side panels and a reduced console width:

Option Part Number
Studio Side Panels 959-30
OB Van Side Panels 959-31

Please see Dimensions and Weight for details.
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Stand

Optionally, the console may be delivered with a stand:

Option

Part Number

Console Stand

959-32
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Overbridge Options

Space is available in the Overbridge to fit either RTW metering (shown above) and/or a Lawo User
Panel.

The permitted variations are:

Part Number |RTW User Panel Fitted

958/90 No No Blank Panel

958/91 Yes No TM 9 (shown above)
958/92 Yes Yes TM 7 + User Panel
958/93 No Yes Blank Panel + User Panel

When the RTW TM 7 or TM 9 are fitted, they connect to the AES3 in/out 5-8 of the local I/O.

The default configuration usually sets the RTW to automatically follow the CRM 1 monitor source
selector.
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The Overbridge User Panel options are:

Part Number |User Panel Description

962/29 REVEAL FADER 5 dedicated faders for revealing surround slaves.

962/14 USER KEYS 40 user buttons configured from the Custom Functions
display.

962/16 INTERCOM integrated loudspeaker and internal talkback microphone,
see Local /O Wiring.

962/18 AUTOMATION timecode automation controls.

962/15 USER CONTROLS |8 rotary controls defined by the factory configuration.

REVEAL FADER

USER KEYS

[_LAEEl [_LEESL | [__L4EEL J |_LAEEL ]

GLOBAL CONTROL

AUTOMATION MODE ‘ STEPOUT MODE

b )
PUNCH
_cesonss@m@
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Local I/O Connection

The local_I/O board, integrated within the control surface, is available in two versions; the version
determines the connection to/from the Nova73:

Option Part Number
Local /O (MADI) 958-55
Local /O (RAVENNA) 958-50

You will need to reserve one MADI, or one RAVENNA, port within the Nova73 for this connection, see
Nova73 Module Options.
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Control Surface Options

Console Keyboard

The console keyboard is available in English or German:

Option Part Number
English Keyboard 956-23
German Keyboard 956-24

Please see Console Keyboard Driver Installation for details on how to change the language version.
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Script Tray

Optionally, one or more removable script trays may be fitted:

Option Part Number

959-41

Removable Script Tray

290

97—
92 ——=

226

340

616

Maximum allowable weight: £0N
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Control Surface Options

Recording Com Kit

The optional Recording Com Kit provides Sony 9pin (P2), LTC and MIDI connections to an external
playback device.

Option Part Number
Recording Com Kit (P2, LTC, MIDI) 958-80

Machine control functions may be mapped onto user buttons from the console's Custom Functions
display, or handled from the optional machine control panel, mounted externally from the console.

For more details, please see the "Technical Documentation: Recording Com Kit", available from the
Download-Center after logging in at www.lawo.com.

mc256 MKIl Technical Manual V5.0/1 339


http://www.lawo.com

% Appendices
Nova73 Compact Core

Nova73 Compact Core

The Nova73 Compact offers an alternative to the Nova73 HD for space-restricted installations:

Nova73 HD (10RU) Nova73 Compact (7RU)

Operationally, the two cores are identical, and share the same Router, DSP and /O Modules. A
second Router_Module may be fitted for redundancy. And either core may operate stand-alone or
within a larger networked system.

The key features and differences are:

Nova73 HD Nova73 Compact
Width 19”
483mm (front plate)
440mm (chassis)
Height 10RU 7RU
Weight 16.25 Kg (one PSU fitted) 14.5 Kg (two PSUs fitted)
Depth 510mm 489mm
Max. number of DSP + /O Modules |16 10
(8k? capacity router at 48kHz) |(5k? capacity router at 48kHz)
Max. number of DSP Modules 8 5
Max. number of AES Modules 8 2 (fitted in slots 2 and 6)
Redundant Power Supplies optional standard
Redundant Router Module MKII optional optional
Configured using AdminHD Yes Yes
Support for Dual Self-Healing Star | Yes No

To achieve its smaller footprint, the Nova73 Compact utilises a different frame (980/06), with front-
mounted plug-in power_supply modules (980/27) and rear-mounted fan_units (980/28). The frame
comes fitted with rear connector panels for any front-mounted AES modules (in slots 2 and 6).
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Nova73 Module Options

Nova73 Module Options

The following tables summarise the Nova73 modules supported in this release of software. For more
details, please refer to the relevant data sheet, available in the "mc2_Nova73 _documentation” guide.

See also Installing the Nova73 Plug-in Modules and Service/Maintenance: Nova73.

Nova73 Plug-in Module Options
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(MKII) MADI SMF

/Q Not every I/O or DSP module can be used in every slot so it is best to check your
configuration within AdminHD before fitting the physical modules.

/O One MADI, or ATM, port is required to provide the Port DSP resources used for the
console's monitoring (Listen surround and Listen stereo). Therefore, you must fit at
least one MADI, or one ATM, module to the Nova73.
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Central Router Modules
980/33 ROUTER MKII|Routing matrix (8k? at 48kHz, or 4k? at 96kHz) and integrated control system.

I/O Modules

981/02 AES3 + MADI |32 inputs and 32 outputs AES/EBU (via D-Sub or BNC rear connector panel);
1 port MADI (optical, multi-mode fibre)

981/31 MADI 2 ports MADI (optical, multi-mode fibre)

981/38 MADI 8 ports MADI (optical, multi-mode fibre)

981/32 MADI 2 double ports MADI, redundant fibre (optical, multi-mode fibre)
981/36 MADI 6 double ports MADI, redundant fibre (optical, multi-mode fibre)
981/41 MADI 2 ports MADI (optical, single-mode fibre)

981/53 ATM 3 ports ATM (optical, multi-mode fibre)

981/56 ATM 6 double ports ATM, redundant fibre (optical, multi-mode fibre)

981/61 RAVENNA 4 ports RAVENNA (CAT 5 Ethernet and SFP option for single or multi-mode
optical fibre); the port configuration and redundancy are configured by
AdminHD. See RAVENNA Interfaces.

DSP Modules
983/02 DSP 24 24 channels for the mc? series mixing consoles.

983/03 DSP 48/24 * |48/24 DSP channels for the mc? series mixing consoles: 48 channels at
48kHz; 24 channels at 96kHz. (The 983/04 is a later revision of the 983/03
supporting identical features.)

983/06 DSP IOSONO|For project-specific applications, please check your system specification.

* The 983/03 (or 04) DSP module may be configured for different applications by changing the
AdminHD configuration and updating the module’s firmware:

e 983/03 DSP 48/24 - DSP channels for the mc? series mixing consoles, see DSP
Configurations.

e 083/03-077 mxDSP - DSP paths for the routing matrix, see mxDSP Configuration.

e 983/03-060 DSP WFS (mix), 983/03-061 DSP WFS (filter) and 983/03-062 DSP spatial mixer
- for project-specific applications, please check your system specification.
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Nova73 Rear Connector Panels

The Nova73 HD supports two types of AES3 rear_connector panel: the 980/14 (D-Sub) and 980/15
(BNC).

Pin-outs for the Nova73 Compact AES3 rear connectors are identical to the 980/14.

980/14 Connector Panel D-Sub
e OQutputs: 4 plugs D-Sub 25-pin, each with 8 balanced contacts 110 ?

¢ Inputs: 4 plug sockets D-Sub 25-pin, each with 8 balanced contacts 110 ?

O
Gonnector Panel
980/14 D-Sub
AES3
|” (balancad, ||
110 Ohm)
O
For pin asslgnmeant
consult manual
Inputs
1.8
I =N
Qutputs 1...8 l U Inputs 1...8
- o
L -
I o1 I
AESS Out e} AESS In
Sub—D 25p male Sub=0 2Z5p fernale
Connector View Connector View
Channel: Channel:
ez Outputs 9...16 _ Inputs 9...16 A
. 1 Ll 13,
nHe o U\_ T - —ano
150 n+1 5T T
7y 11 30 ,
RN PN T) S I G B
n+6 1] a7 o ” ” e J _{,77‘0
I“_—ij = o nes B \'I(_ B
5 5
[ 17..24 [ERSEETY P e
n+a o] i ao @] A/__owgl;
— 0
o? 5 i N
n+3 ] 9, I
R X 7 -
U | b Outputs 17...24 Inputs 17...24 nes T
b LS AT > <+ b T 3
—C
+1 il "Au I I n+7 T s
B o v i i
3, n+8 I 1
B - e [
a=hat, + = a=hat, + -
b=cold, - 25..32 b =cold, -
Outputs 25...32 | . Inputs 25...32
> <
O
O
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980/15 Connector Panel BNC

e Qutputs: 32 BNC connector, unbalanced contacts 75 ?

¢ Inputs: 32 BNC connector, unbalanced contacts 75 ?

Outputs 1...8

Outputs 9...16

Outputs 17..24

Outputs 25...32

AES3

1
980/ 15 BNC
“ (unbalanced, 75 Ohm)

Inputs

W@@@@
000

W@o@@‘

{CRORCROR

1(2) @) @ G

v (1) (9 (9 @
d

Inputs 1...8

4
%
|

Inputs 9...16

-

Inputs 17...24

-

Inputs 25...32

ICHORONOE

e @@ 0|,

<
|
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DALLIS Interface Options

DALLIS Interface Options

The following tables summarise the DALLIS interfaces supported in this release of software. For
more details, please refer to the relevant data sheet, available in the "mc2 Nova73 documentation”
guide.

See also Installing the DALLIS Plug-in Cards and Service/Maintenance: DALLIS.

3RU DALLIS (example configuration)

ZZEEZE e e e Z 2 m oE e
Pl A A e g Wrirr| Al 2=, s\
d d d d deice doca ﬁ &
| o o @
® alElE .9, ® o 3
i oo ;
1o Ee®® |
9“-“'|o>““'u>"“'|9'u}n> o & & o o o o4 o el 5

Not every interface card can be used in every slot. As a general rule, if an interface card is
permitted within AdminHD, then it can be fitted to your system.

ke

The type of DALLIS master board, and hence the connection, determines the maximum
number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128
(RAVENNA).

-

The Maximum Analogue Level of the whole system is defined by the DALLIS card with the
lowest GDA (General Device Address) - this is the card with the lowest address fitted to
the DALLIS frame connected to the lowest port number of the first Nova73. (If a different
fixed level analogue card is fitted elsewhere within the system, then a warning appears in
the log file; however, the card with the lowest GDA still wins.)

ke

DALLIS Master Boards Connects to:
947/05 MADI 1 port MADI (optical, multi-mode fibre) 981/02, 31, 38
947/07 MADI 2 double ports MADI, redundant fibre (optical, multi-mode fibre) 981/32, 36
947/15 MADI 1 port MADI (optical, single-mode fibre) 981/41
947/03 ATM 1 port ATM (optical, multi-mode fibre) 981/53, 56
947/21 1 port RAVENNA (CAT 5 Ethernet and SFP option for single or 981/61
RAVENNA multi-mode optical fibre). See RAVENNA Interfaces.
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DALLIS Interface Options
DALLIS I/O Cards Part Number & Connector Type
Analogue D-Sub XLR BNC Inputs | Outputs
Mic/Line (trafo-balanced) 941/52 941/62 - 4 mono -
Line in (trafo-balanced) 941/02, 04, 06 |941/12, 14, 16 |- 4 mono -
Line out (trafo-balanced) 942/02, 04, 06 [942/12, 14, 16 |- - 4 mono
Mic/Line (elect-balanced) 941/51, 53, 55 |- - 8 mono -
Line in (elect-balanced) 941/84, 86 - - 8 mono -
Line in/out (elect-balanced) |941/83, 85 - - 8 mono 8 mono
Line out (elect-balanced) 942/84, 86 - - - 8 mono
DALLIS I/O Cards Part Number & Connector Type
AES3 D-Sub XLR BNC Inputs | Outputs
AES3in (SRC) 943/02, 03 943/12, 13 - 4 stereo |-
AES3in (SRC) Hi-Z'Thru 943/01, 84, 85 |- - 4 stereo |4 thru
AES3 infout (SRC in) 943/52, 53 - 943/72, 73 4 stereo 4 stereo
AES3 in/out (SRC in/out) 943/54, 55 - 943/74, 75 4 stereo 4 stereo
AES3 out 944/01, 02 944/11, 12 - - 4 stereo
DALLIS I/O Cards
Special Part Number [Description Connector Type
Headphones 942/61 4 stereo headphone outputs |1 x D-Sub
Intercom (Riedel interface)  (943/81, 82 4 AES3 in/out 4 x BNC (bi-directional)
Optical Switch 945/61 Optical to BNC change-over (2 xBNC: 1in, 1 out
switch for MADI or ATM. 3 x MT-RJ
ADAT in/out 946/31 8 channel ADAT interface 2 X ADAT: 1in, 1 out
IP Codec 946/34 Real-time audio streaming 1 x RJ45 (Ethernet)
over IP: up to 2 channels sim |1 x RJ45 (RS232)
encode/decode
RAVENNA (Audio over IP) 946/41 8 channel RAVENNA 1 x RJ45 (Ethernet)
interface. 1 x SFP (optical fibre)
Phantom Power 947/10 48 V supply for transformer- [n/a
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DALLIS I/O Cards

GPI Part Number |Description Connector Type
GPl/Opto Relays 945/01 8 opto-coupler in; 8 relay out |1 x D-Sub
GP1l/Opto/VCA Relays 945/05 8 opto-coupler in; 8 relay out; |1 x D-Sub

4 VCAIn

DALLIS I/O Cards

Part Number

Audio de-embedder /

Connector Type

SDI embedder

3G/HD/SD SDI 946/17 up to 8 AES3 in/out (stereo) |4 x BNC: in, thru, 2 out
2 x D-Sub: metadata

HD/SD SDI 946/13 up to 4 AES3 in/out (stereo) |4 x BNC: in, thru, 2 out

SD SDI 946/09

HD/SD SDI 946/05 up to 4 AES3 in/out (stereo) |3 x BNC: in, thru, out

SDI SDI 946/01

DALLIS I/O Cards

DSP

Part Number

Description

Connector Type

Summing matrix

947/41, 42

8 infout internal summing
matrix with signal generator

n/a

DALLIS I/O Cards

Data Part Number [Description Connector Type
RS422 945/21 4 bi-directional data ports for (4 x RJ45

RS422
Serial Data 945/22 4 bi-directional data ports for (4 x RJ45

RS232, RS422 or MIDI
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Local I/O Wiring

The following diagrams illustrate the wiring, pin-outs and default jumper switch positions for the local I/
0.

Note that AES IN 5-8 and AES OUT 5-8 connect to the RTW meter if either of the TM 7 or TM 9
Overbridge options are fitted.
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Local I/0
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Local I/O Jumper Switch Positions

LINE IN

9-16 —|

Channel 1-7

Channel 8

Channel 8 T
Z
3:) P 3k

W
™
E
a
e
-
e

LINE IN 9-16

N

- 1
preamp
1] .
TBK Lay iz
MIC Phantom

integrated Limiter

=

LINE OUT
TBK MIC

9 | LINE IN SPEAKER

DE%<}ﬁ

b
o
| ChriMute ] =
e 1s? D |959/05-51 Line Comector bosrd |
962/16
optional
- _ _ _

There are four jumper switches on the local I/O connector board, which control two settings:

e JP 3,4 - set the connection to the Line input 16 A-D converter. This can be taken from:
0 an "internal talkback mic preamp" (set by JP 1,2).
o the LINE IN 16 connection from the rear panel.
e JP 1,2 - set the "internal talkback mic preamp" to:
o the integrated talkback mic preamp (fitted as standard).
o the talkback mic preamp fitted to the optional 962/16 INTERCOM user panel.

Note that the JP 1,2 switch positions affect both the connection to the Line input 16 A-D converter,
and the line level talkback output available via the TBK connector.

The factory default positions, shown above, support talkback via the integrated talkback mic preamp.
You may need to adjust the jumper switches if:

e the 962/16 INTERCOM user_panel is fitted. Move JP 1,2 to connect talkback from the
INTERCOM panel's talkback mic preamp.

e you are using an external talkback source, and wish to "free up" Line input 16 for another
application. Move JP 3,4 to connect Line input 16 from the LINE IN 9-16 connector.

Please see Adjusting the Local /O Jumper Switch Positions for details.

For more details on the 962/16 INTERCOM user panel, please refer to the relevant data sheet.
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DSP Configurations

DSP resources are allocated using DSP configurations.

Please note that the variation with 1 DSP board includes: 1 x stereo PFL; 1 x stereo AFL.

All other variations include: 2 x stereo PFL; 1 x stereo AFL; 1 x surround AFL (7.1).

Higher sample rates use twice as much DSP resource as lower sample rates.

More channels, from the same DSP resource, become available if you use Broadcast channels.

For further details on the variations available, we recommend installing mxGUI and viewing the DSP
Configurations display.
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SDI Parameters

AdminHD can define a number of parameters for the SDI Card, SDI Signal In and SDI Signal Out. The
parameters are what the system resets to after a cold start. Users can change these parameters
later from the GUI.

The parameters are similar to those on the mc? GUI's Signal settings display, and vary depending
on the type card:

e SDI Parameters (3G SDI Card)

e SDI Parameters (non 3G SDI Cards)
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SDI Parameters (3G SDI Card)

The DALLIS 3G/HD/SD SDI card (946/17) is a multi-rate SDI card with BNC input, thru and two
outputs. It contains an audio embedder and de-embedder for up to 16 audio channels, and a VANC
embedder and de-embedder for two independent Dolby E Metadata streams. There is onboard video
and audio delay, and an integrated sample rate converter. It occupies two DALLIS card slots and may
be configured to run in a number of different modes using AdminHD.

Further information can be found in the data sheet, available in the "mc2 Nova73 documentation”
guide.

Note that SDI signals have parameters for both the signal and the card. The SDI parameters are
adjusted by selecting the card:

1. Select the 946/17 card from the System tree.

2. Then select one of the four parameter tabs:

Settings

Insert Send 4G501 Embedder De-Embedder Metadata

X

AES
~  Card 1 LINE
i card 4 AES3

b Card 5 SDI El Auto

i Card 7 SDI G eri Black frame

: Destination

v3 signal out 4

-

Note that SDI card parameters may be adjusted whether the card is local to the system, or fitted to a
remote network partner.

Note that SDI parameters are never stored by snapshots. From Version 4.8.0.2 onwards, they are
stored and recalled by productions. You may use the Global isolate of SDI parameters custom
function to isolate SDI parameters so that settings are not affected by a production load.
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3G5D1 Embedder De-Embedder Metadata

SRC

Enable video delay

e SRC - check this option to enable sample rate conversion. Note that SRC is applied to all
channels on the card. Normally, SRC should be enabled. If SRC is off (unchecked), then the
system must be clocked to the same reference as the sending device.

e Enable video delay & Video delay (frames) — this option applies a delay to the SDI data from
the de-embedder to embedder. Video and audio containted in the stream are delayed by the
same amount. Set the amount of Video delay in steps of 1 video frame.

¢ \ideo generator mode, format & test pattern — the SDI card is equipped with a free-running
video test pattern generator. Set the mode to either:

0 Auto - if the input is locked to an incoming video signal, then the output will automatically
track the format of the input. If the input fails, then the video test pattern generator transmits
the last received video format. When the SDI module is part of a SDI chain, this option is
recommended.

o Force On —in this mode it is assumed that the card is used as a video master and that no
SDI input signal is applied. The test pattern generator is forced on all the time. Use the
Video generator format and Generator test pattern options to define the video signal. In
this mode the embedder sample rate is derived from the generator, and the SDI receiver is
switched off. Note that the de-embedder cannot be used.
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Embedder

3GSDI [Embedder De-Embedder Metadata

Clean
Embedder grp. 1 enable
SDI grp. 1/ ch. 1 source

SDI grp. 1 / ch. 2 source

SDI grp. 1/
Embedder grp. 2 enable
P
.25
.38
DALLIS
X
DALLIS
DALLIS
DAL
DALLIS signal ov

Embedder grp. 4 enable X

e Clean — check this option to set the embedder mode to “Clean”. In this mode the incoming
audio stream is deleted and a new data structure generated according to your embedder
settings. Note that if you select this mode any existing audio data will be lost.

e Embedder Group Enable — audio is embedded in groups of four channels into SDI. There is
a total of four groups per SDI, resulting in 16 audio channels. For each group, this checkbox
determines whether the incoming SDI stream is replaced:

o Enable the checkbox to replace the audio group content.
o Disable the checkbox to leave the audio group untouched.
If there is no audio at the SDI input, then a new audio group will be generated.

Note that in AdminHD modes 16/0 and 8/0, all embedder group enables are turned off as the whole
embedder section is bypassed.

e Embedder source 1to 16 — use these options to define the source for each embedder.
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De-Embedder

3GSDI Embedder De-Embedder Metadata

lin 1 source
DALLIS sig E 5DI grp.
DALLIS sig 3 & SDI grp.
DALLIS signal in 4 source SDI grp.
DALLIS signal in 5 source SDI grp. 2 [/ ch
DALLIS signal in 6 source
DALLIS s

DALLIS s

DALLIS signal in 9 source

DALLIS signal in 10 source
DALLIS signal in 11 source
DALLIS s
DALLIS s l'in 13 source
l'in 14 source
DALLIS signal in 15 source SDIgrp. 4/ ch. 3

DALLIS signal in 16 source SDI grp. 4 [ ch. 4

e DALLIS signal in source 1to 16 — use these options to define the source for each de-
embedder.
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Metadata

3GSDI Embedder De-Embedder Me
Metadata de-emb. to port 1
Metadata de-emb. to port 2

Metadata emb. from port 1

Metadata emb. from port 2

Metadata embedder mode Auto

Metadata embedder line Line 11

The SDI module offers 2 metadata ports according to SMPTE RDD-2008. This allows embedding,
de-embedding and transport of two independent Dolby metadata streams alongside with the video.
The streams can be accessed via two D-Sub connectors at the front panel.

e Metadata de-emb. & emb. to port 1, 2 - use these options to define the streams for the
Metadata ports.

¢ Metadata embedder mode & line — set the mode to Auto to track the input, or select Pre-
selected line and define a Metdata embedder line.
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SDI Parameters (non 3G SDI Cards)

The DALLIS HD or SD SDI cards (946/13, 09, 05, 01) provide the ability to route a maximum of 8
channels to/from the SDI stream. Sample rate conversion may be applied to the whole card (all 8
channels), and delay may be applied to either the embedded or de-embedded signals.

Further information can be found in the data sheet, available in the "mc2 Nova73 documentation”
guide.

SDI parameters can be adjusted for the card and for individual input and output signals.

Note that SDI parameters are never stored by snapshots. From Version 4.8.0.2 onwards, they are
stored and recalled by productions. You may use the Global isolate of SDI parameters custom
function to isolate SDI parameters so that settings are not affected by a production load.
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SDI Card
Select an SDI card from the System tree, and click on SDI to adjust the following card parameters:

SDI
Card 15 [945/21]

Sample Rate Converter On X

Card 17 [946/13] De-Embedder

Signal In 2

Signal In 4

Signal In 6

e SRC - check this option to enable sample rate conversion. Note that SRC is applied to all 8
channels on the card. Normally, SRC should be enabled. If SRC is off (unchecked), then the
system must be clocked to the same reference as the sending device.

e Delay — select whether delay is enabled for the Embedded (SDI output) or De-embedded
(SDlinput) signals; delay cannot be applied to both.

¢ Generator signal, mode and format — defines the output generator signal for the SDI stream.

e Embedder mode — select from:

0 On - audio channels will be replaced within the existing SDI data structure according to
your SDI output group selections.

o Off —no audio replacement; the SDI stream remains unaltered.

0 Clean — deletes the incoming audio stream and generates a new data structure according
to your embedder settings. Note that if you select this mode any existing audio data will be
lost.
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SDlI Inputs

Select an SDI input signal from the System tree, and click on SDI to adjust the following signal
parameters:

General Conference SDI Input DSP Device
Card 15 [945/21]
2 (Channel 3+4)
Card 17 [946/13] Delay time
Signal In 1 Delay
Signal In 2

Signal In 4

Signal In 6

e Group select —this field defines which pair of SDI channels will map to the selected SDI card
input. In our example, Group 2 Channels 3&4 from the SDI stream will be de-embedded to
SDI Signal In 1 and 2.

e Delaytime & Delay — check the Delay option to enable delay for the stereo input, and set the
delay time in ms. Delay time can be adjusted from 0 to 240ms.

Delay is only applied to SDI inputs if the SDI card Delay parameter is set to De-embedder.
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SDI Outputs

Select an SDI output signal from the System tree, and click on SDI to adjust the following
parameters:

Signal In 4
General |[SDI Output DSP Device

Signal In 6 Group selec Group 1 (Channel 1+2)

Signal In 8
Signal Out 1

Signal Out 2

Signal Out 4

Signal Out 6

e Group select —this field defines which pair of SDI channels will map to the selected SDI card
output. In our example, Group 1 Channels 1&2 from the SDI stream will be embedded to SDI
Signal Out 1 and 2.

The assignment is only active if the SDI card Embedder mode is set to On or Clean.

e Delay time & Delay — check the Delay option to enable delay for the stereo output, and set
the delay time in ms.

Delay is only applied to SDI outputs if the SDI card Delay parameter is set to Embedder.
¢ Wordlength — choose from the available drop-down menu options.

When 16 or 20-bit are selected, dither is automatically applied.
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GNU Public License

The following modules are used in the Nova73:

Box Nova 73
Linux Kernel 2.6 X
i CLinux 2.4 X X
netsnmp X X
busy box X X
TCL X X
xFree86 X

The GPL source code contained in this product is available at Lawo service department. If you would
like a copy of the GPL source code in this product on a CD, please send €9,90 to Lawo for the cost of
preparing and mailing the CD to you.
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Control System Locations
The table below shows the location of the control system for different mc? and Nova73 products.
Note that:

¢ The Router Module MKII (980/33) control system provides two network ports: ETHERNET A
connects to the mc? control surface; ETHERNET B connects to the Lawo system network.

e For control systems located inside the control surface, you may use any console ETHERNET
port to connect to the Lawo system network.

System Router Control Location System Network
Module System Port
mc2 56 classic 980/33 Intel Nova73 ETHERNET B
mc2 56 MKII 980/33 Intel Nova73 ETHERNET B
mc2 66 classic 980/31, 32 Intel control surface ETHERNET (any)
mc2 66 topl 980/31, 32 Intel control surface ETHERNET (any)
mc2 66 MKII 980/33 Intel Nova73 ETHERNET B
mc2 90 980/31, 32 Intel control surface ETHERNET (any)
mc2 90 980/33 Intel Nova73 ETHERNET B
mc2 90 star? 980/33 Intel Nova73 ETHERNET B
Nova73 Standalone
MK 980/31, 32 Motorola Nova73 ETHERNET
see Technical
Nova73 Ripper MKI  (980/31, 32 Intel 1HE Ripper Documentation
see Technical
Nova73 DSHS MKI 980/32 Intel 1HE Ripper Documentation
Nova73 HD MKII 980/33 Intel Nova73 ETHERNET B
Nova73 Compact MKII|980/33 Intel Nova73 ETHERNET B
Nova73 HD DSHS
MKII 980/33 Intel Nova73 ETHERNET B
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TCP/IP Addresses

Default IP Addresses

The default IP addresses, for different Lawo product control systems, are:
e mc256 = 192.168.102.56
® mc266 = 192.168.102.65

e mc290 = 192.168.102.90

¢ Nova73 (HD & Compact) = 192.168.102.143

e Nova73 HD DSHS: primary 'star' = 192.168.102.32; secondary 'star' = 192.168.102.160

e mxGUI (local control system) = 192.168.56.101

You can check the IP address of your control system from the GUI (using the Signal Settings display).

Subnet Mask

For all products, the default Subnet Mask is 255.255.255.0.

Other IP Addresses

The table below lists the other IP addresses used within a mc256 MKII installation:

(optional)

Device Port IP Address Notes

Router Module Slot A ETHERNET A 192.168.105.1 Fixed address.

Router Module Slot A ETHERNET B 192.168.102.xxx Default address of the control
system (as listed above). This
address can be modified by
AdminHD.

Router Module Slot B ETHERNET A 192.168.106.1 Fixed address.

(optional)

Router Module Slot B ETHERNET B  |192.168.102.xxx This address is always one digit

higher than that of the main
control system. It is set
automatically by AdminHD.

Ethernet Switch
(optional)

192.168.102.250

Default address.

ISDN Dialup Router
(optional)

192.168.102.200

Default address.

Q We recommend keeping the default IP addresses, where possible, as this will simplify
remote maintenance.

366

V5.0/1

mc256 MKIl Technical Manual




Glossary

oo

Glossary
48kHz or 44.1kHz

Access

AdminHD
ATM

Attack Time

AuX

Aux Send

Aux Master

Aux Return

Band Pass Filter

Balance

Bargraph

Clean Feed

See Sample Rate.

On mc? consoles, much of the channel parameter operation is
performed by assigning a fader strip to the Central Control Section. This
is otherwise known as putting a source ‘in access’.

Lawo’s configuration and control software for Nova73 systems.

Asynchronous Transfer Mode (Packing of signals in small portions;
commonly used and highly standardised network protocol).

In the context of dynamics processing (compressor, limiter, gate or
expander), the attack time defines the duration over which an input signal
is measured. The longer the attack time, the slower the processor will
react. For example, when using a gate, a fast attack time causes the
gate to open quickly when signal exceeds the gate threshold.

Auxiliary

An Aux is a general purpose mono, stereo or multi-channel summing bus
which can be used for a variety of applications such as sending to
outboard effects devices.

Auxiliary Send

Source channels feed onto each aux via their Aux Send. The aux send
from each channel can be either pre or post fader and has variable level
control.

Auxiliary Master

The Aux Master is a master source channel used to control the level and
processing of the Aux output. The direct output of the Aux Master is the
signal routed to the outboard effects send.

Auxiliary Return

The Aux Return is the name given to the return channel from the
outboard effects device. This channel controls the level and processing
of the effect as it is summed into the rest of the mix.

See Filters.

Balance is applied to the input of a stereo channel and is the ratio
between the left and right input levels. When Balance is set to its default
value, the level of left and right inputs are equally weighted.

An optical display instrument in the shape of a LED bar for displaying
signal level.

See Mix Minus.
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Compressor

Configuration

ControlHD
DALLIS

dB

dBU

dBFS

Delay

Direct Out

Drop-out

A dynamics processor used to smooth out uneven signal levels. For
example, when a presenter shouts and then whispers, they are
producing sound which has a wide dynamic range; one moment it is very
loud and the next very quiet. This can mean that if we listened to this
signal on our radio without compression, we would forever be turning the
level up and down! A compressor smoothes the signal such very loud
audio is reduced in level and very quiet audio is increased in level. This
results in smaller dynamic range ideal for radio transmission.

The system configuration is a file created by the AdminHD software. The
file may be exported and uploaded to the system’s cold start data where
it will load following a cold start. Or, the file may be uploaded to the
system’s warm start data where it is then loaded every time the system
reboots or powers on. The configuration defines key elements of the
system such as the hardware components, and default signal
parameters.

Lawo’s control software for Nova73 systems.

Lawo’s modular /O interfacing system based on 19” frames using plug-
in cards for different interfaces.

deciBel
A unit of transmission giving the ratio of two powers.

The number of bels is the logarithm to the base 10 of the ratio of the two
powers. One decibel equals one tenth of a bel.

dBU is used to describe levels within the analogue domain, and is a
measure of absolute voltage level based on 0dBU = 0.775 Volts (RMS).
dBU is often used to indicate nominal broadcast operating levels.

dB Full Scale

dBFS is used to describe levels within the digital domain. OdBFS
describes the system’s internal clipping point; this is the maximum level
which may be handled by the system without signal distortion.

The signal output from a delay module is x ms behind the signal input to
the module. Delay is often applied to audio sources whose video has
undergone digital video processing; delay is required such the audio
remains in sync with the video.

Direct Output

The direct output of a channel is the output of the individual source.
Direct Outputs are often used to provide a record or ‘snoop’ feed of a
single source, and may be taken from various points within signal flow:
pre fader, post fader, etc.

Interruption of the audio signal caused by an error in the signal transfer or
recording.
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DSP Digital Signal Processing
Digital signal processing (DSP) is the study of signals in a digital
representation and the processing methods of these signals.

Within mc? consoles and the Nova73, DSP is also used as the collective
name given to the processing cards, within the Nova73, which provide
audio signal processing such as equalization, dynamics and delay.

Dynamics Dynamics is the collective terms given to audio processing which
responds to changes in signal level. For example, a Compressor,
Limiter, Gate or Expander.

EQ Equaliser.

An equaliser is a processor which changes the frequency characteristics
of a signal, for example to increase the amount of treble or bass
components in the signal.

Expander A dynamics processor used to magnify changes in the dynamic range of
the input signal. For example, to reduce noise in speech pauses. See
also Compressor.

Fader A potentiometer used to adjust the gain of a signal.

Filters Filters are equaliser sections which are used to cut out or reduce
specific frequency bands within the signal. For example, a Low Pass
Filter cuts out high frequencies so will result in less treble to the sound. A
High Pass Filter cuts out low frequencies, for example you may use this
to remove unwanted low frequencies like hum or rumble. A Band Pass
Filter cuts out both high and low frequencies allowing frequency
components within the band to pass through the signal; for example, you
may use this type of filter to create a telephone effect on a normal voice.

Gain Adjusting the gain of a signal results in a change in the perceived level or
amplitude. An increase in gain (positive values) results in amplification
and a reduction in gain (negative values) in attenuation.

Gate A dynamics processor used to remove unwanted signals below a certain
threshold level. For example, if a gate is applied to a presenter’s
microphone source, then when they speak signal level exceeds the gate
threshold and the gate opens, while if they make a low level sound, like
shuffling in their seat, the gate remains closed. The result is that only the
signal we want to hear is output from the source channel!

GPI General Purpose Interface (IEEE488) is a standardised platform
independent short-range digital interface, to allow switching connections
between broadcast equipment from different manufacturers.

Headroom The amount of operating level which is in reserve between normal
operating level and OdBFS.

High Pass Filter See Filters.
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Insert Point

Limiter

Low Pass Filter

MADI

Mix Minus

Monitor

ms

mxGUI

Nova73

N-1

On-Air

Overload

Panning

A connection point within the source channel which interrupts the signal
flow and routes out to a piece of external equipment and returns back to
the source channel.

Insert send = route out from the source channel to the external device.
Insert return = input to the source channel from the external device.

A dynamics processor used to stop signals exceeding a certain
threshold level. For example, you may place a limiter across the main
output of the programme to prevent a sudden increase in level exceeding
the clipping point of your transmission feed and causing signal distortion.

See Filters.

Multi-channel Audio Interface; digital interface for combining audio signals
of 56 or 64 channels.

Mix Minus, Clean Feed and N-1 are all terms used to describe a feed
which is created from a number of channels minus a particular channel
or channels. For example, to provide telephone hybrids with a feed of the
programme minus the incoming phone call.

Term used to describe the outputs and functionality of feeds to
loudspeakers or headphones for the purpose of listening to a mix.

milliseconds
Unit of time measurement.

Middle and Side Stereo

Used to describe an arrangement of two coincident microphones, one

pointing to the front (Middle) and the other (bidirectional) at right angles

providing a Side signal. The mc? consoles provide M-S to X-Y decoding
to turn the Middle and Side signal into normal Left and Right stereo.

Lawo’s control software for mc? and Nova73 systems. The software runs
GUI displays from an external PC and can be used either online or offline.

The heart of the mc? system (includes the routing matrix, control system,
I/O modules and DSP). Can exist as a stand-alone routing matrix with
networking capabilities.

See Mix Minus.
Term used to indicate that a radio or TV programme is being broadcast.

Occurs when the signal level is too large for the system, resulting in
signal distortion.

Used to control the left/right position of a mono source when routed to a
stereo or multi-channel output. For example, if a source is panned left,
then you will all signal from the source is routed to the left side of the
summing bus. If a source is panned centre, equal levels are applied to
the left and right sides of the summing bus, etc.
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PFL

Phantom Power

Programme

RAS

Ratio

Release Time

Remote MNOPL

Roll-off Frequency
Routing

RS422
RU

Sample Rate

Shelving EQ

Slope
SMPTE

Pre Fade Listen

Used to listen to signals before the application of fader level. Provides a
way of listening to a source when the fader is closed to check its signal
before the fader is opened to route it onto the programme output.

This is the power supply required when working with condenser
microphones. The console supplies 48V to the microphone via the audio
connector.

The main output of a live broadcast console. This is the mix which feeds
the transmission chain.

Radio Automation System control protocol is Lawo’s universal protocol
for communication between a mixing console (MIXER) and a radio
automation system (RAS).

In the context of a compressor or expander, the ratio defines how much
compression or expansion is applied. For example, the higher the
compressor ratio, the more signal levels above the compressor
threshold will be compressed.

In the context of dynamics processing (compressor, limiter, gate or
expander), the release time defines the time taken for the action of the
processor to subside. For example, when using a gate, a short release
time will cause the gate to close quickly after signal falls below the gate
threshold.

The remote control protocol RemoteMNOPL is a LAN based client-server
network byte order protocol to enable third party systems to control
Lawo’s digital mixing consoles or standalone routers.

See Shelving EQ.

Signal Routing

Term used to describe the connection made between an input and
output.

Type of serial interface used to communicate with external devices.
Rack Units = 44,45 mm respectively 1,75 inch

The speed at which the internal processing of the system takes samples
respective to values from a continuous, analogue audio signal to make a
discrete, digital one. For example, when running at 48kHz, incoming
analogue audio is sampled at a rate of 48000 values per second.

A shelving equaliser band is used to increase or decrease high or low
frequency components of a signal. The slope of the shelf defines how
steeply the gain increase/decrease is applied. The roll-off frequency
defines the frequency at which signal level is reduced by 3dB.

See Shelving EQ.

Abbreviation for Society of Motion Picture and Television Engineers
Standardised protocol for the synchronisation of audio and video
technology - timecode.
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SRC

Sum

Telephone Hybrid

Threshold

Sample Rate Converter.

Summing Bus
The result of several audio signals mixed together within the console.

Within mc? consoles, the name given to the main output busses
(programme busses).

Device which deals with bi-directional signals to/from a 2-wire phone line.
One line provides an incoming feed from the phone line (e.g. the guests
voice), and the other sends signal back to the receiver (e.g. the mix
minus feed).

In the context of dynamics processing (compressor, limiter, gate or
expander), the threshold defines the signal level at which the processor
starts to act. For example, the gate threshold sets the level at which the
gate will open and then close.
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-3-
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-A -
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AdminHD File Types 108
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AES3-id 76

Alarm 77, 81, 257

ATM 74

Audio Follow Video (AFV) 29
-B -

Battery 281

Bay Sener 24, 249, 302
Black Burst 76

-C-

Cold Start 247

config.tcl 107

Configuration 28

Configuration (AdminHD) 95, 106, 138, 153, 213
Connect Manager (AdminHD) 207

Connections 63
Console control surface
Console Keyboard 62
Control System 11, 19, 273, 365
ControlHD 29, 100

Cooling (Control surface) 55
Cooling (DALLIS) 44

Cooling (Nova73) 32

Core Browser (AdminHD) 119

10, 54, 70, 295, 329

-D -
DALLIS 12, 44, 73, 277, 345
Diagnostics 85, 252, 253, 254

Dial-up Router 29

Dimensions (Control surface) 56
Dimensions (DALLIS) 44
Dimensions (Nova73) 32

Dual Self-Healing Star 27

-E-

Ethernet A 64
Ethernet B 65

Extenders 54, 70

-F -

Fans (Control surface) 55

Fans (Nova73) 32, 268

Flashcards 19, 273

FTP 265

-G -

General Purpose Channels (GPCs) 29
Global Alarm 80, 257

GPIO 255

Graphic View (AdminHD) 122
Grounding (Control surface) 59
Grounding (DALLIS) 48
Grounding (Nova73) 35
gui_config.tcl 107

-H-

Hazard Warning Flag 85
Headroom 91

Installation 31
IP Address 68, 366

-L -

Lawo Remote App 29
Link Redundancy 16

Local YO 13, 307, 311, 348
Logfiles 250, 261

-M -

Machine Control 29

MADI 74, 76

Metering 334

mxGUI 29, 97, 107

-N -

Network Connections 65
Networking 26, 255
Nova73 11, 32, 72, 267, 341
-0 -

Options 29, 329, 341, 345

Owerbridge 334
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PING Command 321 -W-
Plugin Server 29 Warm Start 247
Port Redundancy 16 Web Browser Interface 254
Power (Control surface) 23, 60, 304 Weight (Control surface) 56
Power (DALLIS) 49, 278 Weight (DALLIS) 44
Power (Nova73) 36, 269 Weight (Nova73) 32

Wordclock 25, 76, 89
-R-

RAVENNA 74, 255, 284

Redundancy 14

Redundant Router Module 20, 78, 274
Reference Level 91

Remote Desktop 29

Remote Log (AdminHD) 125

Remote MNOPL 29

Remote operation 104

Restart 247

Router Module 11, 271

RTW Metering 334

-S-

Sample Rate 25, 88

SDI Parameters 355, 360

Shutdown 247

Signal List Editor (AdminHD) 181

Software Version 246, 255

Sync 25, 76, 89
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213
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TCL files 107

TCL Functions 28
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Touch-screen 299

-U-
User Panels 334

374 V5.0/1 mc256 MKIl Technical Manual



	Table of Contents
	Welcome
	Changes to This Manual
	Important Safety Instructions
	Technical Overview
	Hardware Components
	Console Control Surface
	Nova73
	DALLIS I/O
	Local I/O

	Redundancy
	Star2 Technology
	Link & Port Redundancy
	Nova73 & DALLIS Power
	Redundant DSP
	Control System
	Redundant Router Module and Control System
	Automatic Takeover
	Manual Takeover

	Control Surface Power
	Control Surface Internal Wiring

	Sample Rate & System Clock
	Networking I/O Resources
	Nova73 HD Dual Self-Healing Star
	Configuration
	System Options

	Installation
	Installing the Nova73
	Nova73 HD Frame (980/02)
	Nova73 Compact Frame (980/06)
	Grounding
	Power
	Plug-in Modules and Connector Panels
	AES3 Rear Connector Panels
	Front Module Slots
	Mounting the Front Modules



	Installing the DALLIS Unit(s)
	Minimum Distances for DALLIS Installation
	3RU Frame (940/30)
	6RU Frame (940/60)
	Grounding
	Power
	Plug-in Cards
	Equipping the 3RU Frame
	Equipping the 6RU Frame
	Mounting the Cards


	Installing the Control Surface
	Ambient Conditions/Air Conditioning
	Dimensions and Weight
	Minimum Distances & OB Van Mounting
	Grounding
	Power
	Console Keyboard Driver

	System Connections
	Ethernet A
	Ethernet B (System Network)
	Network Connection
	TCP/IP Configuration

	Wiring from the Control Surface
	Wiring from the Nova73
	Wiring from DALLIS Unit(s)
	Nova73/DALLIS Interconnects
	External Sync
	Nova73 Alarm & Control Contacts
	GPI Inputs
	GPI Outputs
	Global Alarm

	DALLIS Alarm & Control Contacts
	ALARM FORCE M2
	DALLIS Local Alarm


	Powering On & Checking the System
	Diagnosing System Errors

	System Settings
	Wordclock Options
	Max Sample Rate & Sample Rate
	System Clock Options

	Level Options
	Reference Level
	Headroom



	AdminHD
	Overview
	AdminHD and mxGUI
	Compatibility
	Computer System Requirements
	Software Installation
	Installation Procedure
	Additional Notes for MAC OS X Installation
	Uninstall & Update

	Connecting to the Lawo Control System 
	Checking the Network Communication

	Configuration Files
	Control System Cold Start Files
	AdminHD Files (on your computer)

	Operating Principles
	Starting AdminHD
	File Conversion
	The Main Operating Window
	Online/Offline Status
	The Main Toolbar
	The Sub Windows
	Arranging the Sub Windows

	‘Core Browser’
	The System
	The Core Browser Toolbar

	‘Graphic View’
	‘Parameter Box’
	'Remote Log'
	The Main Menus
	File
	Remote
	Extras
	Window
	? -> About

	AdminHD Preferences
	Preferences -> Common
	Preferences -> Start up
	Preferences -> Directories
	Preferences -> Connect Manager
	Preferences -> Signal List Editor


	Core Configuration: First Steps
	File -> New
	Downloading the Online Configuration
	Opening a Saved Configuration
	Saving the Configuration
	Editing the Configuration
	Checking the Configuration
	Backing up the Cold Start Files
	Upload Options
	Exporting the Cold Start config.tcl
	Uploading the Cold Start config.tcl
	Uploading Data to the Online Configuration

	Core Configuration: Defining the System
	Defining the Core
	Fitting Modules to the Core
	Fitting a Redundant Router Module
	Defining the IO Ports
	Fitting Cards to a DALLIS
	Copy, Cut & Paste
	Deleting Components
	Port Redundancy
	Port DSP Resources

	Core Configuration: Editing Parameters
	Signal Names and Labels
	Device Names (Alias Names)
	Control System IP Address
	Multi-channel Sync
	Operating Levels
	Internal Sampling Rate
	Mapping Tables

	Signal List Configuration
	The 'Signal List Editor'
	The Signal List Editor Toolbar
	Downloading the Signal List
	Opening a Saved Signal List
	Creating a New Signal List
	Default Directories
	Saving the Signal List
	Editing a Signal List
	Adding & Naming Directories & Subdirectories
	Adding Signals to a Subdirectory
	Selection Tips and Tricks
	Deleting Signals, Subdirectories & Directories
	Editing the Position of Signals, Subdirectories & Directories
	Copy, Cut and Paste
	Duplicating the Source/Destination Directory Structure
	Updating the Hardware Tree
	Locating a Signal within the ‘Signal List Editor’

	Generating a Signal List from the Core Configuration
	Exporting the Cold Start gui_config.tcl
	Uploading the Cold Start gui_config.tcl

	Online Operation
	System Diagnostics
	The System Message Log

	The ‘Connect Manager’
	The Connect Manager Toolbar
	Exporting a Connection List

	Documenting the Configuration
	Copy Image / Write Image to File
	Export a Component List

	Core Configuration: Parameters
	System
	Core
	Core -> Connection
	Core -> Data
	Core -> System Settings
	Core -> Map
	Core -> External
	Core -> Network
	Core -> Plugin Server

	Modules
	Ports
	Super-Device
	Cards
	Signals
	Signal In -> Signal
	Signal Out -> Signal
	Signal In/Out -> DSP
	Signal In/Out -> Map


	mxDSP Configuration
	Editing the Core Configuration
	Config-ID Options

	Editing the Signal List
	Updating the Cold Start Configuration
	Updating the Firmware

	The 'Console Panel'
	Editing the Control Surface Configuration (MKI mc266)
	Uploading the Cold Start console_config.tcl


	Service/Maintenance
	Software Versions
	System Shutdown and Restart
	Warm Start & Cold Start Data

	Restarting a Bay Server
	System Logfiles
	GUI Diagnostics
	AdminHD/ControlHD Diagnostics
	Web Browser Interface
	System Overview
	System Alarm
	Device Availability
	Silence Detects Page
	DSP Usage
	System Log Files

	Telnet Sessions
	Logging in to a Remote Control System

	File Transfer via FTP
	Nova73
	Replacing the Fans
	Replacing a Power Supply Unit
	Router Module MKII: LEDs & Switches
	Replacing a Router Module
	Replacing a System or User Data Flashcard
	Updating Configuration and Software in a Redundant System
	I/O & DSP Modules: LEDs & Switches
	Replacing an I/O or DSP Module

	DALLIS Unit(s)
	Replacing a Power Supply Unit
	Master Board: LEDs & Switches
	Replacing a Master Board
	Replacing the Lithium Battery
	I/O Cards: LEDs & Switches
	Replacing an I/O Card

	RAVENNA Interfaces
	AdminHD: Configuration Options
	RAVENNA Port Connections
	Optical Fibre SFP Modules
	RAVENNA Port Status LEDs
	The Control Port
	Control Port IP Addresses
	Updating and Servicing RAVENNA Interfaces

	Control Surface
	Replacing a Panel
	Hood Fastener
	Calibrating a Touch-screen
	Replacing a TFT Display
	Bay Server Rotary Switch Settings
	To Adjust a Bay Server's Rotary Switch Settings

	Replacing a Power Supply Unit
	Replacing the Local I/O Board
	Adjusting the Local I/O Jumper Switch Positions


	Trouble-shooting
	The system will not boot or does not boot correctly
	The system boots up but I have no audio
	The complete control surface is not responding
	One of the control surface panels is not working
	The graphics on the TFT displays freeze temporarily
	The graphics on one of the displays freezes or looks odd
	The network connection to the control system is not working
	Running a PING test

	Technical Data
	Appendices
	System Part Numbers
	Control Surface Options
	Frame Layouts
	Frame Version
	Stand
	Overbridge Options
	Local I/O Connection
	Console Keyboard
	Script Tray
	Recording Com Kit

	Nova73 Compact Core
	Nova73 Module Options
	Nova73 Rear Connector Panels

	DALLIS Interface Options
	Local I/O Wiring
	Local I/O Jumper Switch Positions

	DSP Configurations
	SDI Parameters
	SDI Parameters (3G SDI Card)
	3G SDI
	Embedder
	De-Embedder
	Metadata

	SDI Parameters (non 3G SDI Cards)
	SDI Card
	SDI Inputs
	SDI Outputs


	GNU Public License
	Control System Locations
	TCP/IP Addresses

	Glossary
	Index

